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Chapter 1
[bookmark: O_14566][bookmark: _Toc228971260]1Install and Set Up
[bookmark: O_14570][bookmark: _Toc228971261]1.1  Start SuperNova
SuperNova will start automatically after you log onto your computer unless you have stated otherwise during the installation process.
You can manually start SuperNova after log on by using the SuperNova shortcut key.
Press CONTROL + SHIFT + S.
If you have installed a new version alongside your existing version then the new version will be automatically given the following shortcut key:
Press CONTROL + SHIFT + D.
You can also launch SuperNova by selecting the SuperNova shortcut in the Windows Start menu. This is in the Programs, Dolphin sub-menu.
	
[bookmark: O_14571][bookmark: _Toc228971262]1.2  Run SuperNova for the first time
You will be guided through the activation process the first time you run SuperNova after installation.
The activation process will guide you through unlocking and activating your software.
	
[bookmark: O_14574][bookmark: _Toc228971263]1.3  Learn your hot keys
You can use the SuperNova Key Describer to help you get familiar with your keyboard layout and SuperNova hot keys. 
An application will not see or act on any keys pressed when you use Key Describer.
To turn on or off "Key Describer":
Key Describer Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn on or off Key Describer
	CAPS LOCK + SLASH
	CAPS LOCK + 1
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[bookmark: O_3854]	
[bookmark: O_14575][bookmark: _Toc228971264]1.4  Quit SuperNova
To quit SuperNova:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + F. This will open the "File" menu.
3.	DOWN ARROW to "Quit SuperNova" and press ENTER. A message window will appear asking you to confirm you want to quit.
4.	TAB to the "Yes" button and press SPACEBAR.








Chapter 2
[bookmark: O_14581][bookmark: _Toc228971265]2SuperNova Control Panel
[bookmark: O_16546][bookmark: _Toc228971266]2.1  Introducing the SuperNova Control Panel
[bookmark: O_16896][image: ]
	
[bookmark: O_14583]The SuperNova Control Panel is the place that contains all of the settings for SuperNova.
You can find SuperNova's settings in the Control Panel's menu bar and the button bar.
The menu bar, which is the horizontal bar positioned below the title bar containing options to drop down menus, provides access to all the settings available in SuperNova. The button bar, which is positioned below the menu bar and contains large easy to access buttons, provides access to SuperNova's most commonly used settings.
The final part of the SuperNova Control Panel is the status bar. The status bar, which is the horizontal bar at the bottom of the SuperNova Control Panel, provides information about the Settings files you are using.
You can switch from a full-sized to a compact version of the control panel using the restore down and maximise buttons in the title bar of the control panel.
	
[bookmark: O_14582]You can open the SuperNova Control Panel in several ways.  Use the one which suits you best.
To open the SuperNova main Control Panel:
Press LEFT CONTROL + SPACEBAR.
This opens the full Control Panel as a dialog box.
Alternatively, using the mouse, to open the SuperNova Control
Panel:
Click the SuperNova icon in the Windows Notification Area.
To open the SuperNova Control Panel as a simple menu:
Press CAPS LOCK + SPACEBAR or RIGHT CLICK the SuperNova icon in the Windows Notification Area.
	
[bookmark: O_16564][bookmark: O_16568][image: ]
	
[bookmark: O_16569][bookmark: _Toc228971267]2.2  Keyboard commands to get around the SuperNova Control Panel
The following tables provide a list of keyboard commands to help you get around the SuperNova Control Panel. Note that these keyboard commands are also standard Windows commands that you can use throughout Windows.
Keyboard Commands for the menu bar.
	Function
	Hot key

	Move focus to the menu bar
	ALT

	Move focus across the menu bar
	LEFT ARROW or RIGHT ARROW

	Open the menu item that has focus
	DOWN ARROW or ENTER

	Move to and open a menu bar item
	ALT + Underlined letter

	Move through an open menu
	DOWN ARROW or UP ARROW

	Open a submenu
	RIGHT ARROW or ENTER

	Close a submenu
	LEFT ARROW or ESCAPE

	Select a menu item
	ENTER



Keyboard Commands for dialog boxes
	Function
	Hot key

	Move to the next control
	TAB

	Move to the previous control
	SHIFT + TAB

	Press a button, toggle a check box or select an option
	SPACEBAR

	Move directly to a control
	ALT + Underlined letter

	Open the next tab in a multi tab dialog box
	CONTROL + TAB

	Open the previous tab in a multi tab dialog box
	CONTROL + SHIFT + TAB

	Cancel
	ESCAPE



	
[bookmark: O_15066][bookmark: _Toc228971268]2.3  Settings in the SuperNova Control Panel
All the SuperNova options can be accessed through the menus in the SuperNova Control Panel.  The following list summarises the purpose of the menus.
	File menu:
[bookmark: H_15644]The "File" menu contains options for selecting your user profile as well as managing your SuperNova Settings files. This includes creating, editing, importing and exporting settings files. The "File" menu also contains the command to quit SuperNova.
	
[bookmark: O_16538]	Visual menu.
The "Visual" menu contains the options to control magnification, screen colours, highlighting and other visual effects. You can also access many of these settings through the SuperNova button bar.
	
[bookmark: O_16533]	Speech menu.
The "Speech" menu contains the options to control what SuperNova announces. This includes voice settings like the speed and volume of the voice, plus options controlling what SuperNova says when you are typing, reading and working with text.
	
[bookmark: O_16534]	Braille menu.
The "Braille" menu contains options to control what is output to a Braille display. This includes the Braille table, language and text attributes.
	
[bookmark: O_16535]	Media menu.
The "Media" menu contains options for scanning, searching for books, reading online news articles, listening to radio stations and playing podcasts.
	
[bookmark: O_16536]	General menu.
The "General" menu contains options that control SuperNova's behaviour including startup preferences, update settings, Control Panel appearance and SuperNova keyboard and hot key assignments.
	
[bookmark: O_16537]	Help menu.
The "Help" menu provides shortcuts to useful resources including the SuperNova Manual, online resources and the "About" option. The "About" option provides you with your customer ID number plus the edition, version and build of SuperNova you are currently running. Ensure you have this information at hand if you require technical assistance.
	
[bookmark: O_14585][bookmark: _Toc228971269]2.4  Change the appearance of the SuperNova Control Panel
You can make many changes to the SuperNova Control Panel. For example, you can hide the button bar, hide the status bar, stop the Control Panel appearing when you run SuperNova and remove it from the Windows Taskbar.
For information about changing the SuperNova Control Panel, see the "General Control Panel dialog box".
	
[bookmark: O_14584][bookmark: _Toc228971270]2.5  Close the SuperNova control panel
You can close the SuperNova Control Panel in several ways.
To do this:
Press ESCAPE.
Or,
Click the minimise icon in the SuperNova Control Panel title bar.
When you do this, the SuperNova Control Panel disappears and the focus goes back to the application you were previously running. SuperNova continues to run.
NOTE: If you press ALT + F4 or click the close button in the SuperNova Control Panel title bar, then SuperNova will assume you want to quit the program. Before quitting, a message window appears asking you to confirm the action.
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Chapter 3
[bookmark: O_14567][bookmark: _Toc228971271]3Magnifier
[bookmark: O_14586][bookmark: _Toc228971272]3.1  Turn magnification on or off
[bookmark: O_14593][image: ]
You can turn on or off magnification using the "Visual" options in the SuperNova control panel or by using hot keys. If you are using a touchscreen device, you can also turn magnification on or off by doing a 3 finger  double tap.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn off or on magnification
	LEFT CONTROL + NUMPAD ENTER
	ALT + 0



If you're using multiple monitors and have the "Allow different magnification levels on each monitor" check box enabled in SuperNova's "Multiple Monitors" settings dialog box, then when you press the magnification on/off hot key it will turn the magnification on or off only on the monitor that your mouse pointer is currently on.
	
[bookmark: O_14587][bookmark: _Toc228971273]3.2  Change magnification size
[bookmark: O_14594][image: ]
You can change the power of magnification from 1.2x to 64x. You can change the magnification size using the "Visual" options in the SuperNova control panel or by using hot keys. If you are using a touchscreen device, you can also change magnification by doing a 2 finger pinch or 2 finger stretch.
Magnifier Hot Keys
	Function
	Desktop Hot Keys
	Laptop - Universal Set

	Increase magnification
	LEFT CONTROL + NUMPAD PLUS 
or 
CAPS LOCK + MOUSE WHEEL UP
	ALT + EQUALS
or
CAPS LOCK + MOUSE WHEEL UP

	Reduce magnification
	LEFT CONTROL + NUMPAD MINUS
or
CAPS LOCK + MOUSE WHEEL DOWN
	ALT + DASH
or
CAPS LOCK + MOUSE WHEEL DOWN



If you're using multiple monitors and have the "Allow different magnification levels on each monitor" check box enabled in SuperNova's "Multiple Monitors" settings dialog box, then when you press the increase or decrease magnification hot keys it will increase or decrease the magnification only on the monitor that your mouse pointer is currently on.
	
[bookmark: O_14588][bookmark: _Toc228971274]3.3  Change Magnifier view
[image: ]
You can choose different ways to view the screen using the SuperNova Magnifier.  This includes the following viewing options:
	Full Screen.
This view fills the screen with a magnified portion of the "real" Windows screen.
	Fixed Window.
This view shows the magnified region of the screen in a small static window. You can change the size and position of the window.
	Magnifying Glass
This view behaves like holding a magnifying glass to the screen. You view the magnified region of the screen in a small moving window. You can change the size and position of the window.
	Resizing Glass
This view behaves similar to the Magnifying Glass except that the magnified window will automatically resize itself to the size of the current focus. This view is useful if you use the keyboard to navigate Windows and feel more comfortable seeing the unmagnified screen in the background.
	Split Screen.
This view splits the screen into two regions: a magnified window and an unmagnified window. You can choose where the magnified window appears and the size of the magnified window. The border between the magnified and unmagnified screen is shown as a black line. This mode is popular when also using an integrated CCTV package.
You can change your viewing style by using the "Visual" options in the SuperNova control panel or by using hot keys.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Change Magnifier view
	LEFT CONTROL + NUMPAD 7
	ALT + SHIFT + M

	Change orientation when in Split Screen view
	LEFT CONTROL + NUMPAD 1
	No Assignment


Note that you can change the size and colour of the border around the Fixed Window, Magnifying Glass, Resizing Glass and Split Screen views. You make this change in the "Visual Advanced Options" dialog box.
	
[bookmark: O_14589][bookmark: _Toc228971275]3.4  Change size and position of the magnified window
You can change the size and position of the Fixed Window, Magnifying Glass and Split Screen window. You make the change using a magnification modification mode.
To adjust the size and position of the Fixed Window view:
1.	Choose "Fixed Window" as the Magnifier View setting.
2.	If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 to enter magnification modification mode. If using the Laptop Hot Key set, press LEFT SHIFT + ALT + A to enter magnification modification mode.
In magnification modification mode, a flashing border indicates the object you are editing.
3.	Use the Arrow Keys to position the window on the screen. You can also do this by holding down the Z key and move the mouse.
4.	Press LEFT CONTROL + Arrow Keys to adjust the size of the window. You can also do this by holding down the X key and move the mouse.
5.	Press ESCAPE to exit magnification modification mode.
To adjust the size of the Magnifying Glass view:
1.	Choose "Magnifying Glass" as the Magnifier View setting.
2.	If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 to enter magnification modification mode. If using the Laptop Hot Key set, press LEFT SHIFT + ALT + A to enter magnification modification mode.
In magnification modification mode, a flashing border indicates the object you are editing.
3.	Press LEFT CONTROL + Arrow Keys to adjust the size of the window. You can also do this by holding down the X key and move the mouse.
4.	Press ESCAPE to exit magnification modification mode.
To adjust the size of the Split Screen view:
1.	Choose the Split Screen orientation that you are going to use as the Magnifier View setting.
2.	If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 4 to enter magnification modification mode. If using the Laptop Hot Key set, press LEFT SHIFT + ALT + A to enter magnification modification mode.
In magnification modification mode, a flashing border indicates the object you are editing.
3.	Press LEFT CONTROL + Arrow Keys to adjust the size of the window. You can also do this by holding down the Z key and move the mouse.
4.	Press ESCAPE to exit magnification modification mode.
	
[bookmark: O_14590][bookmark: _Toc228971276]3.5  View other parts of the screen
Only one part of the screen is visible when using magnification. To view the other parts of the screen, you can move the mouse pointer around the screen or use SuperNova hot keys.
Moving around the screen using SuperNova hot keys is described as either panning, moving, move to or jumping.
	Panning.
Panning moves the magnified area across the screen at a constant speed in the direction you specify. The speed of movement can be increased or slowed depending on the keys pressed.
To pan across the screen using your keyboard press RIGHT CONTROL plus an Arrow Key. Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. Press the opposite Arrow Key to slow down. Use the other Arrow Keys to change direction. Release RIGHT CONTROL to stop panning.
When panning across the screen using your mouse, the "SHIFT key locks mouse movement horizontally or vertically" check box found in SuperNova's “Mouse Tracking” options (Visual->Advanced Options->Tracking) causes the panning of the magnified viewport via the mouse to be locked entirely horizontally or vertically while the SHIFT key is being held down (depending on the initial direction of your mouse movement). Releasing the SHIFT key returns mouse movement to normal. 
	Moving (accelerated panning).
Moving works in a similar way to panning, except that the speed of the panning will automatically accelerate up to a certain top speed whilst you have the keys held down.
To move the magnified area press and hold down RIGHT CONTROL + RIGHT SHIFT together with an Arrow Key. When you let go, moving will stop.
	Move To.
You can also move the magnified area directly to various parts of the screen. The following table lists the hot keys that will allow you to move the magnified area to a screen position.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Top left
	RIGHT CONTROL + NUMPAD 7
	No Assignment

	Top
	RIGHT CONTROL + NUMPAD 8
	No Assignment

	Top right
	RIGHT CONTROL + NUMPAD 9
	No Assignment

	Left
	RIGHT CONTROL + NUMPAD 4
	No Assignment

	Centre
	RIGHT CONTROL + NUMPAD 5
	No Assignment

	Right
	RIGHT CONTROL + NUMPAD 6
	No Assignment

	Bottom left
	RIGHT CONTROL + NUMPAD 1
	No Assignment

	Bottom
	RIGHT CONTROL + NUMPAD 2
	No Assignment

	Bottom right
	RIGHT CONTROL + NUMPAD 3
	No Assignment


 
	Jump Movement.
Movement around the screen is also possible in steps. This is different to panning as the magnified window does not scroll smoothly but rather moves in steps. 
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Up
	LEFT CONTROL + CAPS LOCK + NUMPAD 8
	RIGHT CONTROL + RIGHT SHIFT + UP ARROW

	Down
	LEFT CONTROL + CAPS LOCK + NUMPAD 2
	RIGHT CONTROL + RIGHT SHIFT + DOWN ARROW

	Left
	LEFT CONTROL + CAPS LOCK + NUMPAD 4
	RIGHT CONTROL + RIGHT SHIFT + LEFT ARROW

	Right
	LEFT CONTROL + CAPS LOCK + NUMPAD 6
	RIGHT CONTROL + RIGHT SHIFT + RIGHT ARROW


Save and Restore Screen Position
Also available is the opportunity to save a screen position. This will then allow you to return to the same position with the press of a hot key.
To save a screen position:
1.	Move the magnified window to the required position.
2.	Press RIGHT CONTROL + NUMPAD 0 to save the position.
To move the magnified window back to the saved position:
Press RIGHT CONTROL + NUMPAD PERIOD to return to the saved screen position.
	
[bookmark: O_14591][bookmark: _Toc228971277]3.6  Get an overview of the magnified window position
You can see the position the magnified window is on the screen by using Magnifier Overview. You switch in and out of Magnifier Overview using a SuperNova hot key.
To enter and exit Magnifier Overview:
Press LEFT CONTROL+ BACKSLASH.
	
[bookmark: O_14592][bookmark: _Toc228971278]3.7  Create static magnified windows to display information
You can create static magnified windows to keep a particular area of the screen permanently displayed. This lets you see important information that may frequently change as you use your application. 
SuperNova calls these windows "Hooked Areas". Hooked Areas can have their own magnification size and will be visible even if you turn off the SuperNova Magnifier.
Examples:
	You can hook the system tray clock to make it easy to see the time.
	You can hook the place on a word processor's status bar that reports the current page number to make it easy to see what page you are currently working on.
	You can hook the Formula Bar in a spreadsheet to make it easy to see if the current cell contains a formula or text.
You can create a Hooked Area by using the mouse pointer or by using the keyboard.
	
[bookmark: O_14596][bookmark: _Toc228971279]3.7.1  Create a Hooked Area using the keyboard
To create and change the position and size of a Hooked Area window using hot keys requires the use of magnification modification mode.
To create and adjust the size and position of a Hooked Area:
1.	If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 5 to create a new Hooked Area and automatically enter magnification modification mode. If using the Laptop Hot Key set, press LEFT CONTROL + LEFT SHIFT + ALT + H to create a new Hooked Area and automatically enter Magnification Modification Mode
In magnification modification mode, a flashing border indicates the object you are editing.
2.	Use the Magnifier hot keys to change the size of the content inside the Hooked Area.
3.	Use the Arrow Keys to position the window on the screen. You can also do this by holding down the Z key and move the mouse.
4.	Press LEFT SHIFT + Arrow Keys to alter the content inside the Hooked Area. You can also do this by holding down the C key and move the mouse.
5.	Press LEFT CONTROL + Arrow Keys to adjust the size of the window. You can also do this by holding down the X key and move the mouse.
6.	Press ESCAPE to exit magnification modification mode.
During the creation process you will probably find it is only through repeated adjustment of size, position and content within the Hooked Area do you get the desired result.
	
[bookmark: O_14597][bookmark: _Toc228971280]3.7.2  Modify a Hooked Area using the keyboard
To modify an existing hooked area:
1.	If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6. If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will enter magnification modification mode with the currently selected Hooked Area identified by a flashing border.
2.	If you have multiple Hooked Areas then you can cycle between the Hooked Areas by pressing LEFT CONTROL + NUMPAD 6 if using the Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop Hot Key set.
3.	Use the available Magnifier hot keys and Magnification Modification Mode hot keys to adjust the size, location or content of the Hooked Area.
4.	Press ESCAPE to exit Magnification Modification Mode.

	
[bookmark: O_14598][bookmark: _Toc228971281]3.7.3  Delete a Hooked Area using the keyboard
To delete an existing hooked area:
1.	If using the Desktop Hot Key set, press LEFT CONTROL + NUMPAD 6. If using the Laptop Hot Key set, press LEFT CONTROL + F6. This will enter Magnification Modification Mode with the currently selected Hooked Area identified by a flashing border.
2.	If you have multiple Hooked Areas then you can cycle between the areas. To do this press LEFT CONTROL + NUMPAD 6 if using the Desktop Hot Key set. Press LEFT CONTROL + F6 if using the Laptop Hot Key set.
3.	Press DELETE to remove the Hooked Area.
When the Hooked Area is deleted the focus will move to the next Hooked Area. If no Hooked Areas remain then Magnification Modification Mode will be automatically exited. If additional Hooked Areas remain that you do not want to modify then press ESCAPE.
	
[bookmark: O_14601][bookmark: _Toc228971282]3.7.4  Create a Hooked Area using the mouse
You can create Hooked Areas through the "Create Hooked Areas" dialog box. To open this dialog box, open the "Visual" menu and select the menu item "Advanced Options". Then in the "Hooked areas" property sheet of the Advanced Options dialog box press the "New" button.
In the "Create Hooked Areas" dialog box you will need to:
1.	Provide a unique description for the hooked area.
2.	Select or unselect the "Track focus" check box.
Track focus determines whether the content of the hooked area is fixed or shows the current focus. Select this check box and the contents of the hooked area will track the focus. If this check box is selected then the "Choose screen area to hook" button will be disabled as an area of the screen is not being defined.
3.	Select the "Choose screen area to hook" button to define the screen area to display. 
4.	Use LEFT MOUSE BUTTON with mouse movement to create a new area. Press ENTER or the RIGHT MOUSE BUTTON to accept, ESCAPE to cancel.
5.	Select or unselect the "Smoothing" check box.
6.	Select the "Move the hook window" button to position the hooked area and to set the magnification size.
The magnification size can be set using the normal hot keys. Use mouse movement or the CURSOR KEYS to move the hook. Press ENTER or the LEFT MOUSE BUTTON to accept, ESCAPE to cancel.
7.	Select the "OK" button to confirm and save the new Hooked Area.
You can view a list of your created Hooked Areas in the "Hooked Areas" tab, in the "Visual Advanced Options" dialog box. You can also sort, modify and delete existing Hooked Areas in the "Hooked Areas" tab.
	
[bookmark: O_14599][bookmark: _Toc228971283]3.7.5  Show or hide Hooked Areas
You can show or hide Hooked Areas using a SuperNova hot key. This can be useful if you do not want the Hooked Areas to be visible all the time but rather as and when information from other areas of the screen is required.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn off or on Hooked Areas
	LEFT CONTROL + NUMPAD 3
	LEFT CONTROL + F5
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Chapter 4
[bookmark: O_14602][bookmark: _Toc228971284]4Screen enhancements
If you find it difficult to view the screen, track the focus or follow the mouse pointer then the visual enhancements available in SuperNova may provide you with a solution.
	
[bookmark: O_14603][bookmark: _Toc228971285]4.1  Make the screen easier to see
[bookmark: O_14607][image: ]
SuperNova contains options to make viewing the screen more comfortable. One of these options is SuperNova Colour Schemes, which can change the contrast, brightness and colours on the screen.
You can choose a pre-set SuperNova Colour Scheme or create a custom scheme. A Colour Scheme is applied to the whole screen and will work even when the Magnifier is turned off.
You can choose a Colour Scheme through the "Visual" options in the SuperNova control panel. You can  also toggle off or on a Colour Scheme using the "Visual" options in the SuperNova control panel or by using hot keys.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn on or off your Colour Scheme
	LEFT CONTROL + NUMPAD 0
	ALT + SHIFT + C


[bookmark: H_16603]To create a custom scheme you must select "Custom" before you can choose "Configure..." from the list of Colour Schemes. Choosing "Configure..." opens the "Configure Custom Colour Scheme" dialog box. The dialog box contains different controls depending on the settings you choose. This includes brightness, contrast, tint and colour replacement settings.
If you're using multiple monitors and have the "Independent colours" check box enabled in SuperNova's "Multiple Monitors" settings dialog box, then when you press the Colour Scheme on/off hot key it will turn the Colour Scheme on or off only on the monitor that your mouse pointer is currently on.
	
[bookmark: O_14604][bookmark: _Toc228971286]4.2  Make the focus easier to see
[bookmark: O_14608][image: ]
SuperNova contains options to make viewing the screen more comfortable. One of these options is SuperNova Highlighting, which makes different types of focus easier to see by attaching a visual marker to the focus.
Types of focus include:
	Mouse (the pointer controlled by the mouse).
	Cursor (the beam cursor used in edit areas).
	Line (the line the beam cursor is positioned).
	Focus (the focus in dialog boxes and menus).
You can choose a pre-set SuperNova Highlighting Scheme or create your own personal custom scheme. You choose a scheme through the "Visual" options in the SuperNova control panel.
To create a custom scheme you must select "Settings". from the list of Highlighting Schemes. When you choose "Settings" SuperNova automatically switches to the "Custom" scheme before opening the Highlighting Options dialog box. SuperNova also uses the previous scheme's values to make the default values for the new custom scheme.
Tip: If you see no visual effect when choosing a scheme then check to ensure "Highlighting" is turned on. You can turn Highlighting on by selecting the "Highlighting" option in the "Visual" menu or by selecting the "Highlighting" button in the "Visual" tab of the SuperNova control panel.
	
[bookmark: O_14605][bookmark: _Toc228971287]4.3  Make the pointer easier to see
[bookmark: O_14606][image: ]
SuperNova contains options to make viewing the screen more comfortable. One of these options is SuperNova Mouse Pointers, which allows you to change the size and colour of the pointer on the screen. 
You can choose a pre-set SuperNova Mouse Pointer scheme or create your own personal custom scheme through the "Visual" options in the SuperNova control panel.
The pre-set schemes include:
	Large Red
	Large White
	Large Yellow
The selecting of the "Windows Standard" scheme will change the pointer scheme back to the Windows defaults.
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Chapter 5
[bookmark: O_14609][bookmark: _Toc228971288]5Voice settings
[bookmark: O_14610][bookmark: _Toc228971289]5.1  Turn the voice off or on
[bookmark: O_14611][image: ]
You can turn off or on the voice using the "Speech" options in the SuperNova control panel or by using hot keys.
To turn off the voice until you turn on the voice again:
Speech Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn voice on and off
	LEFT CONTROL + 0
	LEFT CONTROL + ALT + 0

	Mute voice
	LEFT CONTROL
	CONTROL



	
[bookmark: O_14613][bookmark: _Toc228971290]5.2  Change volume
[bookmark: O_14612][image: ]
You can change the volume of the voice using the "Speech" options in the SuperNova control panel or by using hot keys.
Speech Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Increase volume
	LEFT CONTROL + EQUALS
	LEFT CONTROL + ALT + EQUALS

	Decrease volume
	LEFT CONTROL + MINUS
	LEFT CONTROL + ALT + MINUS



	
[bookmark: O_14615][bookmark: _Toc228971291]5.3  Change reading speed
[bookmark: O_14614][image: ]
You can change the reading speed of the voice using the "Speech" options in the SuperNova control panel or by using hot keys.
Speech Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Increase reading speed
	LEFT CONTROL + LEFT SHIFT + EQUALS
	LEFT CONTROL + ALT + PAGE UP

	Reduce reading speed
	LEFT CONTROL + LEFT SHIFT + MINUS
	LEFT CONTROL + ALT + PAGE DOWN



	
[bookmark: O_14617][bookmark: _Toc228971292]5.4  Change voice
[image: ]
Speech synthesisers often come with different voices to choose from. Each voice will have its own intonation, created within the speech parameters available.
To change voice:
1.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2.	Press ALT + S.
The "Speech" menu opens.
3.	DOWN ARROW to "Voice Preferences" and press ENTER.
The "Voice Preferences" dialog box opens.
4.	CONTROL + TAB until you open the "Voice and Language Configuration" page.
5.	TAB to the "Voice" list and use the Arrow Keys to select a voice.
6.	If you want to have different voices for different speech contexts, TAB to the "Same as Screen Reader" check box and press SPACEBAR to deselect this option. Then, TAB to each category and use the Arrow Keys to select a voice.
Note: A speech context is a special attribute of the text to be spoken which indicates where it came from or what SuperNova feature you are using.
7.	TAB to the "OK" button and press SPACEBAR.
SuperNova saves the changes and closes the dialog box.
If you are unable to find a voice you find comfortable to listen to then try another synthesiser or try creating your own voice using the options in the "User Defined Voices" page in the "Voice Preferences" dialog box.
	
[bookmark: O_14616][bookmark: _Toc228971293]5.5  Change reading voice language
[bookmark: O_14619][image: ]
SuperNova can automatically change the synthesiser language to match particular alphabetic scripts to make screen reading a more fluent experience. You can automatically switch between many scripts including Latin, Arabic, Chinese (Mandarin), Greek, Hebrew, Hindi (Devanagari) and Russian (Cyrillic).
Where SuperNova is unable to determine the script language, for instance, where the same alphabet is used by different languages, you can use a hot key to select the synthesiser language you want to use to read the passage of text.
Note that not all synthesisers support this feature. To learn more about supported synthesisers and available synthesiser languages please contact Dolphin or your local Dolphin dealer.
	
[bookmark: O_16656][bookmark: _Toc228971294]5.5.1  Enable automatic language switching
1.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2.	Press ALT + S.
The "Speech" menu opens.
3.	DOWN ARROW to "Voice Preferences" and press ENTER.
The "Voice Preferences" dialog box opens.
4.	CONTROL + TAB until you open the "Voice & Language" page.
5.	TAB to the "Enable automatic language switching" check box and press SPACEBAR to select this option.
6.	If you want to prevent the speech changing when punctuation and numbers are encountered through passages of text, TAB to the "Speak numbers & punctuation with previous character's language" check box and press SPACEBAR to select this option.
7.	TAB to the "OK" button and press SPACEBAR.
SuperNova saves the changes and closes the dialog box.
	
[bookmark: O_16657]If you are using a non-European version of SuperNova and require text to be automatically read using a European language, then, in addition to the steps above, in the "Voice & Lnaguage" page, de-select the “Same as screen reader” check box and select the European language you want to use from the “Screen language” list.
You can also change the "Screen language" option by using the Language Up or Language Down hot key. This allows you to change synthesiser language without the need to leave the document you are reading.
	
[bookmark: O_16658]Speech Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Language Down
	LEFT CONTROL + FULL STOP
	No Assignment

	Language Up
	LEFT CONTROL + COMMA
	No Assignment



	
[bookmark: O_14618][bookmark: _Toc228971295]5.6  Change speech synthesiser
SuperNova works with many different speech synthesisers. Supporting such a variety of speech synthesisers means you can pick a synthesiser and voice that you find comfortable, clear and responsive to use. To see what speech synthesisers are available please visit the Dolphin website or contact your local Dolphin Dealer.
To change to another speech synthesiser:
1.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2.	Press ALT + S.
The "Speech" menu opens.
3.	DOWN ARROW to "Voice Preferences" and press ENTER.
The "Voice Preferences" dialog box opens.
4.	CONTROL + TAB until you open the "Synthesiser Configuration" page.
5.	TAB to the "Select Synthesiser" button and press SPACEBAR.
The "Select Synthesiser" dialog box opens.
6.	Use the Arrow Keys to select an alternative speech synthesiser.
7.	TAB to the "OK" button and press SPACEBAR.
SuperNova closes the dialog box and speaks using the new synthesiser. 
If you find the voice not to your liking then you can move into the "Voice and Language Configuration" page to choose a different voice. You could also move to the "User defined voices" page to customise the parameters of the existing voice.
8.	TAB to the "OK" button and press SPACEBAR.
SuperNova closes the "Voice Preferences" dialog box.
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Chapter 6
[bookmark: O_14620][bookmark: _Toc228971296]6Reading and typing
[bookmark: O_14623][bookmark: _Toc228971297]6.1  Read character
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read character at the current focus position
	NUMPAD 4
	CAPS + LEFT ARROW




[bookmark: O_14643]You can learn more about the current character by repeating the press of the hot key.
	x2 announces the phonetic character description.
	x3 announces the character's attributes including font name, size and style.
	x4 announces the unicode value of the character.
	
[bookmark: O_14624][bookmark: _Toc228971298]6.2  Read word
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read word at the current focus position
	NUMPAD 5
	CAPS LOCK + RIGHT ARROW




[bookmark: O_14857]You can learn more about the current word by repeating the press of the hot key.
	x2 spells the word.
	x3 spells the word using the phonetic alphabet.
	
[bookmark: O_14625][bookmark: _Toc228971299]6.3  Read line, read line to cursor and read line from cursor
You can read the current line, read up to the cursor position on the current line and read from the cursor position on the current line.
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read line at the current focus position
	NUMPAD 6
	No Assignment

	Read up to the cursor position on the current line
	LEFT SHIFT + NUMPAD 1
	CAPS LOCK + HOME

	Read from the cursor position on the current line
	LEFT SHIFT + NUMPAD 2
	CAPS LOCK + END




[bookmark: O_14858]You can learn more about the current line by repeating the press of the hot key.
	x2 reads the line including announcements of capital letters and spaces.
	x3 spells the line.
	
[bookmark: O_14632][bookmark: _Toc228971300]6.4  Read selected text
You can read the text you have selected in your document with a hot key.
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read selected text
	NUMPAD 1
	CAPS LOCK + SHIFT + DOWN ARROW




[bookmark: O_14859]You can learn more about the current selection by repeating the press of the hot key.
	x2 spells the selected text including announcements of capital letters and spaces.
	x3 spells the selected text using the phonetic alphabet.
	
[bookmark: O_14626][bookmark: _Toc228971301]6.5  Read focus
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read current focus
	NUMPAD 0
	CAPS LOCK + UP ARROW




[bookmark: O_14860]You can learn more about the current focus by repeating the press of the hot key.
	x2 spells the focus including announcements of capital letters and spaces.
	x3 spells the focus using the phonetic alphabet.
	
[bookmark: O_14627][bookmark: _Toc228971302]6.6  Read control
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read control
	NUMPAD PERIOD
	No Assignment



	
[bookmark: O_14861]You can learn more about the current control by repeating the press of the hot key.
	x2 reads the control including announcements of capital letters and spaces.
	x3 spells the control using the phonetic alphabet.
	
[bookmark: O_14628][bookmark: _Toc228971303]6.7  Read window
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read WINDOW
	NUMPAD 9
	CAPS LOCK + B



	
[bookmark: O_14862]You can learn more about the current window by repeating the press of the hot key.
	x2 spells the focus including announcements of capital letters and spaces.
	
[bookmark: O_14629][bookmark: _Toc228971304]6.8  Read status
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read status information (e.g. status bar)
	NUMPAD 2
	CAPS LOCK + PAGE DOWN




[bookmark: O_14863]You can learn more about the current status by repeating the press of the hot key.
	x2 spells the status including announcements of capital letters and spaces.
	x3 spells the status using the phonetic alphabet.
You may have additional commands added to this hot key for different applications. Please refer to the help for the application to learn more.
	
[bookmark: O_14691][bookmark: _Toc228971305]6.9  Read shortcut key
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Describe shortcut key
	LEFT SHIFT + NUMPAD PERIOD
	CONTROL + CAPS LOCK + LEFT ARROW




[bookmark: O_14864]You can learn more about the current shortcut key by repeating the press of the hot key.
	x2 spells the shortcut key using the phonetic alphabet.
	
[bookmark: O_14640][bookmark: _Toc228971306]6.10  Read date and time
You can announce the current time and date with a SuperNova hot key. The time and date comes from your computer clock.
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Read time and date
	LEFT CONTROL + LEFT SHIFT + NUMPAD SLASH
	CAPS LOCK + F12



	
[bookmark: O_14630][bookmark: _Toc228971307]6.11  Check where you are
You can learn where you are by pressing the "Where Am I" hot key. Pressing The hot key gives different information depending on your current location. 
Examples:
	The "Where Am I?" hot key tells you the window title, document name and current line in a word processor.
	The "Where Am I?" hot key tells you the window title, property sheet name, group name and the name of the current control in a dialog box.
Speak Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Where Am I?
	NUMPAD 7
	CAPS LOCK + PAGE UP



	
[bookmark: O_14621][bookmark: _Toc228971308]6.12  Read continuously
Read From Here is a special reading mode available in SuperNova.
You can use Read From Here to continuously read a document. Reading will continue until the end of the document or until you press a hot key to stop the reading. The pressing of a hot key to stop SuperNova reading will move the cursor to the last word spoken.
You can change the speed of the voice during Read From Here and navigate backwards and forwards through the content of a document as it's being spoken. Note that this requires the document area being read to support Dolphin Cursor navigation by unit in order to move by line, sentence, paragraph and heading, etc. Examples of supported document areas include Microsoft Word documents and Microsoft Outlook e-mails.
Read From Here
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Start Read From Here
	NUMPAD PLUS
	CAPS LOCK + DOWN ARROW

	Pause/Unpause Reading
	SPACEBAR
	SPACEBAR

	Stop Reading
	NUMPAD PLUS
or ESCAPE
or LEFT CONTROL
or RIGHT CONTROL
	ESCAPE
or LEFT CONTROL
or RIGHT CONTROL

	Stop Reading and switch focus
	LEFT SHIFT + SPACEBAR
	LEFT SHIFT + SPACEBAR

	Read From Here next line
	DOWN ARROW
	DOWN ARROW

	Read From Here previous line
	UP ARROW
	UP ARROW

	Read From Here next paragraph
	P
	P

	Read From Here previous paragraph
	LEFT SHIFT + P
	LEFT SHIFT + P

	Read From Here next sentence
	S
	S

	Read From Here previous sentence
	LEFT SHIFT + S
	LEFT SHIFT + S



	
[bookmark: O_14642][bookmark: _Toc228971309]6.12.1  Read From Here with the Dolphin Cursor
Read From Here is also available when using the Dolphin Cursor. This allows you to continuously read information that you may not otherwise be able to read including web pages, dialog boxes, lists and menus.
You can also turn on or turn off the Dolphin Cursor when you stop Read From Here. Turning on the Dolphin Cursor will place the Dolphin Cursor on the last word spoken. The application does not move focus to the new position. 
Read From Here
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Stop Read From Here and turn on or turn off the Dolphin Cursor
	NUMPAD MINUS
	SPACEBAR



	
[bookmark: O_15988][bookmark: _Toc228971310]6.12.2  Enhance Read From Here
Enhance Read From Here creates an alternative reading environment for you when you use the Read From Here command.
In this reading environment, a magnified window shows the current text being spoken as moving text without line breaks at the top of the screen. The rest of the screen is unmagnified, providing an opportunity to check the visual layout of the document as continuous reading progresses.
To turn on or off this option, you can either choose the "Enhance Read From Here" item in the "Speech" menu in the SuperNova control panel or you can use a SuperNova hot key.
Speech Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Enhance Read From Here
	LEFT CONTROL + CAPS LOCK + 1
	No Assignment


Notes:
	This hot key does not start the continuous reading process. You continue to control continuous reading by using the Read From Here hot keys.
	Enhance Read From Here works only when using magnification. If the Magnifier is turned off this reading mode will not initialise. This is because the magnified window at the top of the screen is proportional to the magnification size you are using.
	
[bookmark: O_15026][bookmark: _Toc228971311]6.13  Read using the mouse
You can set SuperNova to start or stop continuous reading with a mouse click. You can also set SuperNova to read text under the mouse pointer.
	
[bookmark: O_15027][bookmark: _Toc228971312]6.13.1  Click and read
If this is the first time you are using Click and Read From Here then you will have to turn on this option.
To do this:
1.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2.	Press ALT + S.
The "Speech" menu opens.
3.	DOWN ARROW to "Read From Here" and RIGHT ARROW to open its sub-menu.
4.	DOWN ARROW to "Click and Read From Here" and press ENTER to select this item.
5.	Press ESCAPE to close the SuperNova control panel.
You can start Read From Here by pressing the MIDDLE MOUSE BUTTON. This will start the reading from the mouse pointer position. Repeating the button press will stop SuperNova reading.
	
[bookmark: O_15028][bookmark: _Toc228971313]6.13.2  Read text under the mouse pointer position
To read text under the mouse pointer position:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "General Announcements" and press ENTER. This will open the "General Announcements" dialog box.
4.	TAB to the "Announce text under mouse" check box and press SPACEBAR to select this item.
5.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
6.	Press ESCAPE to close the SuperNova control panel.
Text below the mouse pointer position will now be read by SuperNova.
	
[bookmark: O_14635][bookmark: _Toc228971314]6.14  Change what is spoken when typing
You can have:
	Each character you type spoken.
	Each word you type spoken.
	Each character and word you type spoken.
	Nothing spoken when typing.
You can make this change through the SuperNova control panel.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "Character Echo" and press ENTER. This will open the "Character Echo" dialog box.
4.	Select what you want spoken when typing from the options available.
5.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
You can also change the Character Echo value using a SuperNova hot key.
Speech hot key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Character echo cycle
	CAPS LOCK + SEMI COLON
	CAPS LOCK + 2



	
[bookmark: O_15525][bookmark: _Toc228971315]6.15  Announce capital letters
You can announce capital letters by changing settings in the SuperNova control panel. Note that the SuperNova settings will vary depending on the synthesiser you are using.
	
[bookmark: O_15526][bookmark: _Toc228971316]6.15.1  Turn on capital announcement
You can turn on capital announcement by selecting the "Capitals" check box in the "Text Style Announcements" dialog box or by using a SuperNova hot key.
To select the "Capitals" check box:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "Text Style Announcements" and press ENTER. This will open the "Text Style Announcements" dialog box. This is a dialog box with multiple tabs.
4.	If you want capital announcements in edit areas, in the "Edit Areas" tab, TAB to the "Capitals" check box and press SPACEBAR to select this item.
5.	If you want capital announcements in prompt areas like dialog boxes, message windows and worksheets, CONTROL + TAB to open the "Prompt Areas" tab, then TAB to the "Capitals" check box and press SPACEBAR to select this item.
6.	Repeat the previous steps for all other areas and modes where you want to have capital announcements.
7.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
To use the SuperNova hot key:
Speech Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Capitals on / off
	CAPS LOCK + QUOTE
	No Assignment


Note that this hot key changes the "Capitals" check box status in the "Text Style Announcements" dialog box corresponding to your current focus position.
Examples:
	Press the hot key in an edit area and only the status of the "Capitals" check box in the "Edit Areas" tab of the "Text Style Announcements" dialog box will change.
	Press the hot key in a menu and only the status of the "Capitals" check box in the "Menus" tab of the "Text Style Announcements" dialog box will change.
	
[bookmark: O_15527][bookmark: _Toc228971317]6.15.2  Turn on capital announcement when reading lines
By default, if you turn on capital announcement in edit areas then SuperNova will announce capitals when you are typing and when you are moving across a line of text. To also announce capitals when you are reading a line, for example, when you press DOWN ARROW to move focus onto a new line, you must also select the "Announce capitals when reading lines" check box.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "General Announcements" and press ENTER. This will open the "General Announcements" dialog box.
4.	TAB to the "Announce capital letters when reading lines" check box and press SPACEBAR to select this item.
5.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
	
[bookmark: O_15528][bookmark: _Toc228971318]6.15.3  Using sounds to indicate capitals
By default, SuperNova will describe capital letters by using words. Using words is a method all synthesisers support. However, it is also possible with some synthesisers to use a sound to indicate capitals.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "General Announcements" and press ENTER. This will open the "General Announcements" dialog box.
4.	TAB to the Use Beeps for Capital Announcement" check box and press SPACEBAR to select this item. Note that this item will not be available if your current synthesiser does not support this option.
5.	TAB to the "Use sound" list and use the Arrow Keys to select the sound you want to use to indicate capitals.
6.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
The following table describes how SuperNova indicates capitals when you are using words and when you are using sounds.
Capital Announcements
	Description
	Words
	Sounds

	Reading a single capital letter
	Caps + letter
	1x beep

	Reading a word with an initial capital
	Capital + word
	1x beep

	Reading a word written using capital letters
	All Caps + word
	2x beep

	Reading a word written with a mixture of lower case and upper case letters
	Mix caps + word
	2x beep



	
[bookmark: O_15529][bookmark: _Toc228971319]6.15.4  Using a pitch change to indicate capitals when spelling characters
You can indicate a capital letter by raising the pitch of your synthesiser's voice. This option is available when spelling characters.
Examples when you are spelling characters:
	You have Character Echo set to echo each character you type.
	You move across a line of text a character at a time.
	You delete a character.
To indicate capitals with a change in pitch:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "Voice Preferences" and press ENTER. This will open the "Voice Preferences" dialog box.
4.	TAB to the "Increase voice pitch for spelt capitals" check box and press SPACEBAR to select this item. Note that this item will not be available if your current synthesiser does not support this option.
5.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
	
[bookmark: O_14638][bookmark: _Toc228971320]6.16  Speak the keys you press
You can add key announcements to your key presses. This can provide reassurance when using your keyboard.
To use Key Echo:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "Keyboard Announcements" and press ENTER. This will open the "Keyboard Announcements" dialog box.
4.	Press SPACEBAR to deselect the "Automatic key echo" check box.
5.	TAB to the "Selected key echo" group and select the key groupings you want spoken when pressed.
6.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
	
[bookmark: O_14637][bookmark: _Toc228971321]6.17  Change what SuperNova tells you about each type of control
[bookmark: O_14678][image: ]
You can control what SuperNova automatically tells you about a button, a check box, a menu item or any other type of control by changing your Verbosity Level. The lower the Verbosity Level, the less information SuperNova automatically announces about the control.
To change Verbosity Level:
1.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2.	Press ALT + S.
The "Speech" menu opens.
3.	DOWN ARROW to "Verbosity Level" and RIGHT ARROW.
A sub-menu opens.
4.	Use the Arrow Keys to select a menu item and press ENTER.
The Verbosity Level changes and the menu closes.
You can also change Verbosity Level using a SuperNova hot key.
Speech Hot Key
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Verbosity Scheme cycle 
	CAPS LOCK + EQUALS
	CAPS LOCK + V



	
[bookmark: O_14641][bookmark: _Toc228971322]6.18  Change how repeated characters are read
You can change the way SuperNova reads repeated characters that may appear on a line. You can have characters like dashes or plus signs individually spoken, read as a numeric value or indicated with a sound.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "General Announcements" and press ENTER. This will open the "General Announcements" dialog box.
4.	TAB to the "Repeats" button and press SPACEBAR. This will open the "Repeats" dialog box.
5.	Choose how SuperNova should read repeated characters by selecting from the options available.
6.	TAB to the "Close" button and press SPACEBAR. This will confirm your changes and closes the dialog box.
To have SuperNova use your settings requires you to have "Repeats" check box selected in the "Text Style Announcements" dialog box.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "Text Style Announcements" and press ENTER. This will open the "Text Style Announcements" dialog box.
4.	For each area you want your repeat settings used, TAB to the "Repeats" check box and press SPACEBAR to select this item.
5.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
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Chapter 7
[bookmark: O_14644][bookmark: _Toc228971323]7Braille settings
[bookmark: O_14645][bookmark: _Toc228971324]7.1  Turn Braille output off or on
[bookmark: O_14692][image: ]
You can turn off or on Braille output using the "Braille" options in the SuperNova control panel or by using hot keys.
To turn Braille output off or on:
Press LEFT CONTROL + LEFT SHIFT + 0.
	
[bookmark: O_14646][bookmark: _Toc228971325]7.2  Show capital letters
Some versions of Literary Braille denote capital letters by prefixing the letter or contraction with a special sign called a Capital Sign. Other versions of Literary Braille permit the omission of any such notation, thus saving space.
To show or hide the displaying of the capital letter sign in Literary Braille:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the Braille menu.
3.	DOWN ARROW to "Characters" and RIGHT ARROW to open its sub-menu.
4.	Select "Options" and press ENTER. This will open the "Characters" dialog box.
5.	In the "Literary" group box select "Show Capitals" to display the Capital Sign. Unselect this option to hide the Capital Sign.
6.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
In addition to the selection of the "Show Capitals" check box and irrespective of Computer Braille and Literary Braille is the option to "Tremble capitals". This check box is also in the "Characters" dialog box.
Choosing this check box will mean any capital letters will blink. You can control the rate of blinking by the "Blink rate" setting in the "Cursor" dialog box. Blinking capitals in 6-dot Braille is especially useful because Computer Braille often uses dots 7 or 8 to denote capital letters.
	
[bookmark: O_14647][bookmark: _Toc228971326]7.3  Show cursor position
You can indicate the cursor position on your Braille display. This can be useful in edit areas.
To show the cursor position on the Braille display:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Cursor" and RIGHT ARROW to open its sub-menu.
4.	Select "Visible" and press ENTER to select this item.
To turn off showing the cursor position, simply repeat the steps above and deselect the "Visible" menu item.
You can also show or hide the cursor position by using a Braille button command. Please refer to your Braille display commands for further details.
	
[bookmark: O_14656][bookmark: _Toc228971327]7.4  Change what SuperNova tells you about each type of control
You can control what SuperNova automatically tells you about a button, a check box, a menu item or any other type of control by changing your Verbosity Level. The lower the Verbosity Level, the less information SuperNova automatically announces about the control.
To change Verbosity Level:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Verbosity Level" and RIGHT ARROW to open the sub-menu.
4.	Select a Verbosity Level and press ENTER to confirm your change and close the menu.
You can also change Verbosity Level using a SuperNova hot key.
To change Verbosity Level:
Press LEFT SHIFT + CAPS LOCK + EQUALS.
	
[bookmark: O_14648][bookmark: _Toc228971328]7.5  Show enhanced characters (bold, italic, etc.)
You can indicate any enhanced characters on your Braille display by adding dot 8 to the cell. An enhanced character is any character other than normal, like a bold character, an underlined character or a character in a different size font or different colour font.
One example where this can be useful is to find out the shortcut key for menu items and controls in dialog boxes. The underlined letter has dot 8 added to it.
To turn Enhanced Display Mode on:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Characters" and RIGHT ARROW to open its sub-menu.
4.	Select "Enhanced" and press ENTER to select this item.
To turn off showing enhanced characters, simply repeat the steps above and deselect the "Enhanced" menu item.
You can also show or hide Enhanced Characters by using a Braille button command. Please refer to your Braille display commands for further details.
You set what is an enhanced character in the "Characters" dialog box. You open the "Characters" dialog box by selecting the "Options" item in the "Characters" sub-menu. This dialog box contains an "Enhanced Characters" group.
	
[bookmark: O_14649][bookmark: _Toc228971329]7.6  Turn off focus tracking
In normal operation, Braille output shows the focus. SuperNova calls this "tracking the focus".
You can turn tracking the focus off. This has the effect of leaving the Braille display "locked" on a particular area of the screen. For example, you could turn Tracking off and monitor the progress of an Internet download.
To turn off Tracking:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu.
4.	Select "Tracking" and press ENTER to deselect this item.
To turn on Tracking, simply repeat the steps above and select the "Tracking" menu item.
You can also turn off or on Tracking by using a Braille button command. Please refer to your Braille display commands for further details.
Notes:
	Turning Tracking off switches you into Braille Physical Mode. You return to your previous Braille mode when you turn Tracking on again.
	You can continue to move around with Tracking turned off.
	
[bookmark: O_14650][bookmark: _Toc228971330]7.7  Show the physical make up of the screen
There are two ways of positioning information on your Braille display.
	Logical Mode. 
This is the default mode used by SuperNova. In this mode the Braille display will show the logical association of any incidental text with the focus. This is similar to the speech output. The nature of Logical Mode means that the Braille display will not show the position of items on the screen.
	Physical Mode.
This mode provides the opportunity to determine the physical layout of objects on the screen. In Physical mode, you can either show the characters on the line and the gaps between them (useful for general layout), or show a more precise layout of the position of the characters on the line (useful for precise document formatting). 
To turn on Physical Mode:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Layout" and RIGHT ARROW to open its sub-menu.
4.	Select "Physical Mode" and press ENTER to select this item.
To turn on Logical Mode, simply repeat the steps above and deselect the "Physical Mode" item.
You can also switch modes by using a Braille button command. Please refer to your Braille display commands for further details.
You set how Physical Mode shows the make up of the screen in the "Layout" dialog box. You open the "Layout" dialog box by selecting the "Options" item in the "Layout" sub-menu.
	
[bookmark: O_14651][bookmark: _Toc228971331]7.8  Choose Computer Braille or Literary Braille
SuperNova supports two forms of Braille output:
	Computer Braille.
Computer Braille strictly uses one Braille cell per character, whatever that character is. It is of most use in applications where every character is of importance, you need to distinguish each possible character and space is not at a premium.
	Literary Braille.
Literary Braille takes advantage of letter combinations in a language and forms them into contractions, thus saving space. The term Literary Braille covers both grade 1 and grade 2 Braille tables. Literary Braille is of most benefit reading ordinary text.
To change to Literary Braille:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Characters" and RIGHT ARROW to open its sub-menu.
4.	Select "Literary" and press ENTER to select Literary Braille output.
To change to Computer Braille, simply repeat the steps above and deselect the "Literary" menu item.
You can also switch between Literary Braille and Computer Braille by using a Braille button command. Please refer to your Braille display commands for further details.
[bookmark: H_16499]To select which Braille output tables are used, for example, which Braille language, use the options in the "Braille General Preferences" dialog box.
	
[bookmark: O_14661][bookmark: _Toc228971332]7.9  Input using your Braille display
[bookmark: O_14837][image: ]
Some Braille displays have a group of six or eight buttons arranged like a Braille writer. You can use these to simulate typing on your computer keyboard.
To turn Braille Input on or off:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu.
4.	Select "Braille Keys" and press ENTER. Braille input is on when the menu item is checked. Deselect this menu item to turn off Braille input.
You can input using either Computer Braille or Literary Braille. To use Literary Braille input you must also ensure the "Literary Input" item is selected in the same sub-menu. Computer Braille input is used when "Literary Input" is unselected. 
When you use Computer Braille input, you use 8 dots and each Braille character you type will type one character in your document.
When you use Literary Braille input, you use 6 dots and use uncontracted or contracted Braille (depending on the chosen input language).  Please note that the Braille characters you type will only appear in your document when you press the Braille Space key, or another key which is not a combination of Braille dots.
To select which Braille input tables are used, for example, which language, use the options in the "Braille General Preferences" dialog box.
	
[bookmark: O_14652][bookmark: _Toc228971333]7.10  Change Braille table
SuperNova supports two forms of Braille output: Computer Braille and Literary Braille. The term Literary Braille covers both grade 1 and grade 2 Braille tables.
To select which Braille tables are used, for example, which language, use the options in the "Braille General Preferences" dialog box. Here you can set a language for the "Unicode to Braille Conversion" (Computer Braille) table and a language for the "Unicode to Literary Braille Conversion" table.
[bookmark: H_16501]Tip: The "Literary" item in the Braille, "Characters" sub-menu switches you between Computer Braille and Literary Braille output. Deselect this menu item to choose Computer Braille output. For more information go to the "Choose Computer Braille or Literary Braille" topic.
	
[bookmark: O_14653][bookmark: _Toc228971334]7.11  Change Braille display
SuperNova works with many different Braille displays. To see what Braille displays are supported please visit the Dolphin web site or contact your local Dolphin Dealer.
To change to another Braille display:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "General Preferences" and press ENTER. This will open the "General Preferences" dialog box.
4.	CONTROL + TAB to the "Braille Configuration" tab.
5.	TAB to the "Select Braille Display" button and press ENTER. This will open a dialog box that lists all Braille displays currently detected by SuperNova.
6.	Use the Arrow Keys to select an alternative Braille display.
7.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box. You return to the "General Preferences" dialog box.
Your new Braille display should now be in operation.
If your new Braille display is not listed by SuperNova:
	Check you have successfully connected your Braille display to your computer.
	Check you have successfully followed any Braille display install and setup procedures recommended by the display manufacturer.
	Check Dolphin SAM detects the device. To check that Dolphin SAM is configured correctly go to the "General" menu in the SuperNova control panel and select the "Advanced Options" menu item. In the "General Advanced Options" dialog box open the "System Configuration" property sheet and then select the "SAM Setup" button.
If problems persist please contact your Braille display supplier for assistance.
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Chapter 8
[bookmark: O_14654][bookmark: _Toc228971335]8Braille reading
[bookmark: O_14576][bookmark: _Toc228971336]8.1  Learn what your Braille buttons do
You can use the SuperNova Key Describer to help you get familiar with your Braille display. An application will not see or act on any keys pressed when you use Key Describer.
To turn on or off "Key Describer":
Press CAPS LOCK + SLASH.
	
[bookmark: O_16381][bookmark: H_16380]To view or download a copy of the latest default Braille display hot keys visit www.yourdolphin.com/braillekeys. http://www.yourdolphin.com/braillekeys
	
[bookmark: O_14655][bookmark: _Toc228971337]8.2  Moving around the screen
As you use your application the Braille output will automatically show the control you are currently on. If you are using Logical Mode, the Braille will also show any text associated with the control.
You can use the navigation features to move the Braille display to show other information, or to move the Braille along if the contents of the current control will not fit.
The most important keys are the Read Backwards and Read Forwards keys. These move the display along the line to show the previous and next portions of the text.
Braille Navigation Hot Keys
	Function
	Hot Keys
	Braille Buttons

	Move forward
	LEFT CONTROL + LEFT SHIFT + PERIOD
	FORWARD command

	Move backwards
	LEFT CONTROL + LEFT SHIFT + COMMA
	BACK command


The distance the Braille will move is governed by a setting in the Control Panel called the Scroll Margin. This value is set in the "General Preferences" dialog box.
Other navigation keys that are available and will typically have Braille Button assignments are:
	Line Start
This will move the Braille display to show the content at the beginning of the line. This will also move the display to the beginning of any incidental text when in Logical Mode.
	Line End
This will move the Braille display to show the content at the end of the line. This will also move the display to the end of any incidental text when in Logical Mode.
	 Width Left
This will move the Braille display to show the content one full display width to the left.
	Width Right
This will move the Braille display to show the content one full display width to the right.
	Half Width Left
This will move the Braille display to show the content half width to the left.
	Half Width Right
This will move the Braille display to show the content half width to the right.
	Cell Left
This will move the display to show the content one Braille cell to the left.
	Cell Right
This will move the display to show the content one Braille cell to the right.
	Line Up
This will move the display to show the content one line up.
	Line Down
This will move the display to show the content one line down.
	Top
This will move the Braille display to show the content at the top left of the window.
	Bottom
This will move the Braille display to show the content at the bottom left of the window.
	Go to Focus
Move the Braille display back to the position of the focus.
The Go to Focus key will move the Braille back to the place where you started navigation, i.e. to the current control. This can be particularly useful when you are editing a document and wish to move straight back to the cursor. Of course, if you type anything, the Braille will jump back automatically, but this key allows you to return to the focus without affecting your application.
Notes:
	If you move up or down, you will temporarily switch into Physical Mode. Logical Mode is restored when you press Go to Focus.
	Any navigation from the Braille display is independent from the Speech and Dolphin Cursor.
	
[bookmark: O_14657][bookmark: _Toc228971338]8.3  Move the cursor using the Cursor Routing buttons
Many Braille displays have buttons located above each cell, called Cursor Routing Buttons. If you press one of these buttons then SuperNova will generate a single mouse click at that corresponding position.
Examples:
	Pressing the Routing Button In an edit area has the effect of instantly moving the cursor to that point.
	Pressing a routing button above a push button will activate the button.
	Pressing a routing button above a check box will toggle the state of the check box.
Some Braille displays have a second row of Routing Buttons. This second row can be used to describe the character at the corresponding position.
	
[bookmark: O_14797][bookmark: _Toc228971339]8.3.1  Change what the Cursor Routing buttons do
You can change what the Cursor Routing buttons do by changing settings in the SuperNova control panel.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu.
4.	Select "Routing Buttons" and press ENTER. This will open the "Routing Buttons" dialog box.
5.	Select the action you want the Routing Buttons to perform.
6.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
	
[bookmark: O_14798][bookmark: _Toc228971340]8.3.2  Change what the Cursor Routing buttons do while using the Dolphin Cursor
You can change what the Cursor Routing buttons do while you are using the Dolphin Cursor by changing settings in the SuperNova control panel.
To do this:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Input" and RIGHT ARROW to open its sub-menu.
4.	Select "Dolphin Cursor Options" and press ENTER. This will open the "Dolphin Cursor Options" dialog box.
5.	Select the action you want the Routing Buttons to perform.
6.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
	
[bookmark: O_14799][bookmark: _Toc228971341]8.3.3  Change what the Cursor Routing buttons do above Status Cells
You can set Routing Buttons above Status Cells to perform SuperNova commands. 
This provides a useful function for these buttons which otherwise would have no purpose because their position means they cannot be used to route the cursor.
Use the "Keyboard and Hot Keys" dialog box to add a Routing Button to a command.
	
[bookmark: O_14658][bookmark: _Toc228971342]8.4  Check text attributes
Every character has a series of properties (attributes) associated with it, such as its size, font and colour. 
You can learn a characters attributes by switching to Attribute Mode.
Two different Attribute Modes are available.
	Cycle Attributes.
	Describe Cell.
 The Cycle Attributes function uses special dot combinations to show the attributes of every character on the Braille display at once.  By contrast, the Describe Cell function writes a full description of just one character on the Braille display.
Braille Attributes Mode Hot Keys
	Function
	Hot Keys
	Braille Buttons

	Cycle the attributes of the characters shown on the display
	LEFT CONTROL + LEFT SHIFT + 6
	CYCLE ATTRIBUTES command

	Describe the attributes of a single character
	LEFT CONTROL + LEFT SHIFT + 7
	DESCRIBE CHARACTER command



	
[bookmark: O_14800][bookmark: _Toc228971343]8.4.1  Cycle attributes
The Cycle Attributes key will cycle through the various attributes of the characters currently shown on the Braille display. Each cell will indicate the attribute of the character that was at that position.
The Cycle Attributes command is a multi action.
1.	Pressing the key the first time will display the size of each character. 
2.	Pressing the key again will display the style of each character. 
3.	Pressing the key again will display the foreground and background colours of the characters.
4.	Pressing the key again will display the foreground colour.
5.	Pressing the key again will display the font of the characters.
6.	A final press of the key will return to normal mode.
As you cycle through the attributes and you press a key on the computer keyboard or the Go to Focus command on the Braille display, then you will return to the normal character display mode.
An explanation on the Braille output for each attribute is described below.
[bookmark: H_15141]The precise meaning of the dots shown for some of the attributes displayed with Cycle Attributes key may not be immediately obvious.  The function is provided so that it is easy to find when an attribute changes.  You may also find the Enhanced Characters function helpful.
Size
The size of characters is shown as a two digit number representing the point size. The upper four dots of the Braille cell are the tens digit and the lower four dots are the units. For example, a ten point character is shown by dots 1678 (A above J).
Style
The styles of characters are shown as follows:
	Dot 1: Italic.
	Dot 4: Underline.
	Dot 2: Struck out and/or non-normal colour.
	Dot 5: Bold.
	Dot 3: Light.
	Dot 6: Selected.
	Dot 7: Link.
	Dot 8: Normal (i.e. not italic and not underlined and not struck out and not bold and not light).
Colour
The foreground and background are shown with the upper four dots representing the foreground and the lower four dots representing the background.
Foreground Colour
The foreground attribute mode shows just the character’s foreground colour using all eight dots of the cell. The colour is represented using the red/green/blue (RGB) method: dots 123 show the amount of red, dots 456 show the amount of green and dots 78 show the amount of blue. White is shown as all eight dots and black is shown as an empty cell.
Font
Each cell displays a symbol representing the character's font name. As only a single character is used for the whole of the name, the symbol may not seem related to the name it represents, for example the Arial font is represented by dots 15678.  To find the full name of the font, use the Describe Character] function.
	
[bookmark: O_14803][bookmark: _Toc228971344]8.4.2  Describe character
The Describe Character key will display a full description of the character at the cursor position. This is useful if you want to find out what an unfamiliar dot combination represents. 
For example, if you find a symbol you do not understand:
1.	Use the Cursor Route button to move focus to the character.
2.	Press Describe Character to describe the character's attributes.
3.	Use the Navigation keys to move along the description if it does not fit on your display.
The description includes a description of the character itself together with all the attribute information available. The information is written out in full.
You will see a description similar to the following:
"(Dots 467) POUND, Arial, normal, 14PT, Black, White, 00a3"
This shows:
	The character being described. In this example it is dots 467.
	The description of the character (the Pound sign).
	The font name of the character.
	The style.
	The size ("PT" is an abbreviation for "point").
	The foreground colour of the character.
	The background colour.
	The Unicode value of the character.
	
[bookmark: O_14659][bookmark: _Toc228971345]8.5  Show information on the Braille display Status Cells
Many Braille displays have a special group of cells to the left of the main display area to display status information. 
SuperNova can use these status cells to display extra information about the character under the cursor, for example, its size and colour.
You can show any of the following status information:
	Features on display.
	Cursor position across the line.
	Type of the current focus.
	Any of the attributes of the character under the cursor
You can select as many options as you want, except that you will be limited to the number of status cells you have on your Braille display.
Each option takes one cell.
Notes:
	Although your Braille display may not have dedicated status cells, you may be able to simulate status cells using the SAM driver. To check this, call up the Driver Configuration dialog box from the SAM Control Panel. SAM can be opened from the "General Advanced Options" dialog box.
	
[bookmark: O_14660][bookmark: _Toc228971346]8.6  Show Braille output on the screen
You can show what is being output to your Braille display inside a small fixed window on the screen. This is the "Show Braille On Screen" item in the "Braille" menu.
To turn the "Show Braille On Screen" option off or on:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + B. This will open the "Braille" menu.
3.	DOWN ARROW to "Show Braille On Screen" and press ENTER. This will confirm the change and close the menu.
You can also show or hide the window with a hot key:
Press LEFT CONTROL + LEFT SHIFT + 1.
You can change the position and size of the window through options in the "Braille Advanced Options" dialog box.

	69

78	Braille reading

Braille reading	79





Chapter 9
[bookmark: O_14662][bookmark: _Toc228971347]9Dolphin Cursor
The Dolphin cursor is a special kind of cursor created by SuperNova. The Dolphin Cursor allows you to read the contents of the screen line by line, or word by word, or letter by letter using your keyboard. You can use the Dolphin cursor to review any part of your computer's screen.
	
[bookmark: O_14663][bookmark: _Toc228971348]9.1  Turn on the Dolphin Cursor
You can turn on the Dolphin Cursor and position it either at the last place it was located or at the current focus position.
Dolphin Cursor Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn on Dolphin Cursor
	NUMPAD MINUS
	CAPS LOCK + Z

	Turn on Dolphin Cursor and position it at the current focus position
	NUMPAD ASTERISK
	CAPS LOCK + MINUS



	
[bookmark: O_14683][bookmark: _Toc228971349]9.2  Turn off the Dolphin Cursor
If you have turned on the Dolphin Cursor, then to turn off the Dolphin Cursor you must use the following hot key.

Dolphin Cursor Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn Dolphin Cursor off
	NUMPAD MINUS
	CAPS LOCK + Z

	Turn off the Dolphin Cursor and prevent the Dolphin Cursor being automatically turned on
	CONTROL + 4
	No Assignment


The Dolphin Cursor also turns off automatically if something happens on the screen, for example, a message window appears.
	
[bookmark: O_15160][bookmark: _Toc228971350]9.3  Turn off the automatic Dolphin Cursor
SuperNova will automatically turn on the Dolphin Cursor in certain places in certain applications. This default behaviour will occur usually when it is not possible to read the text on the screen line by line using the keyboard commands available in the application.
If you want to prevent this behaviour because you do not wish to use the Dolphin Cursor then you must deselect the "Use Dolphin Cursor automatically" check box. 
To turn off the automatic use of the Dolphin Cursor:
1.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + S. This will open the "Speech" menu.
3.	DOWN ARROW to "Advanced Options" and press ENTER. This will open the "Advanced Options" dialog box.
4.	In the "Cursor" properties, press SPACEBAR to deselect the "Use Dolphin Cursor automatically" check box.
5.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
6.	Press ESCAPE to exit the SuperNova control panel.
[bookmark: H_15161]If you want this setting change only to apply to the current application then you must first create an Application Settings file. See "Create Application Settings" for more information.
	
[bookmark: O_14664][bookmark: _Toc228971351]9.4  Select text using the Dolphin Cursor
You can select text from the screen using the Dolphin Cursor. Text includes text from dialog boxes and message windows as well as text from web pages and documents.
To select text using the Dolphin Cursor:
1.	Press SHIFT + Arrow Keys to make your selection or press CONTROL + A to select all the text in the current window.
2.	Press CONTROL + C to copy your selection to the Clipboard.
3.	Go to the place you want to insert the selected text.
4.	Press CONTROL + V to paste the content from the Clipboard.
	
[bookmark: O_15490][bookmark: _Toc228971352]9.5  Search using the Dolphin Cursor Find Command
You can use the Dolphin Cursor Find Command to perform a basic search for text on the screen, in documents and on web pages. You will find more advanced Dolphin Cursor Find Commands available with some applications.
To perform a basic search:
1.	Turn on the Dolphin Cursor.
2.	Press F3. This will place you in an invisible edit box.
3.	Enter your search string. The text you enter is case insensitive, you are always in Insert Mode and the keyboard layout will match your current application.
4.	Press ENTER to start searching the current window. The Dolphin Cursor will move to the first match it finds.
5.	To find the next match, press F4. To find the previous match, press F2.
Note that SuperNova will remember your last search string until you quit SuperNova. This means you can perform the same search without entering the search string again. You only need to turn on the Dolphin Cursor and press F4 or F2 to search for the next or previous match.
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Chapter 10
[bookmark: O_14666][bookmark: _Toc228971353]10Line View
[bookmark: O_14684][image: ]
Line View is a SuperNova reading mode. Line View shows the content of the screen as a single line scrolling across the screen. You can control the size, colours, font and the speed and position of the scrolling text.
	
[bookmark: O_14667][bookmark: _Toc228971354]10.1  Start Line View
You can start Line View from the "Visual" options in the SuperNova control panel or by using a hot key. Line View can start at the current focus position or it can ignore the current focus in favour of displaying the current window or screen.
Line View Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Start Line View (restricted to document window)
	LEFT CONTROL + NUMPAD PERIOD
	No Assignment

	Start Line View (restricted to whole window)
	LEFT CONTROL + NUMPAD 9
	No Assignment

	Start Line View at current focus position (restricted to document window)
	LEFT CONTROL + LEFT SHIFT + NUMPAD 2
	ALT + SHIFT + L

	Start Line View at current focus position (restricted to whole window)
	LEFT CONTROL + NUMPAD 2
	ALT + SHIFT + V



	
[bookmark: O_14668][bookmark: _Toc228971355]10.2  Scroll text in Line View
You use various hot keys to control how the content scrolls in Line View.
Line View Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Go to the Focus
	NUMPAD 0
	F5

	Start and Stop
	SPACEBAR
	SPACEBAR

	Go to the First line
	HOME
	HOME

	Go to the Last Line
	END
	END

	Previous Line
	PAGE UP
	PAGE UP

	Next Line
	PAGE DOWN
	PAGE DOWN

	Scroll Faster
	UP ARROW
	UP ARROW

	Scroll Slower
	DOWN ARROW
	DOWN ARROW

	Flip forward
	ENTER
	ENTER

	Move Forward
	RIGHT ARROW
	RIGHT ARROW

	Move Backwards
	LEFT ARROW
	LEFT ARROW

	Exit Line View mode
	ESCAPE
	ESCAPE


Tip: Line View mode is restricted to what is visible on the screen. In some applications it is possible to change the application's view settings to increase the data visible at any one time. For example, in Microsoft Word Print Preview it is possible to set the page view to a maximum of 6 pages. All 6 pages will be scrolled in Line View mode.
	
[bookmark: O_14669][bookmark: _Toc228971356]10.3  Change the colour, font and items displayed in Line View
You can change the colours, fonts, objects and the size of the text shown in Line View.
To go to the Line View options:
1.	Press Left control + SPACEBAR. This will open the SuperNova control panel.
2.	Press ALT + V. This will open the "Visual" menu.
3.	DOWN ARROW to "Advanced Options" and press ENTER. This will open the "Visual Advanced Options" dialog box.
4.	CONTROL + TAB to open the "Line View " tab.
5.	Make your changes.
6.	TAB to the "OK" button and press SPACEBAR. This will confirm your changes and close the dialog box.
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Chapter 11
[bookmark: O_14671][bookmark: _Toc228971357]11Doc Reader
[bookmark: O_14685][image: ]
The Doc Reader lets you create your own reading environment, where the text, background and highlight can all be set to a value that makes reading comfortable for you. You can display text from documents, web pages or any other source showing text on the screen.
	
[bookmark: O_14672][bookmark: _Toc228971358]11.1  Launch Doc Reader
You can launch the Doc Reader by pressing the following hot key.
Doc Reader Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Launch Doc Reader
	CAPS LOCK + NUMPAD PLUS
	ALT + SHIFT + D


Your text will be loaded into the Doc Reader. This may take a few seconds. In the Doc Reader, you can use the Arrow Keys to move the highlight through the text or press TAB to move through the Doc Reader toolbar options.
	
[bookmark: O_14673][bookmark: _Toc228971359]11.2  Control reading
[bookmark: H_15994]The items available on the Doc Reader toolbar control the reading environment. For advanced controls, including the colour settings, fonts and reading speed please go to the "Doc Reader Settings" dialog box.
After launching the Doc Reader, you can access the toolbar options by pressing TAB. Repeated presses of TAB will move you along the toolbar options and finally return you to the document window.  You can also use SHIFT + TAB to navigate back across the toolbar buttons.
Doc Reader toolbar.
[image: ]
You press this button to start or stop the reading of the document. You can also start or stop the reading of the document by pressing SPACEBAR. When reading, the Doc Reader highlights the current word and automatically scrolls the document window.
[bookmark: O_14188][image: ]
You press this button to increase the size of the text. The change in the text size is independent from the custom font options in the Doc Reader Settings dialog box.
[bookmark: O_14189][image: ]
You press this button to shrink the size of the text. The change in the text size is independent from the custom font options in the Doc Reader Settings dialog box.
[image: ]
You press this button to reveal the Settings toolbar, where you can choose between different viewing mode options such as "Word Wrap" and "Single Line".

The Settings toolbar buttons are:
[image: ]
You press this button to cycle through the highlighting options, where you can cycle between line, sentence and paragraph highlighting.  The item selected determines what is highlighted as a "unit" and the size of movement as you navigate up and down through your text.
[image: ]
You press this button to cycle through a number of different colour schemes. This is helpful if you find viewing the on screen document text difficult because of screen colours and contrast.
[image: ]
You press this button to toggle word wrap display on and off.
[image: ]
You press this button to toggle single line display on and off.
[image: ]
You press this button to exit the Settings toolbar.
	
[bookmark: O_16995][bookmark: _Toc228971360]11.3  Ask AI a question about the displayed page
To ask AI a question about any of the diagrams, charts, photographs, or handwritten text on the currently displayed page, on Doc Reader's main toolbar press the "Ask AI" button:
[image: ]
An Image Chat Window (see "The Image Chat Window" page 125) will then open allowing you to ask AI questions about images on any part of the page.
	
[bookmark: O_15989][bookmark: _Toc228971361]11.4  Exit Doc Reader
To do this:
Press ESCAPE.
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Chapter 12
[bookmark: O_16674][bookmark: _Toc228971362]12Profiles
SuperNova provides a number of ready-made profiles that allow you to quickly tailor the amount of speech feedback generated by SuperNova without having to make multiple individual setting changes in SuperNova’s control panel.
To select a profile:
1.	Press LEFT CONTROL + SPACEBAR. The SuperNova control panel opens.
2.	Press ALT + F. The File menu opens.
3.	DOWN ARROW to "Profile…" and press ENTER. The "Profiles" dialog box opens.
4.	In the "Profile" list box select the name of the profile that you wish to use. (A description of what the currently selected profile is tailored to do is displayed in the "Description" box directly below.)
5.	Once your desired profile has been selected TAB to the "OK" button and press SPACEBAR. This will confirm your profile choice and close the dialog box.
The status bar of SuperNova’s control panel will automatically update to display the name of your newly selected profile and any SuperNova control panel options that have been disabled by your currently selected profile will become grayed out.
You can also RIGHT CLICK on the profile name in the status bar in order to quickly change profiles.
Here is a list of the available profiles:
Note: Not all of the profiles listed below are available in every edition of SuperNova.

Magnifier
Magnification only for mouse users wanting the fastest performance. It will magnify, follow the mouse pointer and track the cursor as you type. This profile disables all speech and Braille.

Magnifier & Speech with mouse
Magnification with occasional speech, designed for mouse users. This profile enables speech on demand: it will speak text under the mouse and includes hotkeys to read the current line, sentence or paragraph. This profile disables automatic speech, Dolphin Cursor, reading tools and Braille output from a Braille display.

Magnifier & Speech with keyboard
Magnification with some automatic speech for mouse and keyboard users. This profile will speak as you type and read the item in focus, such as menus, list items etc. It switches on the Dolphin Cursor so you can read a web-page from the keyboard. Read From Here and Doc Reader are also included for hands-free reading with speech. This profile disables screen reading descriptions and Braille output from a Braille display.

Magnifier & Screen Reader
This profile supports both mouse and keyboard users, offering magnification with full screen reading in speech and/or Braille via a Braille display. This profile is fully-featured and offers the greatest flexibility.

Screen Reader
Full speech and/or Braille screen reading designed for keyboard users with no useful sight. This profile disables all magnification and visual effects and enables Braille output via a Braille display.

Screen Reader with visual effects
Full speech and/or Braille screen reading for keyboard users. This profile disables magnification but enables visual effects including visual highlighting of the focus. This profile is recommended for those with a limited field of vision, or when sharing your screen with a sighted colleague or trainer.
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Chapter 13
[bookmark: O_14930][bookmark: _Toc228971363]13Settings Files
[bookmark: O_15673][bookmark: _Toc228971364]13.1  Types of Settings
Settings can be grouped into the following broad categories:
	Input Settings control what SuperNova understands about the environment it is currently in. Map files and Script files hold this data.
	Output settings are the settings you can configure in SuperNova for an application. Application Settings files and Situation Settings hold this data.
	Global Settings are settings you cannot configure on a per application basis. This includes hot keys, control panel settings, Update Settings and Window Settings.
You can create, edit, import and export both the input and output settings. You do this by choosing items from the "File" menu in the SuperNova control panel.
	
[bookmark: O_14931][bookmark: _Toc228971365]13.2  Create Application Settings
If you find you regularly adjust SuperNova output settings when working in different programs, then using Application Settings can provide an automated solution.
To create an Application Settings file:
1.	Run the application you want to create an Application settings file for.
2.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
3.	Press ALT + F. This will open the "File" menu with "New" selected.
4.	RIGHT ARROW into the "New" sub-menu.
5.	Select "Application settings" and press ENTER. This will open the "Select Settings file" dialog box.
6.	Select "Create a new settings file".
7.	TAB to the "OK" button and press SPACEBAR. This will open the "Create new Settings File" dialog box.
8.	Give the new Application Settings file a name, choose whether to create an empty settings file or copy an existing settings file and then TAB to the "OK" button and press SPACEBAR. This will close the dialog box and return you to the SuperNova control panel.
Your Application Settings file will now be in use. You can check the Application Settings file currently in use by reading the Status Bar in the SuperNova control panel.
	
[bookmark: O_14932][bookmark: _Toc228971366]13.3  Create Situation Settings
If you find you regularly adjust SuperNova output settings when certain dialog boxes appear in an application then using Situation Settings can provide an automated solution. Situation Settings are a subset of Application Settings and are stored within the same file.
To create a Situation Setting:
1.	Run the application and get into the situation you want to create a Situation Setting for.
2.	Press LEFT CONTROL + SPACEBAR. This will open the SuperNova control panel.
3.	Press ALT + F. This will open the "File" menu with "New" selected.
4.	RIGHT ARROW into the "New" sub-menu.
5.	Select "Situation settings" and press ENTER. This will open the "New Situation Settings" dialog box.
6.	Select "Create new Situation".
7.	TAB to the "OK" button and press SPACEBAR. This will open the "Enter a name for the new Situation" dialog box.
8.	Give the new Situation Setting a name and then TAB to the "OK" button and press SPACEBAR. This will open the "Windows Name" dialog box.
9.	If required, adjust the Window Name and then TAB to the "OK" button and press SPACEBAR. This will close the dialog box and return you t the SuperNova control panel.
Your Situation Setting will now be in use. You can check the Situation Setting currently in use by reading the Status Bar in the SuperNova control panel.
	
[bookmark: O_16282][bookmark: _Toc228971367]13.4  Save setting changes
SuperNova automatically saves the changes you make to SuperNova settings. 
To stop this behaviour, deselect the "Always save user settings" check box. You can find the "Always save user settings" check box in the "Startup Preferences" dialog box, which you open through the "General" menu of the SuperNova control panel.
After deselecting the "Always save user settings" check box, an additional "Ask user" check box becomes available. If you select this check box then you will receive a message window during the quitting of SuperNova that asks if you want to proceed without saving the changes you have made.
You can also manually save settings at any time by choosing the "Save Settings" menu item. You can find this item in the "File" menu in the SuperNova control panel.
	
[bookmark: O_15344][bookmark: _Toc228971368]13.5  Change Map file
If you are using an application that does not have a specific Map file then SuperNova will use the "Default Application" Map file.
If you find SuperNova does not work well with your application using the "Default Application" Map file then it is worth trying another Map file. You can try as many Map files as you like.
Tips:
	Try using a Map file for a different version of the same application. You may find a Map file for an old version of an application will work just as well with a new version of the application.
	Try using a Map file created for an application from the same manufacturer. You may find a Map file for a different application but created by the same manufacturer will work well with your application, for example, if you are using a Microsoft application try using the Microsoft Office Map file.
	Try using the "MSAA Application" Map file if you know your application supports MSAA.
To choose a different Map file:
1.	Run your application.
2.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
3.	Press ALT + F.
The "File" menu opens with the "New" menu item selected.
4.	RIGHT ARROW to open the "New" sub-menu, DOWN ARROW to "Map" and press ENTER.
The "Select Map file" dialog box opens.
5.	DOWN ARROW to select the "Use an existing Map file" option.
6.	TAB to the Map list and use the Arrow Keys to select a Map file.
7.	TAB to the "OK" button and press SPACEBAR.
The dialog box closes.
8.	Press ESCAPE.
The SuperNova control panel closes and you go back to the application.
The new Map file's detection settings will take effect immediately. If you continue to have problems accessing your application then please contact Dolphin or your local Dolphin Dealer for assistance.
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Chapter 14
[bookmark: O_15845][bookmark: _Toc228971369]14Media
You can use the options in the Media menu to search for and download books and magazines from online libraries and to browse news feeds, listen to radio stations and play popular podcasts.
In addition, the options in the Media menu also allow you to either OCR or ask A.I. questions about the visual contents of image files on your hard disk, or scanned via a flatbed scanner, or on your Windows clipboard.
IMPORTANT: The options available in Media will differ depending on your SuperNova Control Panel language.
	
[bookmark: O_16513][bookmark: _Toc228971370]14.1  Media Scan and Read
You can use Media's "Scan and Read" option to convert printed material and image-based files into a format you can read on the computer. 
IMPORTANT: For SuperNova to successfully detect and work with a scanning device requires the device to be WIA compliant. Today, the majority of scanning devices are WIA compliant. Please refer to your manufacturer's support documentation for assistance.
	
[bookmark: O_16516][bookmark: _Toc228971371]14.1.1  Scan and read a file
You can use the Media "Scan and Read" option to convert image-based files into a format you can read on the computer. You do not require a scanner or digital camera connected to the computer to perform this task.
To do this from the SuperNova Control Panel:
1.	Open the "Media" option, select "Scan and Read" and choose "From file".
2.	Select the file you want to convert. If you are using a keyboard you can do this by pressing SHIFT + TAB to move into the file list, use the Arrow Keys to select the file and then press ENTER. If the file is in a different folder, use BACKSPACE to go one level up and use ENTER to open folders until you select the file and then press ENTER.
3.	Select your conversion settings. Note that you must choose to open the document in Microsoft Word if you want to edit the converted document.
[bookmark: H_16583]4.	Select the "OK" button. A message window opens showing the progress of the conversion. When the conversion is complete the book opens in Microsoft Word or the SuperNova Reader.
A quick way to scan and read PDF files is to right-click on the PDF file and select the context menu "Open with" ->"Dolphin SuperNova".
	
[bookmark: O_16517][bookmark: _Toc228971372]14.1.2  Scan and read printed material
You can use the Media "Scan and Read" option to convert print material into a format you can read on the computer.
IMPORTANT: For SuperNova to successfully detect and work with a scanning device requires the device to be WIA compliant. Today, the majority of scanning devices are WIA compliant. Please refer to your manufacturer's support documentation for assistance.
To scan and read printed material from the SuperNova Control Panel:
1.	Ensure the scanning device is correctly connected to the computer.
2.	Open the "Media" option, select "Scan and Read" and choose "From scanner".
3.	Select your conversion settings. Note that you must choose to open the document in Microsoft Word if you want to edit the converted document.
4.	Select the "OK" button. A message window opens showing the progress of the conversion. When the conversion is complete a second message window opens asking if you want to stop or continue scanning pages. 
5.	If you want to scan more pages, add the new page to the scanner and select the "Add More Pages" button. Repeat this process until all pages are scanned and you are ready to read the text.
6.	When done, select the "Stop Loading Pages" button. The book opens in Microsoft Word or the SuperNova Reader.
	
[bookmark: O_16634][bookmark: _Toc228971373]14.1.3  Scan and read a clipboard image
You can use the Media "Scan and Read" option to convert an image you copied to the Windows Clipboard to a format you can read. This feature works best with simple uncomplicated images.
To scan and read an image you copied to the clipboard from the SuperNova Control Panel:
1.	Open the "Media" option, select "Scan and Read" and choose "From clipboard". Note that this option will be disabled if SuperNova does not detect an image present on the Windows Clipboard.
2.	Select your conversion settings. Note that you must choose to open the document in Microsoft Word if you want to edit the converted document.
3.	Select the "OK" button. A message window opens showing the progress of the conversion. When the conversion is complete The book opens in Microsoft Word or the SuperNova Reader.
Tip: If you find the images you convert from the clipboard are unsatisfactory then try saving the image as a .JPEG file and using the Scan and Read "From file" option to improve the conversion quality.
	
[bookmark: O_16519][bookmark: _Toc228971374]14.1.4  Adjust "Scan and Read" settings
The "Scan and Read Settings" dialog box gives you options to choose an alternative scanning device, scanning language, level of colour recognition, paper size and output folder.
[bookmark: H_16539]You can go to the "Scan and Read Settings" dialog box in the SuperNova Control Panel by opening the "Media" option, selecting "Scan and Read" and choosing "Scan and Read Settings". To learn more about the available options see the "Scan and Read Settings" dialog box.
	
[bookmark: O_16989][bookmark: _Toc228971375]14.2  Media Image Description
You can use Media's "Image Description" option to ask AI questions about the visual contents of image files on your hard disk, or scanned via a flatbed scanner, or on your Windows clipboard.
	
[bookmark: O_16990][bookmark: _Toc228971376]14.2.1  Ask a question about an image file
You can use the Media "Image Description" option to ask AI questions about the visual contents of image files on your hard disk.
To do this from the SuperNova Control Panel:
1.	Open the "Media" menu, select "Image Description" and choose "Image file".
2.	Select the image file you want to ask questions about and then press the "Open" button. If you're using a keyboard you can do this by pressing SHIFT + TAB to move into the file list, use the Arrow Keys to select the file and then press ENTER. If the file is in a different folder, use BACKSPACE to go one level up and use ENTER to open folders until you select the file and then press ENTER.
An Image Chat Window (see "The Image Chat Window" page 125) will then open allowing you to ask AI questions about the selected image.
 
	
[bookmark: O_16991][bookmark: _Toc228971377]14.2.2  Ask a question about a scanned image
You can use the Media "Image Description" option to ask AI questions about the visual contents of photographs and other printed material placed on a flatbed scanner attached to your computer.
IMPORTANT: For SuperNova to successfully detect and work with a scanning device requires the device to be WIA compliant. Today, the majority of scanning devices are WIA compliant. Please refer to your manufacturer's support documentation for assistance.
To scan and read printed material from the SuperNova Control Panel:
1.	Ensure the scanning device is correctly connected to your computer and switched on.
2.	Open the "Media" option, select "Image Description" and choose "Image from scanner".
3.	Select the "OK" button. A message window will appear showing the progress of the scan. 
An Image Chat Window (see "The Image Chat Window" page 125) will then open allowing you to ask AI questions about the image you have just scanned in.
	
[bookmark: O_16992][bookmark: _Toc228971378]14.2.3  Ask a question about an image on the Windows clipboard
You can use the Media "Image Description" option to ask AI questions about the visual contents of an image file on your Windows Clipboard.
To do this from the SuperNova Control Panel:
1.	Open the "Media" menu, select "Image Description" and choose "Image from clipboard". Note that this option will be disabled if SuperNova does not detect an image present on your Windows Clipboard.
An Image Chat Window (see "The Image Chat Window" page 125) will then open allowing you to ask AI questions about the image currently on your Windows Clipboard.
	
[bookmark: O_16514][bookmark: _Toc228971379]14.3  Media EasyReader
You can use the "EasyReader" option to search for, download and open books, magazines and newspapers from online libraries. You can also use this option to open files on your computer. The books and files you select open in Dolphin EasyReader.
	
[bookmark: O_16548][bookmark: _Toc228971380]14.4  SuperNova Reader keyboard commands
The books you open from the Bookshelf appear as an HTML page in the SuperNova Reader. This allows you to read and navigate the book in the same way you read web pages.
In addition, SuperNova includes the following keyboard commands:
	Function
	Hot key

	Move between document window and toolbar
	F6

	Move between the buttons on the toolbar
	TAB and SHIFT + TAB

	Play / stop (only available if book has audio content)
	F5

	Open Content
	ALT + C

	Open Settings
	ALT + S

	Zoom In
	ALT + I

	Zoom Out
	ALT + O

	Exit
	ALT + E (or ALT + F4)
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Chapter 15
[bookmark: O_16608][bookmark: _Toc228971381]15Connect and View
[bookmark: O_16648][image: ]
SuperNova Connect and View lets you connect any high-definition (HD) camera to your computer and magnify items including newspapers, magazines, bills, labels and even objects onto your computer screen.
You can also use SuperNova Connect and View to connect to other computers and view what is on their screen on your own computer screen. For example, you can connect to a teacher's interactive whiteboard or a trainer's computer and follow what they are presenting on your own computer screen.
	
[bookmark: O_16609][bookmark: _Toc228971382]15.1  Camera Connect and View
Camera Connect and View lets you connect any High-Definition (HD) Camera to your computer and magnify printed material and objects onto your computer screen.
You can use any high-definition (HD) camera with SuperNova. For an official list of cameras that have been tested and are recommended by Dolphin, please visit the Dolphin web site or contact your local Dolphin dealer.
Before you can use SuperNova Camera Connect and View you will need to acquire a suitable camera, setup your workstation and select the camera in SuperNova.
	
[bookmark: O_16610][bookmark: _Toc228971383]15.1.1  Acquiring a suitable camera and stand
For best results you will need an HD camera with autofocus, delivering 1080p video resolution with automatic low-light correction. This will require a USB 2.0 port connection to the computer.
In addition to the camera, you should use a stand to hold the camera on the desk. The use of a stand makes sure the camera is secure and stable over the items you want to view.
	
[bookmark: O_16611][bookmark: _Toc228971384]15.1.2  Setting up your workstation
For best results, ensure you position the camera close to your computer screen to make it easy to adjust the items you want to view while still being able to view the computer screen. You should also make sure the camera is in a safe, clear, well lit area on your desk to avoid shadows falling across the items you want to view.
	
[bookmark: O_16612][bookmark: _Toc228971385]15.1.3  Selecting the camera in SuperNova
Once you have setup the camera on your desk and connected it to the computer, you must select the camera in the SuperNova "Connect and View Settings" dialog box.
To do this in the SuperNova Control Panel:
1.	In the "Visual" option, open the "Connect and View" submenu and choose "Settings". The "Connect and View Settings" dialog box opens showing the "Camera" settings.
2.	Select your camera from the "Devices" list and choose the "OK" button. If your camera is not listed then ensure it is properly connected and switched on.
	
[bookmark: O_16613][bookmark: _Toc228971386]15.1.4  Using your camera with SuperNova
You can use the following options to enable, configure and adjust the camera image with SuperNova.
	
Switching on the Viewer
After selecting the device in the "Connect and View Settings" dialog box, you can view its output by turning on "Connect and View". You can switch on or off "Connect and View" using the "Visual" options in the SuperNova control panel or by using a hot key.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Connect and View on off
	ALT + NUMPAD ENTER
	LEFT SHIFT + CAPS LOCK + 0



When you turn on "Connect and View" a portion of the screen begins to show the image from the camera or whiteboard. This area is called the Viewer. You can change the position of the Viewer on the screen and you can use the Viewer Toolbar to adjust the size, colour and contrast of the image to make it easier to see.

	
Switching between the Viewer and the desktop
To access the Viewer toolbar and to make adjustments to the image requires you to place the focus in the Viewer window.
You can switch between the Viewer and the desktop by pressing CAPS LOCK + MIDDLE MOUSE BUTTON. If you have both an active camera and whiteboard connection then pressing CAPS LOCK + MIDDLE MOUSE BUTTON cycles you between camera, whiteboard and desktop.
	
Adjusting the Viewer position and size
By default, the Viewer appears on the top half of the screen. You can change the position and size of the Viewer through the "Connect and View" settings in the SuperNova Control Panel. You can dock the viewer to the top, bottom, left or right side of the screen and the Viewer can be set to fill 80%, 50% or 20% of the screen area.
While in the Viewer window you can also press LEFT CONTROL + NUM PAD 7 on your keyboard (LEFT SHIFT + LEFT ALT + M if you're using the laptop hotkey set) to cycle you between split screen mode and full screen mode.
You can also do this using the following buttons in the Viewer's Settings toolbar:
[image: ]
[image: ]
[bookmark: O_14595][image: ]
While in Full Screen Mode, you can continue to use CAPS LOCK + MIDDLE MOUSE BUTTON to switch between the Viewer and the desktop.
	
Accessing the Viewer's Settings toolbar
[bookmark: O_14191]The Viewer's Settings toolbar can be accessed by pressing the Viewer's Settings button:
[image: ]

The Settings toolbar buttons are:
[image: ]
You press this button to cycle through a number of different colour schemes. This is helpful if you find viewing the on screen document text difficult because of screen colours and contrast.
[image: ]
You press this button to cycle the position and size of the Viewer area.
[bookmark: O_16977][image: ]
You press this button to exit the Viewer's Settings toolbar.
	
Showing and hiding the Viewer toolbar
The Viewer Toolbar provides you with controls to modify the image you are viewing. The options available on the toolbar differ depending on whether you are connecting to a camera or connecting to a whiteboard.
You can use the Show and Hide buttons to control the appearance of the Viewer Toolbar. If you hide the toolbar then you will be increasing the amount of information that appears in the Viewer.
The style of the Show and Hide buttons differs depending on where the Viewer is docked. For example, if the Viewer is docked to the top then the Show and Hide buttons appear as Arrows pointing to the left and right. 
[image: ]   [image: ]
If the Viewer window is docked to the left then the Show and Hide buttons appear as Arrows pointing up and down.
[image: ]   [image: ]
In all cases, the position of the Hide button is always the last button on the Viewer Toolbar.
Pressing LEFT CONTROL+BACKSLASH on your keyboard also hides and shows the Viewer Toolbar.


	
Magnifying the image in the Viewer
[image: ]   [image: ]
You can change the size of the image in the Viewer by using the magnification buttons in the Viewer Toolbar. If you are using a touchscreen device, you can also change magnification by doing a 2 finger pinch or 2 finger stretch.
You can also use the following hot keys:
Magnifier Hot Keys
	Function
	Desktop Hot Keys
	Laptop - Universal Set

	Increase magnification
	LEFT CONTROL + NUMPAD PLUS 
or 
CAPS LOCK + MOUSE WHEEL UP
	ALT + EQUALS
or
CAPS LOCK + MOUSE WHEEL UP

	Reduce magnification
	LEFT CONTROL + NUMPAD MINUS
or
CAPS LOCK + MOUSE WHEEL DOWN
	ALT + DASH
or
CAPS LOCK + MOUSE WHEEL DOWN



	
Viewing other parts of the image
If you find the image you are looking at is larger than what is appearing in the Viewer then you can move the mouse pointer or use SuperNova's Pan feature to scroll the image with the keyboard.
To pan across the screen press RIGHT CONTROL plus an Arrow Key. Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. Press the opposite Arrow Key to slow down. 
[bookmark: H_16649]To learn more about panning see "View other parts of the screen".

	
Rotating the image in the Viewer
[bookmark: O_16642][image: ]
You can rotate the image in the viewer to present it in a way that is easiest for you to read. This avoids the necessity to rotate the text under the camera. With each press of this button the image rotates by 90 degrees clockwise.
Pressing LEFT CONTROL + NUM PAD 1 on your keyboard will also rotate the image by 90 degrees clockwise each time you press this hot key combination. (Press PAGE UP if using the laptop hotkey set.)
	
Changing the colours of the image
[image: ]
If you are finding viewing the image difficult because of the colours and contrast, then you can use the Colour Changer button to cycle through a number of different colour schemes.
Pressing LEFT CONTROL + NUM PAD 0 on your keyboard also cycles you through the available colour schemes.
SuperNova saves the Colour Scheme you choose in the "Connect and View Settings" dialog box.
	
Improving image quality
SuperNova contains a number of optional image processing features, such as an Enhance High Contrast Colours option, that helps boost the contrast of images while using one of SuperNova's built in colour schemes. This option is particularly useful when viewing pages containing text and diagrams.
SuperNova also contains an Auto Freeze Image option that attempts to remove "dancing dots" (also known as impulse noise) from the camera's video stream (especially noticeable in poorly lit environments).
Note: Dancing dots, also known as "salt and pepper" (or impulse) noise, is more of a problem when light levels in your environment are low and your camera tries to boost the exposure of the image in order to capture as much light as possible. However, because the camera's image sensor has now been made more sensitive to light, its also now more sensitive to random interference too, and so this gives rise to increased impulse noise (that resemble dancing dots) in successive video frames.
The individual settings for SuperNova's image processing features can be accessed from the Camera tab in Connect & View's Settings dialog box (accessible by going to Visual ->Connect & View ->Settings... in SuperNova's control panel.
	
Controlling Auto Focus
A camera's Auto Focus system, if it has one, is designed to automatically adjust the camera lens to give you the sharpest possible image of the subject. In some cases the camera may be regularly attempting to refocus on what it sees as a changing subject, which may be a distraction. If you find the Auto Focus regularly refocusing then you may wish to turn this feature off.
Pressing LEFT CONTROL + NUM PAD 3 on your keyboard toggles Auto Focus off and on.
Not all cameras include an Auto Focus feature.
	
Switching between digital and optical zoom
If your camera is one that supports optical (sometimes also known as hardware) zoom your Connect & View viewer window will display an extra button that allows you to toggle your camera between digital zoom and optical zoom.
The icon displayed directly below indicates that your camera is currently in digital zoom mode.
Pressing this icon will toggle your camera from digital zoom mode into optical zoom mode:
[bookmark: O_16803][image: ]
The icon displayed directly below indicates that your camera is currently in optical zoom mode.
Pressing this icon (or LEFT CONTROL + NUMPAD 4 using SuperNova's num pad hotkey set, or F6 if using SuperNova's laptop hotkey set) will toggle your camera from optical zoom mode into digital zoom mode:
[bookmark: O_16804][image: ]
	
Locking the image
[image: ]   [image: ]
The Lock Image button (LEFT SHIFT + PAUSE if using SuperNova's num pad hotkey set, or F5 if using SuperNova's laptop hotkey set) lets you freeze the screen on the current image. This allows you to explore the image in more detail without the possibility of the image changing. 
Although available as a Viewer Toolbar button when using a camera, you may find this option more useful when viewing presentations as it will allow you to freeze the screen on a particular slide rather than relying on the teacher to stop the presentation at that point. When you unlock the image the Viewer refreshes the current camera image or shows the current presenter's computer screen.
	
Ask AI a question about the current image
To ask AI a question about any of the diagrams, charts, photographs, or handwritten text displayed on the screen by Connect and View, on Connect and View's main toolbar press the "Ask AI" button:
[image: ]
An Image Chat Window (see "The Image Chat Window" page 125) will then open allowing you to ask AI questions about the current image. 
	
Capture Viewer image
[image: ]
The Capture Image button lets you copy the image in the Viewer to the Windows Clipboard. The image SuperNova captures is the full image, irrespective of the size of magnification you are using in the Viewer.
Pressing CAPS LOCK+P also copies the image in the Viewer to the Windows Clipboard. (PAGE DOWN if you're using the laptop hotkey set.)
	
[bookmark: O_16654]You can then copy the image into a document or you can convert the image you have captured to text by using the SuperNova "Scan and Read" options, or by pressing LEFT CONTROL+CAPS LOCK+O.
	
Open in Doc Reader
[bookmark: O_16789][image: ]
The Open in Doc Reader button lets you OCR the image under the camera. The image SuperNova captures is the full image, irrespective of the size of magnification you are using in the Viewer.
Once the image has been OCR-ed, SuperNova's Doc Reader window will automatically open, providing you with buttons to read aloud the OCR-ed text, and toolbars to help organise, annotate, and export your scanned pages, as well as changing the on-screen layout, colours, and size of the OCR-ed text.

Doc Reader main toolbar:
[bookmark: O_16982][image: ]

Individual buttons:
[bookmark: O_14187][image: ]
Pressing the Play button above starts reading the OCR-ed image. You can also start reading the OCR-ed image by pressing SPACEBAR or NUM PAD PLUS. When reading, the Viewer window highlights the current word and automatically scrolls the document. You can also use your arrow keys to move by line and by word.
[bookmark: O_16792][image: ]
Pressing the Stop above button stops reading the OCR-ed image. You can also stop reading the OCR-ed image by pressing SPACEBAR or ESCAPE.
[bookmark: O_16979][image: ]
Pressing the Organise Pages button above displays the Organise Pages toolbar.

Organise Pages toolbar:
[bookmark: O_16980][image: ]
The Organise Pages toolbar above lets you append further pages to you existing document, copy and delete pages, and move between existing pages too. It also contains a Back button to return to Doc Reader's main toolbar.
If you press the Add Page button on the Organise Pages toolbar an Add Page toolbar will be displayed.

Add Page toolbar:

The Add Page toolbar lets you add pages from a camera, or scanner, or from a support document type, such as a PDF or image file. It also contains a Back button to return to the Organise Pages toolbar.

[bookmark: O_16985][image: ]
Pressing the Save button above opens the Save toolbar.

Save toolbar:
[bookmark: O_16848][image: ]
If you select the Microsoft Word, Google Drive, or PDF export buttons, you'll be presented with the two further options: Export the text preserving formatting, and Export the text preserving formatting and layout.
Your exported document will then be automatically opened in Microsoft Word, or your system's default PDF reader, or Windows Notepad (depending on your chosen export format) and an original copy of your document will also be automatically placed in your Windows "My Documents" folder and named snova_clipboardXXX.xml (where XXX is a number with the highest number being your most recently exported document).

[bookmark: O_16882][image: ]
Pressing the Settings button above opens the Settings toolbar, where you can choose between different viewing modes, such as Word Wrap, Single Line, Single Column, and also control screen colours and whether image view tracks the cursor or not.

Settings toolbar:
[bookmark: O_16986][image: ]
Pressing the View button cycles between four different viewing modes:
[bookmark: O_16786][image: ]
Text-only viewing mode.
[bookmark: O_16787][image: ]
Text and original image size-by-side horizontally mode.
[bookmark: O_16788][image: ]
Text and original image size-by-side vertically mode.
[bookmark: O_16790][image: ]
Original image-only mode.
The original image can be scrolled in both Original image-only mode and in side-by-side mode using your finger (on a touch-screen display), or by holding down your left mouse button and moving your mouse.
[bookmark: O_14190][image: ]
Pressing the Units button above cycles between line, sentence and paragraph highlighting.  The item selected determines what is highlighted as a "unit" and the size of movement as you navigate up and down through your scanned text.
[image: ]
Pressing the Colour Scheme button above cycles through a number of different colour schemes. 
[bookmark: O_16975][image: ]
Pressing the Word Wrap button above toggles word wrap display on and off.
[bookmark: O_16976][image: ]
Pressing the Single Line button above toggles single line display on and off.
[bookmark: O_16987][image: ]
Pressing the Single Column button above toggles display on and off.
	
Access to Google Drive
When you select the export to Google Drive option for the first time in SuperNova, SuperNova will open a dialog box named "Google Account Permissions" informing you that SuperNova needs to be granted permission to upload scanned documents to your Google account.
	Press the "Sign in with Google" button in this dialog box to start the process. SuperNova will then open your system's default web browser and load the Google web site page https://accounts.google.com/o/oauth2/auth
	Please log into your Google account through Google's sign-in web page that should just have appeared in your system's default web browser and follow Google's on-screen instructions.
	After logging into your Google account a new Google web page will be displayed stating "SuperNova wants access to your Google Account" along with a "Continue" button.
	To authorise SuperNova to be able to upload documents to your Google Drive press the "Continue" button and on the next Google web pages that loads press the "Copy" button next to the "Authorisation code" that's displayed on this web page. This will copy the authorisation code to your Windows clipboard (for pasting into SuperNova).
	Now return to SuperNova's Google Account Permissions dialog box and use the Windows shortcut key CTRL+V to paste your Google authorisation code into the authorisation code edit area in SuperNova and press the "OK" button to continue and have SuperNova automatically upload your first exported document to your Google Drive.
SuperNova only communicates directly with Google APIs. No user data is shared with Dolphin or any other party.
SuperNova stores your authorisation code (not your username or password) on your computer for later reuse by you. So use caution when using SuperNova on shared computers.
	
Annotating images
Adding an annotation
To add annotations to your Connect & View scanned image, from Doc Reader's main toolbar press the Annotate button:
[bookmark: O_16818][image: ]
Note: You can only add annotations when the page is being viewed in image mode or in a text plus image mode. i.e. Not in text-only mode. In text-only mode the Annotate button be removed from Doc Reader's main toolbar.
The Annotate toolbar will then open with the following buttons:


From left to right the buttons are the Back button (which closes the Annotate toolbar), the add Sticky Note button, the add Highlight button, the add Box button, the add Circle button, and the add Line button.
Note: The document background can be scrolled or panned independently of the annotation, thus allowing you to position the magnified document at the exact position that you want to add your annotation. 
While creating an annotation the following two buttons will be available:
[image: ]
The Colour Changer button above will cycle between the available colours for the current annotation. Each annotation has it’s own colour options. For Sticky Notes: black on white, white on black, black on pink, black on light blue and black on yellow. For the Highlighter: yellow, green, pink and light blue. For the box, circle and line annotation types: red, green, blue and black.
When you're happy with your annotation press the Save button (pictured below) and the annotation will be saved to your document.
[bookmark: O_16830][image: ]
Repositioning an annotation
If you press and hold a finger inside the border of an annotation you'll be able to reposition the annotation by panning.
Note: Pinch to zoom is disabled while you're repositioning an annotation
Resizing an annotation
To resize an annotation:
1.	Press and hold with one finger one of the annotation's borders (left, right, top. or bottom). The border will start flashing. 
2.	Keeping your finger held down you can now drag that border to the where you want it to be. 
3.	If you release your finger the border will still flash. You can then use a panning gesture to resize the flashing border if you wish. e.g. If the bottom border is flashing, you can pan up or down to resize, whereas if the left border is flashing you can pan right or left.
4.	If you press and hold another border when you have one selected, this then becomes the selected border and will flash. Dragging and panning now changes this border.
5.	A single tap outside any of the black borders will exit resizing mode and stops the border flashing.
For mouse users, moving your mouse pointer over an annotation's borders will change your mouse pointer to show you how you can resize it. You can resize the annotation by dragging its border while holding down the left mouse button while your mouse pointer is the left/right arrow pointer or up/down arrow pointer.
For mouse users, you can reposition the annotation by dragging the top border when the regular mouse pointer is displayed.
Editing an existing annotation
After you have added an annotation, if you want to reposition it or change its colour, you can double-tap (or double-left click the annotation with your mouse) in order to edit it.
The annotation's border will start flashing to indicate it's been selected. You can then reposition or resize it as described above.
The Annotate toolbar will be shown again with an additional button, the Delete Annotation button (pictured below).
[bookmark: O_16821][image: ]
Pressing the Delete Annotation button will delete the currently selected annotation from the document.
Exporting your annotations
Your annotations are saved alongside your original document in a separate file. When you open your document in SuperNova's Doc Reader in the future, your annotations will be automatically loaded as well, leaving you where you left off.
	
Ask AI a question about the displayed page
To ask AI a question about any of the diagrams, charts, photographs, or handwritten text on the currently displayed page, on Doc Reader's main toolbar press the "Ask AI" button:
[bookmark: O_16996][image: ]
An Image Chat Window (see "The Image Chat Window" page 125) will then open allowing you to ask AI questions about images on any part of the page.
	
[bookmark: O_16614][bookmark: _Toc228971387]15.1.5  Camera settings
You can find all the SuperNova Camera Connect and View settings in the SuperNova Control Panel. You can find these options through the Visual button bar or through the Connect and View menu. For further information see the Connect and View Settings dialog box.
	
[bookmark: O_16615][bookmark: _Toc228971388]15.2  Whiteboard Connect and View
Whiteboard Connect and View uses virtual network computing (VNC) to let you connect to another computer and magnify and track what appears on their screen on your computer screen.
VNC is a type of software that makes it possible to view another computer over a network connection. There are a number of free and low cost VNC software programs available. These include tight VNC, Ultra VNC and Real VNC. The VNC software must be installed and running on the presenter's computer for SuperNova to make a connection. The VNC software does not need to be installed on your computer.
For more information about VNC programs that have been tested and are recommended by Dolphin, please visit the Dolphin web site or contact your local Dolphin dealer.
	
[bookmark: O_16616][bookmark: _Toc228971389]15.2.1  Connecting to the presenter's computer
You can connect to the presenter's computer that is running VNC software by creating a whiteboard profile. A whiteboard profile will require you to enter specific information, which may only be available from your Network Administrator. This information includes the name of the computer and any security password set in the VNC software.
[bookmark: H_15631]To create a whiteboard profile, do the following in the SuperNova Control Panel: 
1.	In the "Visual" option, open the "Connect and View" submenu and select "Settings". The "Connect and View Settings" dialog box opens.
2.	If this is a new profile you want to create, select the "Whiteboard" page and choose the "New" button. The "Whiteboard Settings" dialog box opens.
3.	If this is a profile you want to edit, open the "Whiteboard" page, select the profile from the "Devices" list and choose the "Settings" button. The "Whiteboard Settings" dialog box opens.
4.	In the "Profile" box type a name for this profile. Give the profile a meaningful name, for example, the name of the classroom, teacher or trainer.
5.	Complete the remaining fields as provided to you by your Network Administrator. For further information see the Connect and View Settings dialog box section.
6.	Select the "OK" button. SuperNova saves the settings and goes back to the previous dialog box.
7.	Select the "OK" button. SuperNova saves the profile, adds it to the Devices list and closes the dialog box.
	
[bookmark: O_16617][bookmark: _Toc228971390]15.2.2  Viewing the presenter's computer
To see the presenter's computer screen requires you to select the profile in the "Connect and View Settings" dialog box and then to turn on the Connect and View feature.
When you are connected to the presenter's computer, you can use the following options to enable, configure and adjust the Viewer.
	
Switching on the Viewer
After selecting the device in the "Connect and View Settings" dialog box, you can view its output by turning on "Connect and View". You can switch on or off "Connect and View" using the "Visual" options in the SuperNova control panel or by using a hot key.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Connect and View on off
	ALT + NUMPAD ENTER
	LEFT SHIFT + CAPS LOCK + 0



When you turn on "Connect and View" a portion of the screen begins to show the image from the camera or whiteboard. This area is called the Viewer. You can change the position of the Viewer on the screen and you can use the Viewer Toolbar to adjust the size, colour and contrast of the image to make it easier to see.

	
Switching between the Viewer and the desktop
To access the Viewer toolbar and to make adjustments to the image requires you to place the focus in the Viewer window.
You can switch between the Viewer and the desktop by pressing CAPS LOCK + MIDDLE MOUSE BUTTON. If you have both an active camera and whiteboard connection then pressing CAPS LOCK + MIDDLE MOUSE BUTTON cycles you between camera, whiteboard and desktop.
	
Showing and hiding the Viewer toolbar
The Viewer Toolbar provides you with controls to modify the image you are viewing. The options available on the toolbar differ depending on whether you are connecting to a camera or connecting to a whiteboard.
You can use the Show and Hide buttons to control the appearance of the Viewer Toolbar. If you hide the toolbar then you will be increasing the amount of information that appears in the Viewer.
The style of the Show and Hide buttons differs depending on where the Viewer is docked. For example, if the Viewer is docked to the top then the Show and Hide buttons appear as Arrows pointing to the left and right. 
[bookmark: O_16644][bookmark: O_16645][image: ]   [image: ]
If the Viewer window is docked to the left then the Show and Hide buttons appear as Arrows pointing up and down.
[bookmark: O_16646][bookmark: O_16647][image: ]   [image: ]
In all cases, the position of the Hide button is always the last button on the Viewer Toolbar.
Pressing LEFT CONTROL+BACKSLASH on your keyboard also hides and shows the Viewer Toolbar.


	
Magnifying the image in the Viewer
[bookmark: O_16632][bookmark: O_16633][image: ]   [image: ]
You can change the size of the image in the Viewer by using the magnification buttons in the Viewer Toolbar. If you are using a touchscreen device, you can also change magnification by doing a 2 finger pinch or 2 finger stretch.
You can also use the following hot keys:
Magnifier Hot Keys
	Function
	Desktop Hot Keys
	Laptop - Universal Set

	Increase magnification
	LEFT CONTROL + NUMPAD PLUS 
or 
CAPS LOCK + MOUSE WHEEL UP
	ALT + EQUALS
or
CAPS LOCK + MOUSE WHEEL UP

	Reduce magnification
	LEFT CONTROL + NUMPAD MINUS
or
CAPS LOCK + MOUSE WHEEL DOWN
	ALT + DASH
or
CAPS LOCK + MOUSE WHEEL DOWN



	
Viewing other parts of the image
If you find the image you are looking at is larger than what is appearing in the Viewer then you can move the mouse pointer or use SuperNova's Pan feature to scroll the image with the keyboard.
To pan across the screen press RIGHT CONTROL plus an Arrow Key. Hold down RIGHT CONTROL to keep panning. Press the same Arrow Key repeatedly (keeping RIGHT CONTROL pressed) to speed up the panning. Press the opposite Arrow Key to slow down. 
To learn more about panning see "View other parts of the screen".

	
Changing the colours of the image
[bookmark: O_16637][image: ]
If you are finding viewing the image difficult because of the colours and contrast, then you can use the Colour Changer button to cycle through a number of different colour schemes.
Pressing LEFT CONTROL + NUM PAD 0 on your keyboard also cycles you through the available colour schemes.
SuperNova saves the Colour Scheme you choose in the "Connect and View Settings" dialog box.
	
Tracking the presenter's movement
[bookmark: O_16639][image: ]
You can control the tracking of the presenter's movement by using the Track Presenter button. When you turn on this feature, the image in the Viewer will automatically scroll to follow the movement of the presenter's mouse pointer around the screen. The tracking of the presenter's mouse pointer will temporarily stop if you begin to move your mouse pointer and tracking resumes again when you stop moving your mouse pointer.
You can prevent the Viewer following the presenter's mouse pointer by turning this feature off.
	
Locking the image
[bookmark: O_16640][bookmark: O_16641][image: ]   [image: ]
The Lock Image button (LEFT SHIFT + PAUSE if using SuperNova's num pad hotkey set, or F5 if using SuperNova's laptop hotkey set) lets you freeze the screen on the current image. This allows you to explore the image in more detail without the possibility of the image changing. 
Although available as a Viewer Toolbar button when using a camera, you may find this option more useful when viewing presentations as it will allow you to freeze the screen on a particular slide rather than relying on the teacher to stop the presentation at that point. When you unlock the image the Viewer refreshes the current camera image or shows the current presenter's computer screen.
	
Capture Viewer image
[bookmark: O_16638][image: ]
The Capture Image button lets you copy the image in the Viewer to the Windows Clipboard. The image SuperNova captures is the full image, irrespective of the size of magnification you are using in the Viewer.
Pressing CAPS LOCK+P also copies the image in the Viewer to the Windows Clipboard. (PAGE DOWN if you're using the laptop hotkey set.)
	
[bookmark: O_16654_1]You can then copy the image into a document or you can convert the image you have captured to text by using the SuperNova "Scan and Read" options, or by pressing LEFT CONTROL+CAPS LOCK+O.
	
[bookmark: O_16618][bookmark: _Toc228971391]15.2.3  Whiteboard settings
[bookmark: H_16620]You can find all the SuperNova Whiteboard Connect & View settings in the SuperNova Control Panel. You can find these options through the Visual button bar or through the Connect & view menu. For further information see the Connect & View Settings dialog box.
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Chapter 16
[bookmark: O_16502][bookmark: _Toc228971392]16Touchscreen
[bookmark: O_16503][bookmark: _Toc228971393]16.1  Touchscreen terminology
The following table provides a description of touchscreen gestures and what the gesture means.

	Gesture
	How to do it

	Tap
	Tap the screen to perform an action, for example, tap a button to activate the button. Some gestures may require you to tap the screen with 1, 2, 3 or more fingers multiple times.

	Press and hold
	Press a finger on the screen and continue to hold the finger against the screen.

	Swipe
	A flick of a finger across the screen.

	Slide
	A longer slower movement of a finger across the screen usually in a vertical or horizontal direction from the screen edge.

	Pinch
	Press two fingers on the screen and move them together, as if you are pinching them together.

	Stretch
	Press two fingers on the screen and move them away from each other, as if you are stretching them apart.



	
[bookmark: O_16509][bookmark: _Toc228971394]16.2  Touchscreen gestures
The following table provides a list of the touchscreen gestures you can use to control SuperNova.

	Function
	Gesture

	Toggle magnification
	3 finger double tap

	Increase magnification
	2 finger stretch

	Reduce magnification
	2 finger pinch

	Pan
	1 finger swipe

	Show / hide the SuperNova Touch Bar
	3 finger single tap

	Announce text under the finger position
	1 finger press and hold



	
[bookmark: O_16506]More gestures.
In addition to the SuperNova touchscreen gestures, here are some more touchscreen gestures to help you get around Windows.

	Function
	Gesture

	Open the Charms (Search, Share, Start, Devices, Settings).
	Slide in from over the right edge with 1 finger

	Switch apps
	Swipe in from over the left edge with 1 finger.

	Open the App Menu. The App Menu shows commands like Save, Edit and Delete.
	Slide in from over the bottom edge with 1 finger.

	Close the open app
	Slide in from over the top edge with 1 finger and continue the motion, dragging the app down to the bottom of the screen.

	Open the context menu (this is the same as performing a right click on a selected item)
	1 finger double tap, hold and release.

	Drag and drop objects around the screen, for example, when re-arranging the Start Screen or desktop.
	1 finger double tap and hold, then slide to move the object. Lift finger to release.



	
[bookmark: O_16508][bookmark: _Toc228971395]16.3  SuperNova Touch Bar
[bookmark: H_16507]The SuperNova Touch Bar is a touchscreen toolbar that appears at the bottom of the screen when you do a 3 finger  single tap. The Touch Bar gives you access to the most common SuperNova actions including turning magnification on and off, changing magnification size and turning the SuperNova Colour Scheme on and off.
	
[bookmark: O_16559][bookmark: O_16560][image: ]
	
[bookmark: O_16504][bookmark: _Toc228971396]16.4  Typing on a touchscreen
SuperNova automatically shows an onscreen keyboard when you need to type and you do not have a keyboard connected to the device. The onscreen keyboard appears at the bottom of the screen and uses large print high contrast keys.
You can also make the keyboard appear at any time by tapping the Keyboard button in the SuperNova Touch Bar or by tapping the Keyboard button in the Windows Notification area. To hide the keyboard, tap the large "X" button in the bottom right corner of the onscreen keyboard.
You can adjust the appearance of the onscreen keyboard in the Touchscreen Settings dialog box.
	
[bookmark: O_16510][bookmark: _Toc228971397]16.5  Adjust touch sensitivity
You can adjust how sensitive SuperNova is to your taps and swipes on the touchscreen. 
For example, If you find that SuperNova is interpreting a double tap gesture as two single tap gestures then you may need to increase the double-tap timeout”. In the same way, if you find that when attempting to drag and drop a desktop icon the icon is not being picked up, then you may need to increase the double-tap timeout or the pass-through timeout”.
[bookmark: H_16512]You make the changes to SuperNova's touchscreen settings in the Touchscreen dialog box.
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Chapter 17
[bookmark: O_16997][bookmark: _Toc228971398]17Understanding Images with AI
SuperNova's Ask AI feature allows you to understand the contents of images by asking questions in natural language. This powerful tool can describe pictures, explain charts, and analyse visual information from various sources.
	
[bookmark: O_16998][bookmark: _Toc228971399]17.1  Accessing Ask AI Image Chat
You can launch a Ask AI Image Chat window from several places within SuperNova, as well as directly using SuperNova's layered hot keys.
You can launch it:
	From Connect & View: When viewing an image from a camera or whiteboard, press the "Ask AI" button on Connect & View's toolbar. This will pass the current screen image to the Ask AI Image Chat window.
	From DocReader: When viewing a scanned document, PDF, or image file in DocReader, press the "Ask AI" button on DocReader's toolbar. This allows you to ask questions about any image on the current DocReader page.
	From the "Image Description" sub-menu options in SuperNova's "Media" menu.
	Directly via hot keys: Press CAPS LOCK + SPACEBAR, followed by Q, to access the Ask AI layer, where you can do all of the above as well as ask questions about the visual contents of the current application window or the full screen.
	
[bookmark: O_16999][bookmark: _Toc228971400]17.2  The Image Chat Window
The Image Chat window provides a consistent user interface for all your conversations with AI It contains the following elements:

	A text message informing you of the number of AI questions you have remaining this month. For example: "You have 97 questions left this month out of 100".
	A preview image of the contents of the image file you selected in the previous step.
	A "Remove Image" button that allows you to remove the selected image if for example you accidentally selected the wrong image file in the previous step. When you press the "Remove Image" button the preview image and the "Remove Image" button will disappear from the window and will be replaced with option "Drop an image onto here, click to upload or paste from clipboard (Ctrl + V)". So for example, if you click on this option you will then be able to select the correct image file you originally intended.
	An edit area in which you can type a question about your selected image file and then press ENTER (or click the "Ask AI" button if you're a mouse user).
	
[bookmark: O_17000][bookmark: _Toc228971401]17.3  Asking A Question
To ask your question, type it into the question edit area and then press ENTER (or click the "Ask AI" button if you're a mouse user).
Once you have submitted your question the status message "processing" will appear, followed a few seconds later by the A.I's response to your question.
	
[bookmark: O_17002][bookmark: _Toc228971402]17.4  Reviewing and Navigating the Conversation
You can review the AI's response a line, word, or character at a time using the Dolphin Cursor, just as you would on a web page.
Because SuperNova's Ask AI Image Chat feature supports multi-turn conversations, you can use SuperNova's quick navigation keys to move through the chat history:
	SHIFT+H: Navigates to the previous question or answer.
	H: Navigates to the next question or answer.
	
[bookmark: O_17003][bookmark: _Toc228971403]17.5  Closing the Image Chat Window
When you have finished, press ALT+F4 (or click the 'X' button) to close the Image Chat window.
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Chapter 18
[bookmark: O_17010][bookmark: _Toc228971404]18Notification Finder
SuperNova's Notification Finder feature allows you to review notifications that appear on your computer from Microsoft Outlook, Microsoft Teams, and Windows that you may have missed or only partially reviewed before they disappeared.
This feature relies on SuperNova "seeing" the popup notification, so if you have "Do Not Disturb" or "Focus Mode" options enabled in these applications, the notification may not be captured by SuperNova.
	
[bookmark: O_17011][bookmark: _Toc228971405]18.1  Using Notification Finder
You can launch the Notification Finder window from within SuperNova's "General" menu, as well as directly using SuperNova's layered hot keys.
You can launch it:
	From the "Notification Finder" sub-menu option in SuperNova's "General" menu.
	Via layered hot keys: Press CAPS LOCK + SPACEBAR, followed by F3, or else press CAPS LOCK + SPACEBAR, followed by Y, followed by N.
The Notification Finder window contains the following elements:
	Recent Notifications (shortcut ALT+N). A list displaying the notifications that have arrived. Each list entry begins with the notification title e.g. Outlook, Teams, etc., in order to make it easy to distinguish which app each notification has come from and includes a time stamp.  
	Message. A read-only edit area displaying the full text of the selected notification in the Recent Notifications list.
	Refresh Notifications (shortcut key ALT+R). This button refreshes the list of notifications to display any new notifications that have arrived while the Notification Finder window is open. e.g. You were viewing the list and were distracted by a colleague and were unsure if you have missed any new notifications. 
	Clear Notifications (shortcut key ALT+C). This button clears the Recent Notifications list. Notifications are stored until the list is cleared.
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Chapter 19
[bookmark: O_15162][bookmark: _Toc228971406]19Hot Keys
[bookmark: O_1424][bookmark: _Toc228971407]19.1  Actions
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Auto Train Graphic Objects
	LEFT CONTROL + RIGHT BRACKET
	CONTROL + CAPS LOCK + G

	Doc Reader
	CAPS LOCK + NUMPAD PLUS
	SHIFT + ALT + D

	Exit Auto Train Graphic Objects
	ESCAPE
	ESCAPE

	Freeze The Screen
	PAUSE
	PAUSE

	SuperNova Help
	CAPS LOCK + F1
or RIGHT CONTROL + RIGHT SHIFT + FORWARD SLASH
	CAPS LOCK + F1

	SuperNova Hotkey Helper
	LEFT SHIFT + CAPS LOCK + F2
	SHIFT + CAPS LOCK + F2

	Hot Keys on / off
	LEFT CONTROL + 8
	SHIFT + CAPS LOCK + 3

	Quick Navigation Keys on / off
	LEFT CONTROL + CAPS LOCK + 8
	LEFT CONTROL + CAPS LOCK + 8

	Open Control Panel
	LEFT CONTROL + SPACEBAR
	LEFT CONTROL + SPACEBAR

	Pass next key to application
	LEFT CONTROL + 7
	CAPS LOCK + 3

	Quit
	CAPS LOCK + F4
	CAPS LOCK + F4

	Row / Column Mode Toggle
	LEFT CONTROL + 9
	LEFT CONTROL + 9

	Screen Refresh
	LEFT CONTROL + SEMI COLON
	CAPS LOCK + ESCAPE

	Show TTS Language selection dialog
	No Assignment
	CONTROL + CAPS LOCK + L

	Show TTS selection dialog
	No Assignment
	CONTROL + CAPS LOCK + S

	OCR from your scanner, camera, or open PDF file
	CAPS LOCK + O
	CAPS LOCK + O

	OCR from the Windows clipboard
	LEFT CONTROL + CAPS LOCK + O
	LEFT CONTROL + CAPS LOCK + O

	Copy the image of the currently magnified screen to the Windows clipboard
	CAPS LOCK + PRINT SCREEN
	CAPS LOCK + PRINT SCREEN

	Copy the image currently in the Connect and View Viewer window to the Windows clipboard
	CAPS LOCK + P
	CAPS LOCK + P

	Restore default user profile
	LEFT CONTROL + CAPS LOCK + P
	LEFT CONTROL + CAPS LOCK + P


Unassigned Commands
The following is a list of unassigned commands within this category. These commands can be manually assigned a key combination.
	Application Help
	Screen capture
	Show Speech Verbosity dialog
	Start Script Editor
	Train windows
	Train windows with a delay
	Windows Basics Help
	
[bookmark: O_3933][bookmark: _Toc228971408]19.2  Speech
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Anti-stutter system on / off
	LEFT CONTROL + 6
	LEFT CONTROL + 6

	Announce text under mouse pointer on / off
	CAPS LOCK + M
	CAPS LOCK + M

	Capitals on / off
	CAPS LOCK + QUOTE
	CAPS LOCK + QUOTE

	Character Echo Cycle
	CAPS LOCK + SEMI COLON
	CAPS LOCK + 2

	Key Describe Mode
	CAPS LOCK + FORWARD SLASH
	CAPS LOCK + 1

	Language Down
	LEFT CONTROL + FULL STOP
	No Assignment

	Language Up
	LEFT CONTROL + COMMA
	No Assignment

	Monitor Markers
	LEFT CONTROL + 5
	LEFT CONTROL + 5

	Mute
	LEFT CONTROL
	LEFT CONTROL

	Next Synthesiser
	LEFT CONTROL + LEFT SHIFT + RIGHT BRACKET
	LEFT CONTROL + LEFT SHIFT + RIGHT BRACKET

	Previous Synthesiser
	LEFT CONTROL + LEFT SHIFT + LEFT BRACKET
	LEFT CONTROL + LEFT SHIFT + LEFT BRACKET

	Speed decrease
	LEFT CONTROL + LEFT SHIFT + MINUS
	LEFT CONTROL + ALT + PAGE DOWN

	Speed Increase
	LEFT CONTROL + LEFT SHIFT + EQUALS
	LEFT CONTROL + ALT + PAGE UP

	Verbosity Scheme Cycle
	CAPS LOCK + EQUALS
	CAPS LOCK + V

	Voice on / off
	LEFT CONTROL + 0
	LEFT CONTROL + ALT + 0

	Volume decrease
	LEFT CONTROL + MINUS
	LEFT CONTROL + ALT + MINUS

	Volume increase
	LEFT CONTROL + EQUALS
	LEFT CONTROL + ALT + EQUALS



[bookmark: O_1430][bookmark: _Toc228971409]19.3  Speak Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Additional Focus Information
	LEFT SHIFT + NUMPAD 0
	LEFT CONTROL + CAPS LOCK + UP ARROW

	Character
	NUMPAD 4
	CAPS LOCK + LEFT ARROW

	Control
	NUMPAD PERIOD
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + UP ARROW

	Describe Focus Position
	NUMPAD 8
	LEFT CONTROL+LEFT SHIFT+CAPS LOCK+LEFT ARROW

	Describe Shortcut Key
	LEFT SHIFT + NUMPAD PERIOD
	CONTROL + CAPS LOCK + LEFT ARROW

	Focus
	NUMPAD 0
	CAPS LOCK + UP ARROW

	From Cursor
	LEFT SHIFT + NUMPAD 2
	CAPS LOCK + END

	Headings
	NUMPAD 3
	SHIFT + CAPS LOCK + LEFT ARROW

	Label Above
	CAPS LOCK + NUMPAD 8
	No Assignment

	Label To Left
	CAPS LOCK + NUMPAD 7
	No Assignment

	Line
	NUMPAD 6
	No Assignment

	Paragraph
	NUMPAD 5
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + P

	Paragraph Move To Next
	CAPS LOCK + RIGHT BRACKET
	No Assignment

	Paragraph Move To Previous
	CAPS LOCK + LEFT BRACKET
	No Assignment

	Repeat Last Speech
	CAPS LOCK + NUMPAD 9
	CAPS LOCK + BACK SLASH

	Selection
	NUMPAD 1
	SHIFT + CAPS LOCK + DOWN ARROW

	Sentence
	CAPS LOCK + NUMPAD 4
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + S

	Sentence Move To Next
	CAPS LOCK + FULL STOP
	No Assignment

	Sentence Move to Previous
	CAPS LOCK + COMMA
	No Assignment

	Status
	NUMPAD 2
	CAPS LOCK + PAGE DOWN

	Table Column
	CAPS LOCK + NUMPAD 6
	SHIFT + CAPS LOCK + RIGHT ARROW

	Table Column From Cell
	CAPS LOCK + NUMPAD PERIOD
	SHIFT + CAPS LOCK + PAGE DOWN

	Table Column To Cell
	CAPS LOCK + NUMPAD 3
	SHIFT + CAPS LOCK + PAGE UP

	Table Row
	CAPS LOCK + NUMPAD 0
	SHIFT + CAPS LOCK + UP ARROW

	Table Row From Cell
	CAPS LOCK + NUMPAD 2
	SHIFT + CAPS LOCK + END

	Table Row To Cell
	CAPS LOCK + NUMPAD 1
	SHIFT + CAPS LOCK + HOME

	To Cursor
	LEFT SHIFT + NUMPAD 1
	CAPS LOCK + HOME

	Where Am I?
	NUMPAD 7
	CAPS LOCK + PAGE UP

	Window
	NUMPAD 9
	CAPS LOCK + B

	Word
	NUMPAD 5
	CAPS LOCK + RIGHT ARROW


Unassigned Commands
The following is a list of unassigned commands within this keyboard hot key set category. These commands can be manually assigned a key combination.
	Label Below
	Label To Right
	Word Move To Next
	Word Move To Previous
	
[bookmark: O_14462][bookmark: _Toc228971410]19.4  Read From Here
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Click and Read From Here
	MIDDLE MOUSE BUTTON
	MIDDLE MOUSE BUTTON

	Enhance Read From Here
	LEFT CONTROL + CAPS LOCK + 1
	No Assignment

	Read From Here
	NUMPAD PLUS
	CAPS LOCK + DOWN ARROW

	Pause/Unpause Reading
	SPACEBAR
	SPACEBAR

	Stop Reading
	NUMPAD PLUS
or ESCAPE
or LEFT CONTROL
or RIGHT CONTROL
	ESCAPE
or LEFT CONTROL
or RIGHT CONTROL

	Stop Reading and switch focus
	LEFT SHIFT + SPACEBAR
	LEFT SHIFT + SPACEBAR

	Read From Here next line
	DOWN ARROW
	DOWN ARROW

	Read From Here previous line
	UP ARROW
	UP ARROW

	Read From Here next paragraph
	P
	P

	Read From Here previous paragraph
	LEFT SHIFT + P
	LEFT SHIFT + P

	Read From Here next sentence
	S
	S

	Read From Here previous sentence
	LEFT SHIFT + S
	LEFT SHIFT + S



	
[bookmark: O_3929][bookmark: _Toc228971411]19.5  Dolphin Cursor (General)
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Activate Down
	COMMA
	COMMA

	Activate Press
	SPACEBAR
	FULL STOP

	Activate Up
	FULL STOP
	No Assignment

	Add Permanent PlaceMarker at Dolphin Cursor
	LEFT CONTROL + CAPS LOCK + A
	LEFT CONTROL + CAPS LOCK + A

	Add Temporary PlaceMarker at Dolphin Cursor
	LEFT CONTROL + LEFT SHIFT + A
	LEFT CONTROL + LEFT SHIFT + A

	Automatic Dolphin Cursor on / off
	LEFT CONTROL + 4
	No Assignment

	Automatic Dolphin Cursor Restricted To Area on / off
	LEFT CONTROL + 2
	LEFT CONTROL + 2

	Find with Dolphin Cursor
	F3
	LEFT CONTROL + CAPS LOCK + F

	Find Next with Dolphin Cursor
	F4
	CAPS LOCK + F3

	Find Previous with Dolphin Cursor
	F2
	SHIFT + CAPS LOCK + F3

	Forms Mode Toggle
	CAPS LOCK + ENTER
	CAPS LOCK + ENTER

	Interact with Control
	ENTER
	ENTER

	Mode Lock
	LEFT CONTROL + 1
	LEFT CONTROL + 1

	Teach Graphic Object
	LEFT CONTROL + LEFT BRACKET
	CAPS LOCK + G

	Turn dolphin Cursor Off
	NUMPAD MINUS
	CAPS LOCK + Z

	Turn dolphin Cursor On
	NUMPAD MINUS
	CAPS LOCK + Z

	Window Lock
	LEFT CONTROL + 3
	LEFT CONTROL + 3



	
[bookmark: O_14464][bookmark: _Toc228971412]19.6  Dolphin Cursor (Movement)
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Bottom of window / area
	LEFT CONTROL + END
	CONTROL + END

	Choose Dolphin Cursor restricted to area
	NUMPAD SLASH
	LEFT CONTROL + CAPS LOCK + Z

	Dolphin Cursor Page Down
	CAPS LOCK + PAGE DOWN
	LEFT CONTROL + PAGE DOWN

	Dolphin Cursor Page Up
	CAPS LOCK + PAGE UP
	LEFT CONTROL + PAGE UP

	End of line
	END
	END

	Heading Next
	CAPS LOCK + DELETE
	H

	Heading Prev
	CAPS LOCK + INSERT
	SHIFT + H

	Left
	LEFT ARROW
	LEFT ARROW

	Left Edge
	LEFT SHIFT + CAPS LOCK + HOME
	No Assignment

	Left Word
	LEFT CONTROL + LEFT ARROW
	LEFT CONTROL + LEFT ARROW

	Move Dolphin Cursor to first toolbar
	LEFT SHIFT + NUMPAD MINUS
	CAPS LOCK + F8

	Move Dolphin Cursor to next application
	LEFT CONTROL + SINGLE OPEN QUOTE
	LEFT CONTROL + SINGLE OPEN QUOTE

	Move Dolphin Cursor to next window
	LEFT CONTROL + TAB
	LEFT CONTROL + TAB

	Move Dolphin Cursor to previous application
	LEFT CONTROL + LEFT SHIFT + SINGLE OPEN QUOTE
	LEFT CONTROL + LEFT SHIFT + SINGLE OPEN QUOTE

	Move Dolphin Cursor to previous window
	LEFT CONTROL + LEFT SHIFT + TAB
	LEFT CONTROL + LEFT SHIFT + TAB

	Move Dolphin Cursor to Quick Launch bar
	LEFT SHIFT + NUMPAD STAR
	No Assignment

	Move Dolphin Cursor to System Tray
	LEFT SHIFT + NUMPAD SLASH
	No Assignment

	Move Physical Down
	LEFT SHIFT + CAPS LOCK + DOWN ARROW
	SHIFT + ALT + DOWN ARROW

	Move Physical Left
	LEFT SHIFT + CAPS LOCK + LEFT ARROW
	SIFT + ALT + LEFT ARROW

	Move Physical Right
	LEFT SHIFT + CAPS LOCK + RIGHT ARROW
	SHIFT + ALT + RIGHT ARROW

	Move Physical Up
	LEFT SHIFT + CAPS LOCK + UP ARROW
	SHIFT + ALT + UP ARROW

	Move To Application Cursor
	NUMPAD STAR
	CAPS LOCK + MINUS

	Next Dialog
	F7
	F7

	Next Large Object
	PAGE DOWN
	PAGE DOWN

	Next Line
	DOWN ARROW
	DOWN ARROW

	Next Main Window
	RIGHT CTRL+TAB
	RIGHT CTRL+TAB

	Next Object
	TAB
	TAB

	Physical Bottom
	LEFT SHIFT + CAPS LOCK + PAGE DOWN
	No Assignment

	Physical on off
	LEFT CONTROL + LEFT SHIFT + 9
	No Assignment

	Physical Top
	LEFT SHIFT + CAPS LOCK + PAGE UP
	No Assignment

	Previous Dialog
	LEFT SHIFT + F7
	LEFT SHIFT + F7

	Previous Large Object
	PAGE UP
	PAGE UP

	Previous Line
	UP ARROW
	UP ARROW

	Previous Main Window
	RIGHT CTRL + LEFT SHIFT + TAB
	RIGHT CTRL + LEFT SHIFT + TAB

	Previous Object
	LEFT SHIFT + TAB
	SHIFT + TAB

	Restrict Dolphin Cursor to selection
	LEFT CONTROL + LEFT SHIFT + NUMPAD MINUS
	LEFT CONTROL + LEFT SHIFT + CAPS LOCK + Z

	Right
	RIGHT ARROW
	RIGHT ARROW

	Right Edge
	LEFT SHIFT + CAPS LOCK + END
	No Assignment

	Right Word
	LEFT CONTROL + RIGHT ARROW
	LEFT CONTROL + RIGHT ARROW

	Route Dolphin Cursor to Mouse
	MIDDLE MOUSE BUTTON
	MIDDLE MOUSE BUTTON

	Skip Ahead
	LEFT CONTROL + DOWN ARROW
	LEFT CONTROL + DOWN ARROW

	Skip Back
	LEFT CONTROL + UP ARROW
	LEFT CONTROL + UP ARROW

	Start of line
	HOME
	HOME

	Table Down
	CAPS LOCK + DOWN ARROW
	LEFT CONTROL + ALT + DOWN ARROW

	Table Left
	CAPS LOCK + LEFT ARROW
	LEFT CONTROL + ALT + LEFT ARROW

	Table Next
	CAPS LOCK + END
	T

	Table Prev
	CAPS LOCK + HOME
	SHIFT + T

	Table Right
	CAPS LOCK + RIGHT ARROW
	LEFT CONTROL + ALT + RIGHT ARROW

	Table Up
	CAPS LOCK + UP ARROW
	LEFT CONTROL + ALT + UP ARROW

	Top of Window / Area
	LEFT CONTROL + HOME
	CONTROL + HOME



	
[bookmark: O_14463][bookmark: _Toc228971413]19.7  Dolphin Cursor (Mouse Control)
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Drag with Left Mouse Button
	RIGHT CONTROL + HOME
	CONTROL + CAPS LOCK + 8

	Drag with Right Mouse Button
	RIGHT CONTROL + RIGHT SHIFT + HOME
	CONTROL + CAPS LOCK + 9

	Drop
	RIGHT CONTROL + END
	LEFT CONTROL + CAPS LOCK + 7

	Left Click at Dolphin Cursor
	INSERT
	CAPS LOCK + 8

	Left Click at Dolphin Cursor and switch Dolphin Cursor off
	A
	A

	Left Double Click at Dolphin Cursor
	Q
	Q

	Middle Click at Dolphin Cursor
	S
	S

	Mouse Wheel Down at Dolphin Cursor
	X
	X

	Mouse Wheel Up at Dolphin Cursor
	W
	W

	Move Mouse to Focus
	RIGHT CONTROL + DELETE
	CAPS LOCK + EQUALS

	Right Click at Dolphin Cursor
	DELETE
	CAPS LOCK + 9

	Right Click at Dolphin Cursor and switch Dolphin Cursor off
	D
	D

	Right Double Click at Dolphin Cursor
	E
	No Assignment




[bookmark: O_16402]Note: In some applications, for example, Internet Explorer and Adobe Reader, the above stated hot keys may conflict with a SuperNova Quick Navigation Key. Where a conflict exists the Quick Navigation key has priority. To use the above stated commands in an application with a conflicting Quick Navigation Key requires you to re-assign the associated Dolphin Cursor (Mouse Control) hot key.
	
[bookmark: O_14424][bookmark: _Toc228971414]19.8  Dolphin Cursor Selection
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Bottom of window / area
	LEFT CONTROL + LEFT SHIFT + END
	LEFT CONTROL + LEFT SHIFT + END

	Copy
	CONTROL + C
	CONTROL + C

	End of line
	SHIFT + END
	SHIFT + END

	Left
	SHIFT + LEFT ARROW
	SHIFT + LEFT ARROW

	Left word
	CONTROL + SHIFT + LEFT ARROW
	CONTROL + SHIFT + LEFT ARROW

	Next large object
	SHIFT + PAGE DOWN
	SHIFT + PAGE DOWN

	Next line
	SHIFT + DOWN ARROW
	SHIFT + DOWN ARROW

	Previous large object
	SHIFT + PAGE UP
	SHIFT + PAGE UP

	Previous line
	SHIFT + UP ARROW
	SHIFT + UP ARROW

	Right
	SHIFT + RIGHT ARROW
	SHIFT + RIGHT ARROW

	Right word
	CONTROL + SHIFT + RIGHT ARROW
	CONTROL + SHIFT + RIGHT ARROW

	Select all
	CONTROL + A
	CONTROL + A

	Skip ahead
	LEFT CONTROL + LEFT SHIFT + DOWN ARROW
	LEFT CONTROL + LEFT SHIFT + DOWN ARROW

	Skip back
	LEFT CONTROL + LEFT SHIFT + UP ARROW
	LEFT CONTROL + LEFT SHIFT + UP ARROW

	Start of line
	SHIFT + HOME
	SHIFT + HOME

	Top of window / area
	LEFT CONTROL + LEFT SHIFT + HOME
	LEFT CONTROL + LEFT SHIFT + HOME



	
[bookmark: O_1426][bookmark: _Toc228971415]19.9  Magnifier
	Function
	Desktop - Default NumPad Set
	Laptop - Universal

	Colour Scheme on off
	LEFT CONTROL + NUMPAD 0
	SHIFT + ALT + C

	Create Hooked Area
	LEFT CONTROL + NUMPAD 5
	LEFT SHIFT + LEFT CONTROL + ALT + H

	Foci Highlights on off
	LEFT CONTROL + LEFT SHIFT + BACK SLASH
	LEFT SHIFT + LEFT ALT + O

	Hooked areas on off
	LEFT CONTROL + NUMPAD 3
	LEFT CONTROL + ALT + H

	Jump Down
	LEFT CONTROL + CAPS LOCK + NUMPAD 2
	LEFT ALT + PAGE DOWN

	Jump Left
	LEFT CONTROL + CAPS LOCK + NUMPAD 4
	LEFT ALT + HOME

	Jump Right
	LEFT CONTROL + CAPS LOCK + NUMPAD 6
	LEFT ALT + END

	Jump Up
	LEFT CONTROL + CAPS LOCK + NUMPAD 8
	LEFT ALT + PAGE UP

	Magnification Decrease
	LEFT CONTROL + NUMPAD MINUS
or CAPS LOCK + MOUSE WHEEL DOWN
	LEFT ALT + MINUS
or CAPS LOCK + MOUSE WHEEL DOWN

	Magnification Increase
	LEFT CONTROL + NUMPAD PLUS
or CAPS LOCK + MOUSE WHEEL UP
	LEFT ALT + EQUALS
or CAPS LOCK + MOUSE WHEEL UP

	Magnification X Decrease
	RIGHT CONTROL + NUMPAD SLASH
	No Assignment

	Magnification X Increase
	LEFT CONTROL + NUMPAD SLASH
	No Assignment

	Magnification Y Decrease
	RIGHT CONTROL + NUMPAD STAR
	No Assignment

	Magnification Y Increase
	LEFT CONTROL + NUMPAD STAR
	No Assignment

	Magnifier on off
	LEFT CONTROL + NUMPAD ENTER
	ALT + 0

	Modify Hooked Areas
	LEFT CONTROL + NUMPAD 6
	LEFT SHIFT + ALT + H

	Modify Primary Area
	LEFT CONTROL + NUMPAD 4
	LEFT SHIFT + ALT + A

	Move Down
	RIGHT CONTROL + RIGHT SHIFT + DOWN ARROW
	RIGHT CONTROL + RIGHT SHIFT + DOWN ARROW

	Move Left
	RIGHT CONTROL + RIGHT SHIFT + LEFT ARROW
	RIGHT CONTROL + RIGHT SHIFT + LEFT ARROW

	Move Right
	RIGHT CONTROL + RIGHT SHIFT + RIGHT ARROW
	RIGHT CONTROL + RIGHT SHIFT + RIGHT ARROW

	Move to bottom left of screen
	RIGHT CONTROL + NUMPAD 1
	No Assignment

	Move to bottom of screen
	RIGHT CONTROL + NUMPAD 2
	No Assignment

	Move to bottom right of screen
	RIGHT CONTROL + NUMPAD 3
	No Assignment

	Move to left edge of screen
	RIGHT CONTROL + NUMPAD 4
	No Assignment

	Move to middle of screen
	RIGHT CONTROL + NUMPAD 5
	No Assignment

	Move to right edge of screen
	RIGHT CONTROL + NUMPAD 6
	No Assignment

	Move to top left of screen
	RIGHT CONTROL + NUMPAD 7
	No Assignment

	Move to top of screen
	RIGHT CONTROL + NUMPAD 8
	No Assignment

	Move to top right of screen
	RIGHT CONTROL + NUMPAD 9
	No Assignment

	Move Up
	RIGHT CONTROL + RIGHT SHIFT +  UP ARROW
	RIGHT CONTROL + RIGHT SHIFT + UP ARROW

	Orientation Cycle
	LEFT CONTROL + NUMPAD 1
	No Assignment

	Overview mode on off
	LEFT CONTROL + BACK SLASH
	LEFT CONTROL + BACK SLASH

	Pan Down
	RIGHT CONTROL + DOWN ARROW
	RIGHT CONTROL + DOWN ARROW

	Pan Left
	RIGHT CONTROL + LEFT ARROW
	RIGHT CONTROL + LEFT ARROW

	Pan Right
	RIGHT CONTROL + RIGHT ARROW
	RIGHT CONTROL + RIGHT ARROW

	Pan Up
	RIGHT CONTROL + UP ARROW
	RIGHT CONTROL + UP ARROW

	Primary Magnifier Type Cycle
	LEFT CONTROL + NUMPAD 7
	LEFT SHIFT + ALT + M

	Restore Position
	RIGHT CONTROL + NUMPAD PERIOD
	No Assignment

	Save Position
	RIGHT CONTROL + NUMPAD 0
	No Assignment

	Switch monitors
	CAPS LOCK + MIDDLE MOUSE BUTTON
	CAPS LOCK + MIDDLE MOUSE BUTTON

	Cycle text smoothing (True Font/Standard/Off)
	LEFT CONTROL + NUMPAD 8
	No Assignment

	Bold Fonts on off
	RIGHT CONTROL + NUMPAD 8
	No Assignment

	Sharpening on off
	RIGHT CONTROL + RIGHT SHIFT + NUMPAD 8
	No Assignment



	
[bookmark: O_1427][bookmark: _Toc228971416]19.10  Magnifier Window Adjustment
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Alter hook with mouse
	LEFT MOUSE BUTTON
	LEFT MOUSE BUTTON

	Area Down
	DOWN ARROW
	DOWN ARROW

	Area Left
	LEFT ARROW
	LEFT ARROW

	Area Right
	RIGHT ARROW
	RIGHT ARROW

	Area Up
	UP ARROW
	UP ARROW

	Cancel Get Hook Area
	ESCAPE
	ESCAPE

	Contents Down
	LEFT SHIFT + DOWN ARROW
	LEFT SHIFT + DOWN ARROW

	Contents Left
	LEFT SHIFT + LEFT ARROW
	LEFT SHIFT + LEFT ARROW

	Contents Right
	LEFT SHIFT + RIGHT ARROW
	LEFT SHIFT + RIGHT ARROW

	Contents Up
	LEFT SHIFT + UP ARROW
	LEFT SHIFT + UP ARROW

	Cycle Orientation
	LEFT CONTROL + NUMPAD 1
	No Assignment

	Decrease Magnification
	LEFT CONTROL + NUMPAD MINUS
or CAPS LOCK + MOUSE WHEEL DOWN
	ALT + MINUS
or CAPS LOCK + MOUSE WHEEL DOWN

	Decrement X Magnification
	RIGHT CONTROL + NUMPAD SLASH
	No Assignment

	Decrement Y Magnification
	RIGHT CONTROL + NUMPAD STAR
	No Assignment

	Delete Hooked Area
	DELETE
	DELETE

	Exit Modification Mode
	ESCAPE
	ESCAPE

	Increase Magnification
	LEFT CONTROL + NUMPAD PLUS
or CAPS LOCK + MOUSE WHEEL DOWN
	ALT + EQUALS
or CAPS LOCK + MOUSE WHEEL UP

	Increment X Magnification
	LEFT CONTROL + NUMPAD SLASH
	No Assignment

	Increment Y Magnification
	LEFT CONTROL + NUMPAD STAR
	No Assignment

	Make narrower
	LEFT CONTROL + LEFT ARROW
	LEFT CONTROL + LEFT ARROW

	Make shorter
	LEFT CONTROL + UP ARROW
	LEFT CONTROL + UP ARROW

	Make taller
	LEFT CONTROL + DOWN ARROW
	LEFT CONTROL + DOWN ARROW

	Make wider
	LEFT CONTROL + RIGHT ARROW
	LEFT CONTROL + RIGHT ARROW

	Move area with mouse
	Z
	Z

	Move contents of area with mouse
	C
	C

	OK Get Hook Area
	ENTER
or RIGHT MOUSE BUTTON
	ENTER
or RIGHT MOUSE BUTTON

	Resize area with mouse
	X
	X

	Text Smoothing
	LEFT CONTROL + NUMPAD 8
	No Assignment

	Tracking on off
	LEFT SHIFT + NUMPAD 8
	F8



	
[bookmark: O_3932][bookmark: _Toc228971417]19.11  Line View
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Decrease magnification
	LEFT CONTROL + NUMPAD MINUS
or CAPS LOCK + MOUSE WHEEL DOWN
	ALT + MINUS
or CAPS LOCK + MOUSE WHEEL DOWN

	Decrement X magnification
	RIGHT CONTROL + NUMPAD SLASH
	No Assignment

	Decrement Y magnification
	RIGHT CONTROL + NUMPAD STAR
	No Assignment

	Exit Line View
	ESCAPE
	ESCAPE

	Exit Line View and click at character or route Dolphin Cursor to character
	NUMPAD ENTER
	ENTER
or LEFT MOUSE BUTTON

	Flip forward
	ENTER
	ENTER

	Go to the first line
	HOME
	HOME

	Go to the focus
	NUMPAD 0
	F5

	Go to the last line
	END
	END

	Increase magnification
	LEFT CONTROL + NUMPAD PLUS
or CAPS LOCK + MOUSE WHEEL UP
	ALT + EQUALS
or CAPS LOCK + MOUSE WHEEL UP

	Increment X magnification
	LEFT CONTROL + NUMPAD SLASH
	No Assignment

	Increment Y magnification
	LEFT CONTROL + NUMPAD STAR
	No Assignment

	Line View document
	LEFT CONTROL + NUMPAD PERIOD
	No Assignment

	Line View document area and go to focus
	LEFT CONTROL + LEFT SHIFT + NUMPAD 2
	No Assignment

	Line View document from cursor
	LEFT CONTROL + NUMPAD 2
	LEFT SHIFT + ALT + L

	Line View whole window
	LEFT CONTROL + NUMPAD 9
	LEFT SHIFT + ALT + V

	Move backwards
	LEFT ARROW
	LEFT ARROW

	Move forward
	RIGHT ARROW
	RIGHT ARROW

	Next line
	PAGE DOWN
	PAGE DOWN

	Previous line
	PAGE UP
	PAGE UP

	Scroll faster
	UP ARROW
	UP ARROW

	Scroll slower
	DOWN ARROW
	DOWN ARROW

	Start or stop
	SPACEBAR
	SPACEBAR

	Text smoothing
	LEFT CONTROL + NUMPAD 8
	No Assignment



	
[bookmark: O_3935][bookmark: _Toc228971418]19.12  Item Finder
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Item Finder (multi tab dialog box)
	CAPS LOCK + TAB
	CAPS LOCK + TAB

	Links
	CAPS LOCK + 1
	CAPS LOCK + F7

	Headings
	CAPS LOCK + 2
	CAPS LOCK + F6

	Frames or Objects
	CAPS LOCK + 3
	CAPS LOCK + F9

	Tables
	CAPS LOCK + 5
	No Assignment

	Controls
	CAPS LOCK + 6
	CAPS LOCK + F5

	Revisions or Comments
	CAPS LOCK + 7
	LEFT SHIFT + CAPS LOCK + R

	Errors
	CAPS LOCK + 8
	No Assignment




[bookmark: O_14460]Global Item Finder
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	System Tray items
	CAPS LOCK + 0
	CAPS LOCK + F11


For information on Custom Lists please refer to the SuperNova Help for the target application. Help information can be obtained from SuperNova by pressING CAPS LOCK + F1.
	
[bookmark: O_1432][bookmark: _Toc228971419]19.13  Text Input
This category lists keys that become available in Forms Mode that are otherwise assigned when using the Dolphin Cursor.
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Cancel
	ESCAPE
	ESCAPE

	Delete previous character
	BACKSPACE
	BACKSPACE

	Delete this character
	DELETE
	DELETE

	Enter
	ENTER
	ENTER

	Left one character
	LEFT ARROW
	LEFT ARROW

	Move to end of line
	END
	END

	Move to start of line
	HOME
	HOME

	Phonetic character
	LEFT CONTROL + LEFT SHIFT + NUMPAD 4
	No Assignment

	Phonetic line
	LEFT CONTROL + LEFT SHIFT + NUMPAD 6
	No Assignment

	Read character
	NUMPAD 4
	CAPS LOCK + LEFT ARROW

	Read character attributes (set 1)
	LEFT SHIFT + NUMPAD 4
	No Assignment

	Read character attributes (Set 2)
	LEFT CONTROL + NUMPAD 4
	No Assignment

	Read line
	NUMPAD 6
	CAPS LOCK + UP ARROW

	Right one character
	RIGHT ARROW
	RIGHT ARROW

	Spell line
	LEFT SHIFT + NUMPAD 6
	No Assignment

	Verbose line
	LEFT CONTROL + NUMPAD 6
	No Assignment



	
[bookmark: O_3934][bookmark: _Toc228971420]19.14  Braille
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Back
	LEFT CONTROL + LEFT SHIFT + COMMA
	LEFT CONTROL + LEFT SHIFT + COMMA

	Cycle Attributes
	LEFT CONTROL + LEFT SHIFT + 6
	LEFT CONTROL + LEFT SHIFT + 6

	Describe Character on / off
	LEFT CONTROL + LEFT SHIFT + 7
	LEFT CONTROL + LEFT SHIFT + 7

	Forward
	LEFT CONTROL + LEFT SHIFT + FULL STOP
	LEFT CONTROL + LEFT SHIFT + FULL STOP

	Go To Focus
	LEFT CONTROL + LEFT SHIFT + FORWARD SLASH
	LEFT CONTROL + LEFT SHIFT + FORWARD SLASH

	Hooks on / off
	LEFT CONTROL + LEFT SHIFT + 2
	LEFT CONTROL + LEFT SHIFT + 2

	Literary Braille on / off
	LEFT CONTROL + LEFT SHIFT + 8
	LEFT CONTROL + LEFT SHIFT + 8

	Monitor on / off
	LEFT CONTROL + LEFT SHIFT + 1
	LEFT CONTROL + LEFT SHIFT + 1

	Braille Output on / off
	LEFT CONTROL + LEFT SHIFT + 0
	LEFT CONTROL + CAPS LOCK + 0

	Physical / Logical Mode
	LEFT CONTROL + LEFT SHIFT + 9
	LEFT CONTROL + LEFT SHIFT + 9

	Verbosity Scheme Cycle
	LEFT SHIFT + CAPS LOCK + EQUALS
	LEFT CONTROL + CAPS LOCK + V


Unassigned Commands
The following is a list of unassigned commands within this category. These commands can be manually assigned a key combination or may already have an assigned Braille display button combination. Please refer to your Braille display hot key list for more information.
	Bottom
	Half Width Left

	Braille Document Read Back
	Half Width Right

	Braille Document Read Back (Dolphin Cursor)
	Input on / off

	Braille Document Read Forward
	Layout on / off

	Braille Document Read Forward (Dolphin Cursor)
	Line Down

	Cell Left
	Line Down (Dolphin Cursor)

	Cell Right
	Line End

	Cursor on / off
	Line Start

	Cursor style
	Line Up

	Display Characters
	Line Up (Dolphin Cursor)

	Display Font Colours
	Routing Button Action

	Display Font Foreground Colour
	Routing Button Action in Dolphin Cursor

	Display Font Name
	Second Routing Button Action

	Display Font Size
	Second Routing Button Action in Dolphin Cursor

	Display Font Style
	Top

	Eight Dot Six Dot
	Tracking on / off

	Enhance on / off
	Tremble Capitals on / off

	Expand Gaps on / off
	Width Left

	Flush Input
	Width Right



	
[bookmark: O_16591][bookmark: _Toc228971421]19.15  Quick Navigation Keys for web browsers
SuperNova coding includes the following list of hot keys for web page navigating. The keyboard commands are available using the Dolphin Cursor in supported web browsers. The keyboard commands cannot be removed or reassigned.
	
[bookmark: O_16491][bookmark: _Toc228971422]19.15.1  Quick Navigation Keys
To move to the previous element use Shift + Key
	Move to
	Hot key

	PlaceMarker
	A

	Button
	B

	List box
	C

	Different element
	D

	Edit area
	E

	Form
	F

	Graphic
	G

	Heading
	H

	List item
	I

	Link
	K

	List
	L

	Frame
	M

	Text block
	N

	Paragraph
	P

	Block Quote
	Q

	Radio
	R

	Table
	T

	Unvisited link
	U

	Visited link
	V

	Check box
	X

	Heading level 1 - 6
	1 - 6

	Landmark
	; (SEMI COLON)


You can interact more seamlessly with websites that use single letter accesskeys such as Facebook and YouTube by toggling off SuperNova's Quick Navigation Keys. Press LEFT CONTROL + CAPS LOCK + 8 to avoid conflicting hotkeys to use a website's single letter accesskeys. For example, K navigates you to the next link on a webpage, but is also used by YouTube to pause the playing of a video. Rather than using SuperNova's pass next key to application hot key every time you want to pause a video on YouTube, just toggle off SuperNova's Quick Navigation Keys while you use YouTube and then turn them on again when you want to use another website.
Pressing  LEFT CONTROL + CAPS LOCK + 8 will disable any alphanumeric or punctuation hotkeys while using the Dolphin Cursor, although you can toggle this setting while in any mode. This means that it doesn’t specifically disable quick navigation keys, but instead allows through all standard key presses that might control a web application regardless of how your hot keys are configured. So, if you re-define a quick navigation key to something that's not an alphanumeric key, it will not get disabled. Keys included are any alphanumeric or punctuation key with or without SHIFT. Any hot key with CAPS LOCK, ALT or CONTROL is not included.


	
[bookmark: O_16592][bookmark: _Toc228971423]19.16  Quick Navigation Keys for Microsoft Word
SuperNova coding includes the following list of hot keys for supported versions of Microsoft Word. You cannot remove or reassign these keyboard commands.
	
[bookmark: O_16407][bookmark: _Toc228971424]19.16.1  Quick Navigation Keys
To move to the previous element use Shift + Caps Lock + Key
	Move to
	Hot key

	Bookmark
	CAPS LOCK + A

	Button
	CAPS LOCK + B

	Comment
	CAPS LOCK + C

	Different paragraph style
	CAPS LOCK + D

	Edit form field
	CAPS LOCK + E

	Footnote or Endnote
	CAPS LOCK + F

	Graphic
	CAPS LOCK + G

	Heading style
	CAPS LOCK + H

	List item
	CAPS LOCK + I

	Link
	CAPS LOCK + K

	List
	CAPS LOCK + L

	Text box
	CAPS LOCK + Y

	Normal style paragraph
	CAPS LOCK + N

	Object (including graphics)
	CAPS LOCK + O

	Paragraph
	CAPS LOCK + P

	Revision
	CAPS LOCK + R

	Table
	CAPS LOCK + T

	Check box
	CAPS LOCK + X

	Section break
	CAPS LOCK + Z


Note that you may find various Quick Navigation Keys failing when working in a protected document.
	
[bookmark: O_16912][bookmark: _Toc228971425]19.17  Layered hot keys
Layered hotkey mode provides an alternative way to access popular settings. Press CAPS LOCK + SPACEBAR to switch into Layered hotkey mode.
In this mode you can:
	Press TAB and SHIFT + TAB to explore the available options at the current level. On selecting an option, you can press ENTER to explore the sub-options or to select an item.
	You can use shortcut keys to directly navigate to a specific option.
Generally speaking you will always automatically exit Layered hotkey mode after executing an option.
As mentioned previously, pressing CAPS LOCK + SPACEBAR puts you into a special Layered hotkey mode where the operation of the keyboard is taken over by SuperNova. Specific keypresses perform actions or change settings or move you into different layers. The layers are contained in a top layer. This is the starting point. You cannot navigate to a previous layer from here. 
General keys in layered mode:
	CAPS LOCK + SPACEBAR enters Layered mode.
	ESCAPE exits Layered mode.
	BACKSPACE moves to the previous layer.
	TAB moves to next entry in the current layer.
	SHIFT + TAB moves to previous entry in the current layer.
	ENTER selects the current entry in the current layer.
	F1 speaks the entries in the current layer.
Notes:

Some layers are area specific. For example, you can only access the Table layer when your focus is inside a table.
Some layers like the Table layer will also keep you in Layered mode after performing an action. You can leave Layered mode by pressing ESCAPE.

Apart from SuperNova Magnifier, which doesn't include profiles, changing your profile will change the available layers. i.e. You won't get speech layers in Magnifier profile or magnification layers in ScreenReader profile.
	
[bookmark: O_16913]The top layer contains the following layers:
	Audio, A
	Braille, B
	Dolphin Cursor, D
	Item Finder, I
	Magnification, M
	Scan, O
	Ask AI, Q
	Reader, R
	Speech, S
	Table, T
	System, Y
as well as the following hot keys:
	Restore Default Profile, F2
	Notification Finder, F3.
	Quit, F4
	Battery Status, F10
	Privacy Screen, F11
	Date And Time, F12
	
[bookmark: O_16960][bookmark: _Toc228971426]19.17.1  Audio layer
To select the Audio layer press A then:
	Left Audio Split, LEFT ARROW
	No Audio Split, UP ARROW
	Right Audio Split, RIGHT ARROW
	Audio Ducking, DOWN ARROW
	
[bookmark: O_16961][bookmark: _Toc228971427]19.17.2  Braille layer
To select the Braille layer press B then:
	Output On / Off, O
	Literary On / Off, L
	Enhanced Mode On / Off, E
	Tracking On / Off, T
	6 Dots On / Off, 6
	Tremble Capitals On / Off, A
	Input Keys On / Off, I
	Literary Input On / Off, Y
	Hooks On / Off, H
	On Screen Monitor On / Off, M
	Cursor On / Off, C
	Set Cursor Style, U
	Set Verbosity, V
	Describe Character layer, D
	Physical layer, P
	Routing Buttons layer, R
To select the Describe Character layer press D from within the Braille layer then:
	Describe Character On / Off, D
	Font Name Using Identifiers, N
	Font Size Using Identifiers, Z
	Font Style Using Identifiers, Y
	Font Background Colour Using Identifiers, B
	Font Colour Using Identifiers, C
	Cycle Character Attributes Using Identifiers, A
	Back To Text, T
To select the Physical layer press P from within the Braille layer then:
	Physical On / Off, O
	Layout On / Off, L
	Expand Gaps On / Off, G
To select the Routing Buttons layer press R from within the Braille layer then:
	Set Row 1 Action, 1
	Set Row 2 Action, 2
	Set Row 1 Action With Dolphin Cursor, D
	Set Row 2 Action With Dolphin Cursor, C
	
[bookmark: O_16962][bookmark: _Toc228971428]19.17.3  Dolphin Cursor layer
To select the Dolphin Cursor layer press D then:
	Automatic Dolphin Cursor On / Off, A
	Automatic Forms Mode On / Off, F
	Restrict Dolphin Cursor To Current Area On / Off, R
	
[bookmark: O_16963][bookmark: _Toc228971429]19.17.4  Item Finder layer
To select the Item Finder layer press I then:
	System Tray List, S
	Web Browser layer, B
	Excel layer, E
	Outlook layer, O
	PowerPoint layer, P
	Word layer, W
To select the Web Browser layer press B from within the Item Finder layer then:
	Summary List, S
	Links, K
	Headings, H
	Frames, M
	Tables, T
	Controls, C
	Landmarks, ; (SEMICOLON)
	Place Markers, A
To select the Excel layer press E from within the Item Finder layer then:
	Summary List, S
	Links, K
	Objects, O
	Sheets, T
	Comment Cells In View, M
	Charts, C
	Chart Elements, E
	Formula Cells In View, F
	Data Cells In View, D
To select the Outlook layer press O from within the Item Finder layer then:
	Summary List, S
	Links, K
	Headings, H
	Objects, O
	Tables, T
	Comments, C
	Spelling Errors, E
	Grammar Errors, G
To select the PowerPoint layer press P from within the Item Finder layer then:
	Summary List, S
	Slides, L
To select the Word layer press W from within the Item Finder layer then:
	Summary List, S
	Links, K
	Headings, H
	Objects, O
	Tables, T
	Comments, C
	Spelling Errors, E
	Grammar Errors, G
	
[bookmark: O_16964][bookmark: _Toc228971430]19.17.5  Magnification layer
To select the Magnification layer press M then:
	On / Off, O
	Increase, UP ARROW
	Decrease, DOWN ARROW
	Colour scheme On / Off, C
	View layer, V
	Hooked Areas layer, H
To select the View layer press V from within the Magnification layer then:
	Full screen, F
	Window, W
	Magnifying glass, G
	Resizing glass, Z
	Left split, LEFT ARROW
	Top split, UP ARROW
	Right split, RIGHT ARROW
	Bottom split, DOWN ARROW
	Modify size and position, M
To select the Hooked Areas layer press H from within the Magnification layer then:
	Hooked Areas On / Off, O
	Create Hooked Area, C
	Modify Hooked Area, M
	
[bookmark: O_16965][bookmark: _Toc228971431]19.17.6  Scan layer
To select the Scan layer press O then:
	Read From File, F
	Read From Scanner, S
	Read Clipboard Image, C
	Read Clipboard Image In Doc Reader, D
	
[bookmark: O_16994][bookmark: _Toc228971432]19.17.7  Ask AI layer
To select the Ask AI layer press Q then:
	Describe image file, F.
	Describe image from scanner, S.
	Describe image from clipboard, C.
	Describe image of whole screen, W.
	Describe image of application window, A.
	Describe image at Dolphin Cursor, D.
	Describe image of Doc Reader page, R.
	Query help, Q.
[bookmark: H_17004]Depending on your selection, an Image Chat Window (see "The Image Chat Window" page 125) will then open enabling you to ask AI questions about the selected image, or a Help Chat window will open enabling you to ask questions about SuperNova features and settings.

	
[bookmark: O_16966][bookmark: _Toc228971433]19.17.8  Reader layer
To select the Reader layer press R then:
	Doc Reader, D
	Line View Window, W
	Line View Window From Focus, F
	Line View Document Window, O
	Line View Document Window From Cursor, C
	Read From Here, R
	Enhance Read From Here On / Off, E
	
[bookmark: O_16967][bookmark: _Toc228971434]19.17.9  Speech layer
To select the Speech layer press S then:
	Voice On / Off, O
	Volume Up, UP ARROW
	Volume Down, DOWN ARROW
	Speak Slower, LEFT ARROW
	Speak Faster, RIGHT ARROW
	Set Verbosity, V
	Set Typing Mode, Y
	Previous Language, P
	Next Language, N
	Select Synthesiser, S
	Speak Text Under Mouse On / Off, M
	Speak Phonetic Description When Navigating by Character On / Off, H
	Voice And Language Configuration, L
	Transcript, T
To select the Capitals layer press C from within the Speech layer then:
	Capitals On / Off, O
	Reading Lines On / Off, L
	Change Pitch For Spelt Capitals On / Off, P
	Use Beeps, B
	Use Words, W
	
[bookmark: O_16968][bookmark: _Toc228971435]19.17.10  Table layer
To select the Table layer press T then:
	Left, LEFT ARROW
	Right, RIGHT ARROW
	Up, UP ARROW
	Down, DOWN ARROW
	First Cell, CONTROL + HOME
	Last Cell, CONTROL + END
	Top Of Column, CONTROL + UP ARROW
	Bottom Of Column, CONTROL + DOWN ARROW
	Start Of Row, CONTROL + LEFT ARROW
	End Of Row, CONTROL + RIGHT ARROW
	Speak Cell, X
	Speak Row, R
	Speak Row To Cell, HOME
	Speak Row From Cell, END
	Speak Column, C
	Speak Column To Cell, PAGE UP
	Speak Column From Cell, PAGE DOWN
	Next Table, T
	Previous Table, SHIFT + T
	
[bookmark: O_16969][bookmark: _Toc228971436]19.17.11  System layer
To select the System layer press Y then:
	Speak Battery Status, B
	Speak Date, D
	Speak keyboard language, K
	Speak System Tray, S
	Speak Time, T
	Notification Finder, N.
	Restore Default Profile, P
	Quit, Q
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Chapter 20
[bookmark: O_14679][bookmark: _Toc228971437]20Hot key conflicts
Sometimes you can find SuperNova hot keys conflict with an application's hot keys. You can resolve this issue in a number of different ways.
	
[bookmark: O_14681][bookmark: _Toc228971438]20.1  Tell SuperNova to ignore the next key press
You can resolve a hot key conflict between SuperNova and your application by telling SuperNova to ignore the next key press. Once you have released the keys, SuperNova automatically turns on its hot keys again.
Action Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Pass the next key press through to your application
	LEFT CONTROL + 7
	CAPS LOCK + 3



	
[bookmark: O_14680][bookmark: _Toc228971439]20.2  Turn off SuperNova hot keys
You can resolve a hot key conflict between SuperNova and your application by turning off SuperNova's hot keys. This disables all hot keys except for the hot key to turn on SuperNova's hot keys again.
Action Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Turn off or on hot keys
	LEFT CONTROL + 8
	SHIFT + CAPS LOCK + 3



	
[bookmark: O_14682][bookmark: _Toc228971440]20.3  Reassign a SuperNova hot key
You can add, delete or reassign any SuperNova hot key. You can do this to resolve hot key conflicts between SuperNova and your application or to change a hot key command to a key combination you find easier to use.
To do this:
1.	Press LEFT CONTROL + SPACEBAR.
The SuperNova control panel opens.
2.	Press ALT + G.
The "General" menu opens.
3.	DOWN ARROW to "Keyboard and Hot Keys" and press ENTER.
A submenu opens.
4.	DOWN ARROW to "Hot Keys" and press ENTER.
The "Hot Keys" dialog box opens.
5.	TAB through, using the "Hot Key Command Set" list and "Command" list to select the assigned hot key you want to change.
6.	Use the "Add key" button, "Replace key" button or "Remove key" button to change the hot key.
7.	TAB to the "OK" button and press SPACEBAR.
SuperNova confirms the changes and closes the dialog box.
Tip: If you find it difficult to locate your hot key from the categories and commands available then use the SuperNova Key Describer to help.
	
[bookmark: O_16680][bookmark: _Toc228971441]21ZoomText to SuperNova product terminology guide
The following table provides a helpful terminology conversion guide for ZoomText users transitioning to SuperNova.

	ZoomText term
	SuperNova equivalent

	AppReader
	[bookmark: H_16693]Read From Here (see "Read continuously" page 40)

	Camera
	[bookmark: H_16698]Connect and View (page 95)

	Colour Enhancements
	[bookmark: H_16692]Colour Schemes (see "Make the screen easier to see" page 25)

	Command Keys
	Hot Keys

	Cursor Enhancements
	Highlighting Options ->Cursor

	DocReader
	[bookmark: H_16697]Doc Reader (page 77)

	Dual Monitor
	[bookmark: H_16701]Multiple Monitor (see "Visual Multiple Monitors dialog box" page 191)

	Dye
	[bookmark: H_16702]Tint (page 180)

	Finder
	[bookmark: H_16684]Item Finder (page 151)

	Focus Enhancements
	[bookmark: H_16690]Highlighting Options ->Focus (see "Make the focus easier to see" page 26)

	Font Enhancements
	[bookmark: H_16700]Font Smoothing (page 195)

	Freeze Window
	[bookmark: H_16687]Hooked Area (see "Create static magnified windows to display information" page 20)

	Mouse Echo
	[bookmark: H_16694]Announce Text Under Mouse (see "Click and read" page 42)

	Pointer Enhancements
	[bookmark: H_16604]Highlighting Options ->Mouse

	Pointer Scheme
	[bookmark: H_16691]Mouse Pointers (see "Make the pointer easier to see" page 26)

	Text Finder
	[bookmark: H_16696]Find with Dolphin Cursor (see "Search using the Dolphin Cursor Find Command" page 71)

	Text Processing
	[bookmark: H_15584]Text Style Announcements

	Text Reading Commands
	[bookmark: H_16685]Speak Keys (page 132)

	Typing Echo
	[bookmark: H_16695]Character Echo (see "Change what is spoken when typing" page 43)

	View mode
	[bookmark: H_16686]Overview mode (see "Get an overview of the magnified window position" page 20)

	Window Type
	[bookmark: H_16688]Magnifier View (see "Change Magnifier view" page 14)

	Web Finder
	[bookmark: H_16699]Item Finder (page 151)

	Zoom Level
	[bookmark: H_16689]Magnification Size (see "Change magnification size" page 13)
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[bookmark: _Toc228971442]22Index
[bookmark: O_113]A
Access to Google Drive, 126
Accessing Ask AI Image Chat, 143
Accessing the Viewer's Settings toolbar, 113
Acquiring a suitable camera and stand, 110
Actions, 149
Adjust, 106
Adjust touch sensitivity, 142
Adjusting the Viewer position and size, 112
Annotating images, 127
Announce capital letters, 50
Ask a question about a scanned image, 107
Ask a question about an image file, 106
Ask a question about an image on the Windows clipboard, 107
Ask AI a question about the current image, 119
Ask AI a question about the displayed page, 92, 130
Ask AI layer, 189
Asking A Question, 144
Audio layer, 183
B
Braille, 175
Braille Advanced Options dialog box, 253
Braille Cursor menu and dialog box, 252
Braille General Announcements dialog box, 244
Braille General Preferences dialog box, 243
Braille Input menu and dialog box, 245
Braille layer, 183
Braille Layout menu and dialog box, 248
Braille reading, 69
Braille settings, 59
Braille Status Cells dialog box, 251
C
Camera Connect and View, 109
Camera settings, 130
Capture Viewer image, 119, 137
Change Braille display, 66
Change Braille table, 66
Change how repeated characters are read, 56
Change magnification size, 14
Change Magnifier view, 15
Change Map file, 99
Change reading speed, 32
Change reading voice language, 34
Change size and position of the magnified window, 16
Change speech synthesiser, 36
Change the appearance of the SuperNova Control Panel, 11
Change the colour, font and items displayed in Line View, 87
Change voice, 33
Change volume, 32
Change what is spoken when typing, 49
Change what SuperNova tells you about each type of control, 55, 61
Change what the Cursor Routing buttons do, 72
Change what the Cursor Routing buttons do above Status Cells, 74
Change what the Cursor Routing buttons do while using the Dolphin Cursor, 73
Changing the colours of the image, 116, 136
Characters, 246
Check text attributes, 74
Check where you are, 45
Choose Computer Braille or Literary Braille, 64
Click and read, 48
Close the SuperNova control panel, 11
Closing the Image Chat Window, 145
Connect and View, 109
Connecting to the presenter's computer, 131
Control Panel Theme, 260
Control reading, 89
Controlling Auto Focus, 117
Create a Hooked Area using the keyboard, 22
Create a Hooked Area using the mouse, 24
Create Application Settings, 97
Create Situation Settings, 98
Create static magnified windows to display information, 21
Cycle attributes, 75
D
Delete a Hooked Area using the keyboard, 23
Describe character, 77
Disable sounds at startup, 261
Doc Reader, 89
Dolphin Cursor, 81
Dolphin Cursor (General), 156
Dolphin Cursor (Mouse Control), 162
Dolphin Cursor (Movement), 158
Dolphin Cursor layer, 185
Dolphin Cursor Options, 246
Dolphin Cursor Selection, 163
E
Edit Application Settings dialog box, 205
Edit Map dialog box, 206
Edit Script menu item, 206
Edit Situation Settings dialog box, 205
Enable automatic language switching, 35
Enhance Read From Here, 47
Enhancement tab, 229
Exit Doc Reader, 92
G
General Advanced Options dialog box, 265
General Check for Updates, 256
General Control Panel dialog box, 258
General Hot Keys dialog box, 258
General Keyboard dialog box, 257
General Latest Release Notes, 256
General Notification Finder, 256
General Startup Preferences dialog box, 260
General Touchscreen Settings dialog box, 263
General Update Settings dialog box, 256
General Web Settings dialog box, 257
Get an overview of the magnified window position, 21
H
Hooked Areas tab (Braille), 254
Hot key conflicts, 193
Hot Keys, 149
I
Improving image quality, 117
Input using your Braille display, 65
Install and Set Up, 3
Introducing the SuperNova Control Panel, 7
Item Finder, 173
Item Finder dialog box, 255
Item Finder layer, 185
K
Keyboard commands to get around the SuperNova Control Panel, 8
L
Launch Doc Reader, 89
Layered hot keys, 181
Learn what your Braille buttons do, 69
Learn your hot keys, 4
Line View, 85, 171
Locking the image, 119, 137
M
Magnification Engine Settings button, 265
Magnification layer, 188
Magnifier, 13, 164
Magnifier Window Adjustment, 169
Magnifying the image in the Viewer, 114, 134
Make the focus easier to see, 28
Make the pointer easier to see, 29
Make the screen easier to see, 27
Media, 103
Media EasyReader, 108
Media Image Description, 106
Media Scan and Read, 103
Media Scan and Read Settings dialog box, 254
Modify a Hooked Area using the keyboard, 23
Move the cursor using the Cursor Routing buttons, 72
Moving around the screen, 69
N
New Application Settings dialog box, 203
New Map dialog box, 204
New Script menu item, 204
New Situation Settings dialog box, 203
Notification Finder, 147
O
Open in Doc Reader, 120
Options, 247, 248
P
Profiles, 93
Q
Quick Navigation Keys, 178, 180
Quick Navigation Keys for Microsoft Word, 180
Quick Navigation Keys for web browsers, 178
Quit SuperNova, 5
R
Read character, 39
Read continuously, 45
Read control, 42
Read date and time, 44
Read focus, 41
Read From Here, 155
Read From Here with the Dolphin Cursor, 47
Read line, read line to cursor and read line from cursor, 40
Read selected text, 41
Read shortcut key, 44
Read status, 43
Read text under the mouse pointer position, 49
Read using the mouse, 48
Read window, 43
Read word, 39
Reader layer, 190
Reading and typing, 39
Reassign a SuperNova hot key, 194
Reference, 203
Reviewing and Navigating the Conversation, 145
Rotating the image in the Viewer, 116
Routing Buttons, 245
Run SuperNova for the first time, 3
S
Save setting changes, 99
Scan and read a clipboard image, 105
Scan and read a file, 103
Scan and read printed material, 104
Scan layer, 189
Screen enhancements, 27
Scroll text in Line View, 86
Search using the Dolphin Cursor Find Command, 83
Select text using the Dolphin Cursor, 83
Selecting the camera in SuperNova, 110
Setting up your workstation, 110
Settings Files, 97
Settings in the SuperNova Control Panel, 10
Shortcut Key, 261
Show Braille output on the screen, 79
Show capital letters, 59
Show cursor position, 60
Show enhanced characters (bold, italic, etc.), 61
Show information on the Braille display Status Cells, 78
Show or hide Hooked Areas, 25
Show the physical make up of the screen, 63
Showing and hiding the Viewer toolbar, 113, 133
Speak Keys, 153
Speak the keys you press, 55
Speech, 151
Speech Advanced Options dialog box, 241
Speech Character Echo dialog box, 235
Speech General Announcements dialog box, 238
Speech Keyboard Announcements dialog box, 235
Speech layer, 190
Speech Text Style Announcements dialog box, 235
Speech Voice Preferences dialog box, 230
Start Line View, 85
Start SuperNova, 3
Style, 252
SuperNova Control Panel, 7
SuperNova Reader keyboard commands, 108
SuperNova Touch Bar, 141
Switching between digital and optical zoom, 118
Switching between the Viewer and the desktop, 111, 133
Switching on the Viewer, 111, 132
System layer, 192
T
Table layer, 191
Tell SuperNova to ignore the next key press, 193
Text Input, 174
The Image Chat Window, 144
Touchscreen, 139
Touchscreen gestures, 140
Touchscreen terminology, 139
Tracking the presenter's movement, 136
Turn Braille output off or on, 59
Turn magnification on or off, 13
Turn off focus tracking, 62
Turn off SuperNova hot keys, 193
Turn off the automatic Dolphin Cursor, 82
Turn off the Dolphin Cursor, 81
Turn on capital announcement, 51
Turn on capital announcement when reading lines, 52
Turn on the Dolphin Cursor, 81
Turn the voice off or on, 31
Types of Settings, 97
Typing on a touchscreen, 142
U
Understanding Images with AI, 143
Using a pitch change to indicate capitals when spelling characters, 54
Using Notification Finder, 147
Using sounds to indicate capitals, 53
Using your camera with SuperNova, 110
V
Verbosity tab (Braille), 253
View other parts of the screen, 18
Viewing other parts of the image, 115, 135
Viewing the presenter's computer, 132
Visual Advanced Options dialog box, 224
Visual Configure Custom Colour Scheme dialog box, 207
Visual Connect and View Settings dialog box, 217
Visual Doc Reader Settings dialog box, 215
Visual Highlighting Options dialog box, 210
Visual Mouse Pointers dialog box, 214
Visual Multiple Monitors dialog box, 222
Voice settings, 31
W
Whiteboard Connect and View, 131
Whiteboard settings, 138
Z
ZoomText to SuperNova product terminology guide, 195
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Chapter 21
[bookmark: O_14676][bookmark: _Toc228971443]23Reference
[bookmark: O_15562][bookmark: _Toc228971444]23.1  New Situation Settings dialog box
Menu: File > New > Situation Settings
You can create or choose an existing Situation by using options in the "New Situation Settings" dialog box.
Options:
[bookmark: H_15570]	Create New Situation radio button.
You can create a new Situation Setting by selecting this radio button and then choosing the "OK" button. This will move you to the next step in the creation process. To review all steps in this process please refer to the "Create Situation Settings" topic.
	Use an existing Situation radio button.
You can change to another Situation by selecting this option and then selecting from the available list. Note the Situation list will show only those Situation Settings available in the current Application Settings file.
	
[bookmark: O_15563][bookmark: _Toc228971445]23.2  New Application Settings dialog box
Menu: File > New > Application Settings
You can create or choose an existing Application Settings file by using options in the Application Settings dialog box.
Options:
	Create a new settings file radio button.
You can create a new Application Settings file by selecting this option and then choosing the "OK" button. After selecting the "OK" button, you will go to the next step in the creation process. To review all steps in this process please refer to the "Create Application Settings" topic.
[bookmark: H_15572]	Use an existing settings file radio button.
You can change to a different settings file by selecting this option and then by selecting a file from the available list. You confirm your selection by choosing the "OK" button. The settings will apply immediately unless you select the option "Use Default Settings in the control panel". If you do select this option then your new settings will apply when you go back to your application.
	
[bookmark: O_15564][bookmark: _Toc228971446]23.3  New Map dialog box
Menu: File > New > Map
You can create or choose an existing Map file by using options in the "Select New Map" dialog box.
Options:
	Create a new Map file radio button.
You can create a new Map file by selecting this radio button and then choosing the "OK" button. This will move you to the next step in the creation process. To review all steps in this process please refer to the "Mapping Guide". This is available through the SuperNova "Help" menu.
[bookmark: H_15571]	Use an existing Map file radio button.
You can change to an alternative Map file by selecting this option and then selecting a file from the available list. To learn more about the reasons why you might change a Map file please refer to the "Change Map file" topic.
	
[bookmark: O_15565][bookmark: _Toc228971447]23.4  New Script menu item
Menu: File > New > Script
You can create a new Script file for the current application by selecting this menu item. The new Script file will open in the Dolphin Script Editor. The Dolphin Script Editor includes a "Help" menu with options linking to the Scripting Guide.
Note: If a Script file exists for the current application then this menu item will be disabled. To view and edit an existing Script file, go to the "File" menu, "Edit" sub-menu and select "Script".
	
[bookmark: O_15566][bookmark: _Toc228971448]23.5  Edit Situation Settings dialog box
Menu: File > Edit > Situation Settings
You can delete or change the properties of your Situation Settings by using options in the "Situation Management" dialog box. Note that you must be using the Application Settings file that has the Situation Settings to be able to edit the Situations in that file.
	Situation list.
You can choose the Situation you want to edit or delete from this list.
	Edit Rules button.
You can edit the rules of a Situation by selecting this  button. This will open the "Define Situation Rules" dialog box. In this dialog box you can change the name of the Situation, change the title and class details of the Situation rule and add and remove Situation rules.
	Delete button.
You can delete the current Situation from your Application Settings file by selecting this button. After selecting the button you will receive a warning message asking you to confirm that you want to proceed. To proceed select the "Yes" button or to cancel select the "No" button.
	
[bookmark: O_15567][bookmark: _Toc228971449]23.6  Edit Application Settings dialog box
Menu: File > Edit > Application Settings
You can delete or change the properties of your Application Settings file by using options in the "Settings File Management" dialog box.
	Application Settings file list.
You can choose the Application Settings file you want to edit or delete from this list. Note that you cannot delete the "Default Application" settings file because this is a SuperNova system file.
	Properties button.
You can edit the properties of an Application Settings file by selecting this  button. This will open the "Settings File Properties" dialog box. In this dialog box you can change the name and version number of the settings file and add and remove any the applications associated with the file.
	Delete this settings file button.
You can delete the current Application Settings file by selecting this button. After selecting the button you will receive a warning message asking you to confirm that you want to proceed. To proceed select the "Yes" button or to cancel select the "No" button.
	
[bookmark: O_15568][bookmark: _Toc228971450]23.7  Edit Map dialog box
Menu: File > Edit > Map
You can edit the properties and rules of a Map file by selecting this menu item. To learn more about Map files please refer to the Mapping Guide available from the "Help" menu of the SuperNova control panel.
This dialog box also contains Script options. You can create, reload, edit and delete Script files and Extension Script files. To learn more about Script files please refer to the Scripting Guide. You can open the Scripting Guide from the SuperNova control panel "Help" menu.
	
[bookmark: O_15569][bookmark: _Toc228971451]23.8  Edit Script menu item
Menu: File > Edit > Script
You can edit the Script file for the current application by selecting this menu item. The Script file will open in the Dolphin Script Editor. The Dolphin Script Editor includes a "Help" menu with options linking to the Scripting Guide.
Note: If no Script file exists for the current application then this menu item will be disabled. To create a new Script file, go to the "File" menu, "New" sub-menu and select "Script".
	
[bookmark: O_15346][bookmark: _Toc228971452]23.9  Visual Configure Custom Colour Scheme dialog box
Menu: Visual > Colour Schemes > Configure.
You can create your own colour scheme by using options in the "Configure Custom Colour Scheme" dialog box.
Note: To open this dialog box you must choose "Custom" as your Colour Scheme and then choose "Configure" from the list of Colour Schemes.
You can create a custom scheme in this dialog box using one of the following options:
	Classic
	Tint
	Dual Tint
	Treble Tint
	Quad Tint
	Colour Replacement
The controls available in this dialog box change depending on the custom setting you have chosen.
	
[bookmark: O_16605][bookmark: _Toc228971453]23.9.1  Classic custom colour scheme options.
	Invert brightness check box.
This option inverts the brightness of the screen, turning a typically dark on light screen to a light on dark screen. This option does not affect the amount of colour on the screen.
	Contrast slider.
The "Contrast" slider controls colour definition, making light colours lighter and dark colours darker. This changes the screen in a similar way to the Contrast button you find on a television.
	Brightness slider.
The "Brightness" slider controls how bright the colours appear on the screen, making light colours more luminous and dark colours darker. This changes the screen in a similar way to the Brightness button you find on a television.
	Luminance Split slider.
The luminance Split is the position in the colour spectrum where light and dark colours divide. Moving the slider to the left means more of the colours in the spectrum are classified as being in the lighter spectrum. This influences the contrast and brightness values.
	Colour Adjust slider.
The "colour adjust" slider allows you to make general changes to screen colours with the exception of white and black. You can use the colour palette to view the changes that occur as you move the slider. A slider position of 0% means screen colours are unchanged.
	Colour slider.
The "Colour" slider allows you to control how much colour is on the screen. Changing this value means colours either become paler or more intense. You can use the colour palette to view the changes that occur as you move the slider. A slider position of 50% means screen colours are unchanged.
	Preview these colour settings when in this dialog box check box.
Select this check box to see your changes occur as you make them.
	
[bookmark: O_16606][bookmark: _Toc228971454]23.9.2  Tint, Dual Tint, Treble Tint and Quad Tint custom colour options:
	Invert brightness check box.
This option inverts the brightness of the screen, turning a typically dark on light screen to a light on dark screen. This option does not affect the amount of colours on the screen.
	Contrast slider.
The "Contrast" slider controls colour definition, making light colours lighter and dark colours darker. This changes the screen in a similar way to the Contrast button you find on a television.
	Brightness slider.
The "Brightness" slider controls how bright the colours appear on the screen, making light colours more luminous and dark colours darker. This changes the screen in a similar way to the Brightness button you find on a television.
	Luminance Split slider.
The Luminance Split is the position in the colour spectrum where light and dark colours divide. Moving the slider to the left means more of the colours in the spectrum are classified as being in the lighter spectrum. This influences the contrast and brightness values. When using Treble Tint and Quad Tint, additional contrast boundary sliders are available to define the boundary for the colours in the middle colour ranges.
	Level slider.
The "Level" slider allows you to control how intense the tint colour is applied to the screen. A value of 100%, where the slider is positioned to the right, means the tint colours completely replace the current screen colours. A value of 25% means the tint colours will be blended with the original screen colours at a ratio of 25:75, which creates a screen with more shades.
	Tint colour list boxes.
You will be able to choose from one to four different colours depending on whether you have chosen "Tint", "Dual Tint", "Treble Tint" or "Quad Tint". The colours you choose become the primary colours for the colour spectrum relative to the Luminance Split.
	Preview these colour settings when in this dialog box check box.
Select this check box to see your changes occur as you make them.
	
[bookmark: O_16607][bookmark: _Toc228971455]23.9.3  Colour Replacement custom colour scheme options:
	Invert brightness check box.
This option inverts the brightness of the screen, turning a typically dark on light screen to a light on dark screen. This option does not affect the amount of colours on the screen.
	Contrast slider.
The "Contrast" slider controls colour definition, making light colours lighter and dark colours darker. This changes the screen in a similar way to the Contrast button you find on a television.
	Brightness slider.
The "Brightness" slider controls how bright the colours appear on the screen, making light colours more luminous and dark colours darker. This changes the screen in a similar way to the Brightness button you find on a television.
	Luminance Split slider.
The Luminance Split is the position in the colour spectrum where light and dark colours divide. Moving the slider to the left means more of the colours in the spectrum are classified as being in the lighter spectrum. This influences the contrast and brightness values.
	From and To list boxes.
The "From" and "To" list boxes allow you to replace one colour with another colour. Use the list boxes to make one or multiple colour replacements.
	Preview these colour settings when in this dialog box check box.
Select this check box to see your changes occur as you make them.
	
[bookmark: O_14753][bookmark: _Toc228971456]23.10  Visual Highlighting Options dialog box
Menu: Visual > Highlighting > Settings
You can make different types of focus easier to see by adding a highlight indicator. You can choose the style, colour and behaviour of the highlight in the "Highlighting Options" dialog box.
	
[bookmark: O_14756]Mouse tab.
	Highlight the mouse check box.
Select this check box to turn on the highlighting of this focus. Deselect this check box to turn off the highlighting of this focus.
	Display group.
	Use the "Shape" settings to change the shape and size of the highlighting.
	Use the "Show" list box to control when the highlight is visible. Note that selecting "On hot key" means you control the highlight using the Foci Highlights hot key and selecting "Dynamic tracking" means the mouse highlight stays visible until you press a key on the keyboard.
	Effects group.
You can choose from different colour options. Depending on the option you choose you can also control the colour(s) and/or the transparency.
	
[bookmark: O_14768]Cursor tab.
	Highlight the Cursor check box.
Select this check box to turn on the highlighting of this focus. Deselect this check box to turn off the highlighting of this focus.
	Display group.
	Use the "Shape" settings to change the shape and size of the highlighting.
	Use the "Show" list box to control when the highlight is visible. Note that selecting "On hot key" means you control the highlight using the Foci Highlights hot key and selecting "Dynamic tracking" means the Cursor highlight stays visible until SuperNova is tracking a different type of focus, for example, the mouse.
	Effects group.
You can choose from different colour options. Depending on the option you choose you can also control the colour(s) and/or the transparency.
	
[bookmark: O_14770]Line tab.
	Highlight the Line check box.
Select this check box to turn on the highlighting of this focus. Deselect this check box to turn off the highlighting of this focus.
	Display group.
	Use the "Shape" settings to change the shape and size of the highlighting.
	Use the "Show" list box to control when the highlight is visible. Note that selecting "On hot key" means you control the highlight using the Foci Highlights hot key and selecting "Dynamic tracking" means the Line highlight stays visible until SuperNova is tracking a different type of focus, for example, the mouse.
	Effects group.
You can choose from different colour options. Depending on the option you choose you can also control the colour(s) and/or the transparency.
	
[bookmark: O_14771]Focus tab.
The term "Focus" refers to the focus used in dialog boxes and menus.
	Highlight the Focus check box.
Select this check box to turn on the highlighting of this focus. Deselect this check box to turn off the highlighting of this focus.
	Display group.
	Use the "Shape" settings to change the shape and size of the highlighting.
	Use the "Show" list box to control when the highlight is visible. Note that selecting "On hot key" means you control the highlight using the Foci Highlights hot key and selecting "Dynamic tracking" means the Focus highlight stays visible until SuperNova is tracking a different type of focus, for example, the mouse.
	Effects group.
You can choose from different colour options. Depending on the option you choose you can also control the colour(s) and/or the transparency.
	
[bookmark: O_14772]Read From Here tab.
Read From Here is a SuperNova reading mode. You can change highlighting options for the current word and the current line being read.
	Word group.
You must select "Highlight the spoken word" check box to turn on this highlighting option. Use the available settings to set how the spoken word is highlighted. 
	Line group.
You must select "Highlight the line" check box to turn on this highlighting option. Use the available settings to set how the current line being spoken is highlighted.
	
[bookmark: O_14773]Dolphin Cursor tab.
The Dolphin cursor is a special kind of cursor created by SuperNova. The Dolphin Cursor allows you to read the contents of the screen line by line, or word by word, or letter by letter using your keyboard. You can use the Dolphin cursor to review any part of your computer's screen.
	Current Character group.
You must select "Highlight the character" check box to turn on this highlighting option. Use the available settings to set how the character is highlighted.
	Current Line/Object group.
You must select "Highlight the line" check box to turn on this highlighting option. Use the available settings to set how the current line is highlighted.
	
[bookmark: O_15682][bookmark: _Toc228971457]23.11  Visual Mouse Pointers dialog box
Menu: Visual > Mouse Pointers
Available with SuperNova are mouse pointers that are larger and easier to see than the usual Windows mouse pointers. The pointers are available in a range of different colours and sizes.
Options:
	Scheme list.
You can choose an existing Mouse Pointer scheme from this list. If no existing scheme is suitable, use the other options to create a new scheme or modify an existing scheme.
	Type list and Pointer Image list.
The "Type" list shows the different pointers in Windows and the "Pointer Image" list shows the different images you can apply to the selected pointer type. To change a pointer, select the type of pointer and then choose a pointer from the images provided.
	New button.
Pressing the "New" button will open the "Create New Scheme" dialog box. In this dialog box, you enter a new name for the scheme. The new scheme name appears in the "Scheme" list.
	Restore to defaults button.
If you have modified a default SuperNova scheme, then selecting this button will return the scheme back to the SuperNova default pointers for the scheme.
	Delete button.
If you have created a new scheme, then pressing this button will open a message window asking you to confirm that the scheme is to be deleted. Choose "Yes" to delete the scheme or "No" to cancel.
	Custom pointer size group.
The options in this group allow you to adjust the size of the mouse pointers in the current scheme, relative to their default size.
	Use custom pointer size check box.
If you select this check box the value in the "Size" list will apply to all pointers in the current scheme.
	Size list.
The "Size" list contains a range of values you can apply to the pointers in your current scheme. You can choose a fixed size, for example 8, which will increase the pointers to 8 times their original size. When a fixed value is chosen, the pointers will remain at the same size regardless of what magnifier size you have set. Alternatively, you can choose a value relative to your magnification level, for example 150%. With a relative value, the pointer size will adjust as you increase or decrease your magnification size. At higher magnification levels you may find the fixed pointer size occupies too much of the screen, so you may benefit from choosing a relative pointer size smaller than the original size.
	Use custom pointer in magnified areas only check box.
If you select this check box then the custom pointer size is only visible in magnified areas. It is not visible when you turn off the Magnifier or view the unmagnified screen in Views such as Split Screen.
	
[bookmark: O_15990][bookmark: _Toc228971458]23.12  Visual Doc Reader Settings dialog box
Menu: Visual > Doc Reader Settings
The options available in the "Doc Reader Settings" dialog box control the Doc Reader reading environment. You can open this dialog box by selecting the item in the "Visual" menu or by selecting the "Settings" button from the Doc Reader toolbar.
Options:
	
[bookmark: O_15991]	Font settings.
In the Doc Reader you can define the font that is used to display the text within the document window.  You can also state the font size to use.
	Colour settings.
You can define the colours to use in the document window. There are three categories to which you can apply a foreground and background colour too.
	Document colours sets the background and foreground colours used in the document window.  However, if "Use document colours" is selected then this setting will not be applied.
	Word highlight colours sets the background and foreground colours used by the Doc Reader for the current focus.  This shows the currently selected word as the Doc Reader reads through the document.  However, if "Invert word" is selected then this setting will not be applied.  Instead the highlight will be inverted based on the custom colour settings.
	Unit highlight colours sets the background and foreground colours for your specified unit of movement.  This is what is highlighted as you cursor down through a document.
	Fetch whole document check box.
With the "Fetch whole document" check box selected you will load the complete document into the Doc Reader.  Depending on the size of the document, this may take a few seconds.  This option is only supported in DOM enabled applications such as Microsoft Word, Adobe Acrobat Reader, Internet Explorer, NotePad, WordPad, etc.
It is also possible to specify the number of lines you want to fetch by unselecting the "Fetch whole document" check box and then specifying the number of lines from the available spin control.  This will allow you to load a section of a document faster.
If you are working in an application that does not include DOM support then the Doc Reader will load the content from the current screen.  
	Invert word check box.
With the selection of the "Invert word" check box the focus highlighting will be an inverted highlight based on the document colours specified or based on the actual document's colours depending on what is currently enabled.
	
[bookmark: O_15992]	Doc Reader speech check box.
With this option selected the document will be read using your selected "Read From Here voice" stated in the "Voice and language" dialog box. You can disable speech output in the document window by deselecting this check box.
	
[bookmark: O_15993]	Use document colours check box.
Selecting this check box will mean that the Doc Reader will use the colours specified in the document instead of its own custom colours. 
	Use document styles check box.
Selecting this option will mean styles used in the document will appear in the Doc Reader.
	Wrap line to. list.
The "Wrap line to" option can be used to insert a line break on a line if it exceeds a particular length. This can be useful if lines are scrolling outside the current window.
To disable this feature set the "Wrap line to" value to 0.
	
[bookmark: O_16619][bookmark: _Toc228971459]23.13  Visual Connect and View Settings dialog box
Menu: Visual > Connect and View > Settings
The "Connect and View Settings" dialog box contains options you can use to change how SuperNova works with a camera and a whiteboard.
	
[bookmark: O_16877]General tab.
	Connect and View Window controls
	Position list
By default, the Connect and View window appears on the top half of the screen. However, you can dock the Connect and View window to the top, bottom, left, or right side of the screen. Or else you can set the Connect and View window to take over the entire screen.
	Size list
You can set the docked Connect & View window to fill 80%, 50%, or 20% of the screen area.
	On Monitor list
When using multiple monitors you can select which monitor the Connect and View window appears on. 
	Allow mouse to move freely between Connect and View window and the desktop check box
Disabling this option helps prevent the accidental movement of the mouse pointer into or out of your Connect and View window. 
	Resistance slider
With Allow mouse to move freely between Connect and View window and the desktop enabled you can add a level of mouse resistance when trying to cross the window border using this slider. The higher the level the greater the resistance, which means you have to hold the mouse pointer against the edge of the window for longer to move from window to window.
	Save Connect and View screen captures to Browse button
This option allows you to select the folder where Connect and View screen capture images are saved.
	Switch Connect and View Windows Hotkey list
The Add and Remove buttons allow you to redefine SuperNova's default hot key, CAPS LOCK + MIDDLE MOUSE BUTTON, for switching to and from the Connect and View window.
	
[bookmark: O_16621]Cameras tab.
	Devices list and controls
Use this list to select a camera to use with SuperNova. Set the value to "Off" if you want to prevent the selection of a camera when you switch between devices. Use the "Settings" button to optimise the camera performance. These options will differ between camera models. The following options are available:
	Resolution list
This lists available resolutions for your connected camera. Increasing the Resolution should improve the picture quality shown in the viewer.
	Frame Rate list
This is listed as frames per second (FPS). The higher FPS means frequently changing images appear smoother whereas lower FPS can decrease the amount of camera wobble detected, which may bring a better document reading experience.
	Anti Flicker list
This lists 50Hz which is usually selected for Europe and the UK and 60Hz usually selected for America and Japan. Selecting the correct Hz will eliminate flicker caused by florescent lighting that can interfere with a camera image. 
	Automatic Focusing check box.
If you find the Auto Focus regularly refocusing then you may wish to turn this feature off. Not all cameras include an Auto Focus feature. SuperNova will only make the Auto Focus check box available if the camera supports this feature.
	Colour Scheme list
Use this option to apply a default colour scheme to the camera viewer. Additional options are also available in the camera viewer to control the Colour Scheme setting.
	Use Camera Hardware Zoom check box
Use this option to enable hardware optical zooming for cameras that support it (rather than digital zooming). This results in an improved magnified image.
	Use Camera Colour Changer check box
Use this option to enable hardware colour changing options for cameras that support it (rather than software colour changing).
	Enhance High Contrast Colours check box
Use this option to boost the contrast of viewed images while using one of SuperNova's built in colour schemes. (This option is particularly useful when viewing pages containing text and diagrams).
	Auto Freeze Image check box
Use this option to remove "dancing dots" (also known as "salt and pepper" or "impulse" noise) from the camera's video stream (especially useful in poorly lit environments). 
	
[bookmark: O_16622]Whiteboards tab
	Devices list and controls
Use the Devices list and Add and Remove buttons to create, edit, or delete a whiteboard connection profile. Set the value to "Off" if you want to prevent switching to a whiteboard device. Use the "Add" button to create a new profile. Use the "Settings" button to edit an existing whiteboard connection profile.
The following additional options are available when you add or edit a profile:
	Profile
Use this edit area to give the whiteboard connection profile a meaningful name. You may want to name the whiteboard after the classroom or teacher to make it easy to select it in the future.
	Connection Mode
Specify the method used to connect to the teacher's whiteboard.
The options detailed below will change depending on which mode is selected:
	Different Networks
Select this option to connect via the internet using Dolphin’s secure relay server. This is used when you are in a different location or on a different network to the teacher.
	Same Network
Select this option to connect directly over the same Wi-Fi or local network (LAN).
	Settings for "Different Networks" Connections. (Visible only when "Different Networks" is selected)
	Your Name
Enter the name you wish to be identified by. This is the name the teacher will see on their screen when you request access to their whiteboard.
	Access Code
Enter the unique Access Code provided by your teacher.
	Organisation ID
Enter the unique Organisation ID provided by your teacher. This ensures you are connecting to your school network.
	Settings for "Same Network" Connections. (Visible only when "Same Network" is selected)
	Machine Name
Use this edit area to enter the name of the teacher's computer as it appears on the network. Alternatively, you can also enter the teacher's computer's IP address; however, this is not recommended because of the dynamic assignment of IP addresses under most network configurations.
	Port
By default, Virtual Network Computing (VNC) uses port 5900. You should only change this setting if directed to do so by your Network Administrator.
	Password
Use this edita area to enter the password that allows you to connect to the teacher's computer. The assignment of a password is optional and is set in the Whiteboard Assistant or VNC Server software. Your teacher or Network Administrator will be able to provide you with this information.
	Connection Type
Use these controls to select the option that matches your type of network connection. You can choose between a local area network (LAN) connection and a wireless connection.
	Protocol
There are a number of Remote Frame Buffer (RFB) protocols available that are supported by VNC. You should only change this setting if directed to do so by your Network Administrator.
	Optimise Connection For
Choose between "Text And Graphics" or "Video Playback" to ensure the best viewing experience for the content being screen-shared.
Once you have initiated a connection, a status window will appear. It will display the message "Waiting to be admitted into [Teacher's Name] session" while the teacher reviews your request. You can press the "Cancel" button at any time to abort the connection attempt.
	General Settings
	Show Mouse
Use this checkbox to control whether the mouse pointer on the teacher's computer appears in your Connect and View viewer window. You may want to enable this option if you want to see where the teacher's mouse pointer is being positioned on the whiteboard screen. You may want to disable this option if the presence of the mouse pointer is a distraction.
The additional options in the "Connect and View Settings" dialog box are general settings and apply to all whiteboard interaction, irrespective of the chosen device.
	Colour Scheme
Use this listbox to apply a default colour scheme to the whiteboard. Additional options are also available in the Connect and View whiteboard viewer window to control the Colour Scheme setting.
	Track presenter's position on whiteboard
Use this checkbox to control the tracking of the focus on the teacher's computer. Disabling this option means that you control the movement around the window. You can move around the window by using the mouse pointer or by panning around the screen with the keyboard.
	
[bookmark: O_15681][bookmark: _Toc228971460]23.14  Visual Multiple Monitors dialog box
Menu: Visual > Multiple Monitors
You choose the multiple monitor options in the Multiple Monitors dialog box.
To use multiple monitors, SuperNova requires a graphics card attached to the computer motherboard, such as an AGP/PCI or PCIe graphics card. The use of USB graphic card adapters is not supported.
Options:
	Display mode for extended desktop group.
You can use the options in this group to choose the most appropriate setup for computers where the desktop has been extended onto additional monitors.
	Span radio button.
You can choose this option if you wish to use two monitors to behave as one large monitor. In this scenario, one single desktop will span across both monitors.
	Side by side applications radio button.
You can use this mode to display different applications on different monitors. When working with side by side applications the following hot keys are of help:

	Function
	Hot key

	Jump mouse pointer to the middle of the next monitor
	CAPS LOCK + MIDDLE MOUSE BUTTON

	Move application to right monitor
	WINDOWS Logo Key + SHIFT + RIGHT ARROW

	Move application to left monitor
	WINDOWS Logo Key + SHIFT + LEFT ARROW



	Presentation Mode check box.
You use this option to have one monitor showing a magnified screen and all the remaining monitors showing an unmagnified screen. For example, this will allow you to work on a magnified screen while an audience viewing a presentation slide show on the second monitor will see an unmagnified screen.
	Mouse Buffer check box.
You can use this option to prevent the accidental movement of the mouse pointer onto another monitor when you are using an extended desktop. You achieve this by creating a level of resistance at the screen edge, which means you require additional force to move the mouse pointer onto another monitor. You can adjust the level of resistance the buffer creates by using the "Resistance" slider.
	Resistance slider.
You control the mouse buffer resistance using this slider. The higher the level the greater the resistance, which means you have to hold the mouse pointer against the edge of the screen for longer to move from monitor to monitor.
	Switch monitor hot key list.
When working with "Side by side" applications on an extended desktop, you may wish to move the mouse pointer quickly from one monitor to the next, without panning the magnification away from the area of the screen you are currently viewing. To do this, you can use the "Switch Monitor" hot key. The default hotkey to switch between monitors is CAPS LOCK + MIDDLE MOUSE BUTTON.
	Add Key, Replace Key and Remove Key buttons.
You can use these buttons to change the "Switch monitor" hot key.
	Allow different magnification levels on each monitor check box.
This option allows you to have independent magnification levels on each of your monitors. This is useful for instance when you have two monitors of different sizes and you need a little extra magnification on the smaller monitor, or when magnifying smaller text in an application on one of your other monitors.
	Independent colours check box.
This option allows you to have independent colour schemes on each of your monitors. This is useful for instance when you have applications on each monitor that require different colour adjustments to make easier to view for you.

When you make your SuperNova magnification level and colours independent, in SuperNova's control panel the monitor number that the magnification level and colour settings belong to will be displayed in the "Visual" property sheet (directly underneath the magnification size control).

(Don't forget that you can also make your SuperNova settings application-specific).
	
[bookmark: O_14693][bookmark: _Toc228971461]23.15  Visual Advanced Options dialog box
Menu: Visual > Advanced Options
You can specify settings for a variety of SuperNova features by selecting options in the "Visual Advanced Options" dialog box.
	
[bookmark: O_14694]General Preferences tab
	Highlight Hot Key Action group.
Visual Highlights can be set to appear in a number of different ways. One of these ways is to show the selected Highlights when a hot key is pressed. How the hot key behaves when pressed is determined by the "Show Highlight" list box. This can be set to "Until Hot Key pressed again" or "Until Hot Key released".
	Fractional Magnification group.
The "Allow fractional magnification" check box determines whether increases in the size of magnification will include fractional values. If you turn fractional magnification off, nothing will immediately change. Only after the next magnification adjustment will the factor move to the nearest linear factor.
If you experience issues when using fractional magnification sizes then options are available to try and improve performance.
	Overview Mode group.
The settings in this group determine how the Magnifier position is displayed on the screen when in Overview Mode. The magnified area can be inverted or the background can be inverted. In this group settings also determine the behaviour of the Overview Mode hot key. This can be set to "Until Hot Key pressed again" or "Until Hot Key released".
	Video Compatibility button.
This button will open the "Video Compatibility" dialog box. This dialog box contains a number of check boxes for optimising the speed of the magnification and resolving screen corruption problems caused by non-compliant video drivers.
	Mouse Buffer check box.
The "Mouse Buffer" check box when enabled helps prevent the accidental movement of the mouse pointer into or out of your Connect and View viewer window when the "Allow mouse pointer to move between camera window and desktop" check box is enabled. This is achieved by creating a level of resistance at the window border, which means you require additional force to move the mouse pointer into the other window. You can adjust the level of resistance the buffer creates by using the "Resistance" slider.
	Resistance slider.
	You control the mouse buffer resistance using this slider. The higher the level the greater the resistance, which means you have to hold the mouse pointer against the edge of the window for longer to move from window to window.
	
[bookmark: O_14695]Magnifier tab.
	Lock Aspect check box.
If the "Lock Aspect" check box is unselected then you will have two spin controls that will allow you to adjust the horizontal and vertical magnification size independently. If you turn lock aspect ratio back on, the magnification factor will change to the average of the horizontal and vertical factors. Note that True Fonts is unsupported when  working with a different horizontal and vertical magnification size.
	
[bookmark: O_15573]	Font Smoothing group.
Font smoothing improves the legibility of the text on the screen when you use magnification. Options include:
	None radio button.
Choose "None" to turn off Font Smoothing.
	Standard radio button.
Choose "Standard" for basic font smoothing. Use this option if you are experiencing performance issues using True Fonts.
	True Fonts radio button.
Choose "True Fonts" for perfect clarity at all magnification sizes. You may wish to experiment with the True Font Settings if you are using a magnification size of 3x or lower or you are using an LCD monitor.
	True Fonts Settings group.
	Standard radio button.
Using "Standard" renders text in a non- antialiased mode. This is the default and fastest method, especially when using a magnification size of 4x or greater.
	Antialiased radio button.
This setting renders  the text and smooth's the text edges. If you experience jagged effects using True Fonts at a low magnification size then you should select this option.
You can switch between "None", "Standard" and "True Fonts" by using a SuperNova hot key.
Magnifier Hot Keys
	Function
	Desktop - Default NumPad Set
	Laptop - Universal Set

	Font Smoothing
	LEFT CONTROL + NUMPAD 8
	No Assignment


Note that True Fonts is unavailable if you are using a different vertical and horizontal magnification ratio. You can independently change the vertical and horizontal magnification size by deselecting the "Lock Aspect" check box in the "Visual Advanced Options" dialog box.
	
[bookmark: O_14700]Tracking tab.
	Mouse tracking group.
In this group the "Track mouse pointer" check box controls whether SuperNova follows the mouse pointer. When tracking the mouse pointer the window will scroll whenever the mouse is moved beyond the mouse frame. The distance that it moves will normally be just enough so that the mouse ends up at the edge of the screen or margin. To adjust the mouse frame, press the mouse frame button. This takes you to the Mouse and Foci Frame Dialog Box.
The "Move mouse pointer into view" check box determines what happens when the mouse pointer is currently not visible inside the magnified window. With this option selected, when the mouse pointer is initially moved, the mouse pointer will be brought to the centre of the magnified window. If this option is unselected then the magnified window will be moved to the mouse pointer's location on the screen.
If the "Stay in window" check box is selected, artificial mouse boundaries are created around the currently selected window. This places a restriction on the mouse pointer so the display does not easily move away from the current window. These mouse boundaries are removed if you move the pointer beyond the edge of the window.
The "SHIFT key locks mouse movement horizontally or vertically" check box when enabled causes the panning of the magnified viewport to be locked entirely horizontally or vertically while the SHIFT key is being held down (depending on the initial direction of your mouse movement). Releasing the SHIFT key returns mouse movement to normal.
	Cursor tracking group.
The "Track Cursor" check box controls whether the Magnifier follows the beam cursor inside edit areas. If this checkbox is selected, the magnified window will move to show the area around the cursor as it moves. The Cursor Frame (the minimum distance between the beam and the edge of the screen) can be set in the Caret Frame dialog box by pressing the "Cursor Frame" button.
	Focus tracking group.
In this group you can control whether the Magnifier tracks other types of Windows controls. Available options are menus, controls and windows.
The "Keep focus in centre" check box sets whether any controls that are being tracked such as menus and small dialog boxes are to be centred in the magnified window if they fit. If "Keep focus in centre" is not selected the display will move the minimum amount possible to make the object completely visible.
The "Track Narrator" check box controls whether Windows Narrator's focus highlight is tracked when Narrator is running. (Requires Windows 10 build 17763 or greater).
	
[bookmark: O_14701]Line View tab.
Line View is a SuperNova reading mode. In this mode the content of the visible screen is shown as a single line scrolling across the screen. Line View lets you control background and text colour, text size and what font to use.
	
[bookmark: O_14702]Hooked Areas tab.
Hooked Areas allow you to keep a particular area of the screen permanently displayed. This lets you keep an eye on important information that may frequently change as you use your application.
	
[bookmark: O_16791][bookmark: _Toc228971462]23.15.1  Enhancement tab
Enhancement tab
	Font Enhancement group.
The "True Fonts Bold" check box adds boldness to True Font magnified text.
The "Standard Bold" check box adds boldness to non-True Font magnified text, such as the text found in the Windows 10 Start menu and in the content pane of Google Chrome and Mozilla Firefox.
The "Low", "Medium" and "High" radio buttons control the amount of boldness added to the magnified text.
	Image Enhancement group.
The "Sharpen" check box controls whether SuperNova sharpens magnified images (including photographs) as well as non-True Font text.
If the "Sharpen" check box is enabled SuperNova will sharpen magnified images and non-True Font text by exaggerating the brightness difference along any edges on your screen, thus making those edges appear more pronounced. The sharpening process works by subtracting a slightly blurred version of your screen image from your original screen image in order to detect the presence of edges, creating what's known as a "mask". Using this mask the contrast along the detected edges is then selectively increased leaving behind a sharper image.
The "Contrast" slider controls the minimum brightness difference  sharpened. This can be used to sharpen more pronounced edges, while leaving more subtle edges untouched. It's especially useful to avoid sharpening noise.
The "Size" slider controls the size of the edges you wish to enhance, where a smaller size enhances smaller detail. You'll usually want a size setting that's comparable to the size of the smallest detail within your image. The key to effective sharpening is finding the right settings for making edges appear sufficiently pronounced while minimising sharpening "halos".

Note: The Standard bold and Sharpen options are not available on Windows 7.

	
[bookmark: O_14733][bookmark: _Toc228971463]23.16  Speech Voice Preferences dialog box
Menu: Speech > Voice Preferences
You can change various Voice settings in the "Voice Preferences" dialog box.
	
[bookmark: O_14735]General tab.
	Volume spin control.
Use the "Volume" spin control to change how loud the voice sounds. This value is independent to the computer's own volume setting.
	Speed spin control.
Use the "Speed" spin control to change how fast the voice reads.
	Spelling Speed spin control.
Use the "Spelling Speed" spin control to select how fast characters are spelt. You may wish to set this to a speed lower than your normal reading speed to make the spelling of words easier to understand.
	Change voice pitch for spelt capitals check box.
Select this check box to have your reading voice rise in pitch when spelling a capital letter. Examples when you are spelling characters include when you have Character Echo set to echo each character you type, when you move across a line of text a character at a time and when you delete a character. Note that this item will not be available if your current synthesiser does not support this option. This option also includes an listbox directly below that lets you stipulate the pitch change value. You can set the value to be higher or lower than the default value. This enables you to adjust the pitch change depending on your hearing range, and to potentially address any limitations in the synthesiser voice.
	
[bookmark: O_14738]Synthesiser Configuration tab.
	Select Synthesiser button.
Choose this button to open the "Select Synthesiser" dialog box. This dialog box lists all synthesisers detected by SuperNova.
If the only option in the list is 'no Speech Device' then this means there are no configured speech synthesisers to choose from. Check that your synthesiser is configured correctly and make sure it is detected by Dolphin SAM. This is done by choosing "SAM Setup" in the "General Advanced Options" dialog box.
	Configure button.
The configure button will open the Driver Configuration dialog box for the synthesiser currently in use.
	Language Configuration list box and Set Language for button.
Not all speech synthesisers are able to return information about which language or languages they have available. If SuperNova determines that this is the case, you can use the language configuration box to set the language. If SuperNova detects the language then the options will be disabled.
	
[bookmark: O_14744]Voice and Language Configuration tab.
The "Voice and Language Configuration" property sheet lets you choose different voices for different speech contexts. A speech context is a special attribute of the text to be spoken which indicates where it came from or what SuperNova feature you are using.
You may find it useful to have different voices for different contexts. This can help remind you what feature you are using or the type of control currently being used.
The set of voices that are chosen here, and which are currently defined are saved automatically on a per-synthesiser basis. This means that if you change synthesiser you will have a different set of voices, but the voices for your first synthesiser are saved and will be used again if you switch back to your original synthesiser.
The options in this property sheet are:
	Screen Reader group.
In this group you set the Screen Reader "Language" and "Voice". This reflects the language and voice SuperNova will use to speak prompts. A prompt is something that is spoken which is not taken from the screen. Usually, your screen reader language will match your Access System Language.
	Screen group.
This group lets you set the synthesiser language and voice that is to be used to read text from the screen.
You can choose which voice is to be used to read the text from the screen when you are in an edit area, prompt area (e.g. dialog box), a menu, a spreadsheet, or when reading text under your mouse. 
You can also use a different voice when a SuperNova feature is being used. This will override any other voice chosen for any other area.
Each of the individual voice list boxes also contains a "No Voice" option if you wish to disable speech output for that particular type of area.
	Automatic language switching group.
The options in this group lets you control automatic language switching. Automatic language switching changes the synthesiser language to match particular alphabetic scripts; making screen reading a more fluent experience. 
If you have the appropriate synthesiser language installed, you can automatically switch between many languages including Latin, Arabic, Chinese (Mandarin), Greek, Hebrew, Hindi (Devanagari) and Russian (Cyrillic) scripts.
Note that not all synthesisers support this feature. To learn more about available synthesiser languages please contact Dolphin or your local Dolphin dealer.
	Install Additional Voices button.
This option lets you install additional Vocalizer speech synthesiser voices and languages. The process will seamlessly download and install the voices you select without you needing to restart your computer.
	Load All Default Voices button.
Pressing the "Load all Default Voices" button sets all voices back to the synthesiser's default value.
	Voice Exceptions.
Voice Exceptions are a pronunciation correction feature that allows you to correct the mispronunciation of certain words by a specific speech synthesiser voice. Those pronunciation corrections may involve technical words or words originating from a different language. When you press the "Edit" button the Voice Exceptions dialog box will be displayed, listing any existing pronunciation correction rules for the currently selected speech synthesiser voice. In the Voice Exceptions dialog box you're able to add, edit and remove pronunciation correction rules for the selected speech synthesiser voice. Each individual pronunciation correction rule consists of a "Source word", e.g. "Dr", and a "Replacement word", e.g. "doctor". A pronunciation correction rule can be made case-sensitive by enabling the "Case sensitive matching" check box. Examples of case-sensitive rules in English could be:
	IT; US; VAT; WHO; Polish
In the above examples, words with uppercase letters are pronounced differently if they were written in lowercase.

	
[bookmark: O_14747]User defined voices tab.
This property sheet is used to create and modify the speech synthesiser voices. You can define your own voices or edit the existing ones. Each voice consists of a name and number of synthesiser parameters. The actual number of synthesiser parameters, their meaning and possible range of values depend upon your synthesiser.
The options in this property sheet are:
	Language list box.
Use this list box to state what language the new voice is to be based upon or what language the existing voice that you want to modify can be found in.
	Voice list box.
The Voice pull-down list box displays a list of all the currently available speech synthesiser voices. Choose the voice that you wish to edit or delete from this list.
	Add, Delete and Rename buttons.
These buttons let you either create a new voice, delete the currently selected voice or rename the currently selected voice.
	Parameters group box.
The options in this group box set the basic speech characteristics of the voice. This is the pitch and intonation.
	Other Speech Parameters group box.
This group box contains other more synthesiser-dependent settings. These parameters are in a pull-down list entitled "Parameter". Each parameter has a value that can be adjusted in the "Value" list box.
	Test text edit area.
The test text is an edit area which contains some text. This text is read out every time you change the value of a voice parameter. You can edit this text and put in anything you like. This test text lets you change parameters and hear what they sound like without the risk of changing the voice to something that you can't understand, which could occur if you were editing the same voice you were using.
	Load Default Voices for Current Language button.
This button loads the default set of voices from the synthesiser. The actual set of voices depends upon your synthesiser. The voice names used will depend upon your current access system language.
The voices defined here are unique to SuperNova. They will not appear in any other program that uses the same synthesiser.
	
[bookmark: O_14774][bookmark: _Toc228971464]23.17  Speech Character Echo dialog box
Menu: Speech > Character Echo
The "Character Echo" dialog box sets what is to be spoken as you type. You can have characters, words, both characters and words or nothing spoken.
	
[bookmark: O_14775][bookmark: _Toc228971465]23.18  Speech Keyboard Announcements dialog box
Menu: Speech > Keyboard Announcements
The "Keyboard Announcements" dialog box lets you add key press announcements to SuperNova spoken output.
	
[bookmark: O_14776][bookmark: _Toc228971466]23.19  Speech Text Style Announcements dialog box
Menu: Speech > Text Style Announcements
You can specify settings for punctuation announcement, number announcement and text attribute announcement by selecting options in the "Text Style Announcements" dialog box. This dialog box has multiple tabs, dividing settings into different contexts.
Contexts:
	Edit Areas tab has settings you can apply to text in any control designed for text input; where you can view, enter, or edit text or numbers. Examples include the document window in a wordprocessor, a text box on a web page or an entry field in an address book.
	Prompt Areas tab has settings you can apply to all areas with the exception of edit areas and menus. Examples include field labels in dialog boxes, message windows and worksheets.
	Menus tab has settings you can apply to menus.
[bookmark: H_15520]	Read From Here tab has settings you can apply to this SuperNova continuous reading mode.
	Dolphin Cursor tab has settings you can apply to this SuperNova screen reviewing mode. 
	Spreadsheet tab has settings you can apply to reading the values of Excel worksheets. You can control punctuation, number announcement, and numerous text style properties.
Settings:
	Punctuation Level list.
SuperNova groups punctuation characters into specific categories. You can change how much punctuation is announced by SuperNova by changing the punctuation level.
	Number Announcement group.
You can read numbers as digits, pairs or words. If you select "Digits" then SuperNova will spell each number, for example, one, two, three, four. If you select "Pairs" then SuperNova will read numbers as a two digit value, for example, twelve, twenty three. If you select "Words" then SuperNova will read numbers in full, for example, one thousand, two hundred and twenty three.
	Announce group
	Blank lines check box.
You can have SuperNova tell you when the focus is on a blank line by selecting this check box. This option applies specifically to edit areas.
[bookmark: H_15521][bookmark: H_15522]	Capitals check box.
You can have SuperNova tell you when a capital letter is being used by selecting this check box. You choose how SuperNova indicates capitals by choosing settings in the "Voice Preferences" dialog box and "General Announcements" dialog box.
[bookmark: H_15523]	Repeats check box.
You can change how SuperNova reads repeating characters by selecting this check box. This applies to punctuation characters and symbols and excludes letters and numbers. You control the method SuperNova uses to indicate repeated characters by choosing settings in the "Repeats" dialog box.
	Colour change check box.
You can have SuperNova tell you about changes in the font colour by selecting this check box.
	Back colour change check box.
You can have SuperNova tell you about changes in the background colour by selecting this check box.
	Point size change check box.
You can have SuperNova tell you about changes in the font size by selecting this check box.
	Font change check box.
You can have SuperNova tell you about changes in the font type by selecting this check box.
	Selected check box.
You can have SuperNova tell you about selection changes by selecting this check box. For example, if you select one word in a line of text and then press the Read Line hot key, SuperNova will announce the selection change.
	Links check box.
You can have SuperNova tell you when links are part of the text you are reading by selecting this check box. Note, this option does not apply to web pages. To change the announcement of links on web pages requires changes to your verbosity scheme.
	Meaning change check box.
You can have SuperNova tell you when text is marked as an abbreviation, acronym, citation, emphasis, shortquote, strong and monospace by selecting this check box. This option applies to HTML content.
	Underline change check box.
You can have SuperNova tell you when text is underlined by selecting this check box.
	Weight change check box.
You can have SuperNova tell you when text is bold by selecting this check box.
	Italics change check box.
You can have SuperNova tell you when text is italic by selecting this check box.
	Strikethrough change check box.
You can have SuperNova tell you when text is strikethrough by selecting this check box.
	Spelling Error check box.
You can have SuperNova tell you when text is marked as a spelling error by selecting this check box. This option applies to Microsoft Office and requires you to be showing errors in your document by using Office's wavy underline option.
	Grammar Error check box.
You can have SuperNova tell you when text is marked as a grammar error by selecting this check box. This option applies to Microsoft Office and requires you to be showing errors in your document by using Office's wavy underline option.
	Script change check box.
You can have SuperNova tell you when text is subscript or superscript by selecting this check box.
	Heading change check box.
You can have SuperNova tell you when a heading style change occurs by selecting this check box.
	Text Effect change check box.
You can have SuperNova tell you about a text effect change by selecting this check box. A text effect is a character attribute like emboss, shadow or engrave.
	Text Animation change check box.
You can have SuperNova tell you about a text animation change by selecting this check box. A text animation is a character attribute like "Blinking Background", "Las Vegas Lights" and "Marching Red Ants". This option applies to Microsoft Office.
	
[bookmark: O_14777][bookmark: _Toc228971467]23.20  Speech General Announcements dialog box
Menu: Speech > General Announcements
You can specify settings for a variety of SuperNova features by selecting options in the "General Announcements" dialog box. The availability of some options depends on the synthesiser you are using.
	
[bookmark: O_15530]	Announce Braille changes check box.
You can announce the changes you are making to Braille settings when you are using hot keys by selecting this check box. This includes turning on Braille output, turning on Literary Braille, turning on Physical Braille, turning on Enhanced Braille and  your Routing button actions.
	
[bookmark: O_15531]	Announce magnification changes check box.
You can announce the changes you are making to magnification settings when you are using hot keys by selecting this check box. This includes turning on the Magnifier, changing Magnifier View, changing Split Screen orientation, Magnifier Size and turning on your Colour Scheme.
	
[bookmark: O_15532]	Announce 'no focus detected' check box.
You can have SuperNova announce when an application loses focus by selecting this check box. An example when an application might lose focus is when closing a foreground window fails to place the focus in the background window. You can usually resolve this loss of focus by pressing ALT + TAB to switch to an open application or by pressing WINDOWS KEY + D to place focus on the Desktop.
	
[bookmark: O_15533]	Announce text under mouse check box.
You can have SuperNova read the text under the mouse pointer by selecting this check box. To read the text requires you to move the mouse pointer to the place where the text is on the screen.
	
[bookmark: O_15534]	Announce clipboard actions check box.
You can have SuperNova announce the results of your cut, copy and paste key commands by selecting this check box. SuperNova bases the clipboard announcements on the use of CONTROL + C to copy, CONTROL + X to cut and CONTROL + V to paste. If you use different keyboard commands then use the options in the "Clipboard key mapping" dialog box to define alternative key presses.
	
[bookmark: O_15535]	Announce line count when selecting text check box.
You can count the number of lines you are selecting by selecting this check box. Note that this option is only available in areas with a supporting Document Object Model (DOM) like NotePad, WordPad and Microsoft Word.
	
[bookmark: O_15538][bookmark: H_15541]	Announce capitals when reading lines check box.
You can include capital announcements when you read a line of text by selecting this check box. You are reading a line of text when you are moving focus to a new line, for example, by using keys like UP ARROW, DOWN ARROW, PAGE UP and PAGE DOWN.
Note: To turn on capital announcement you must select the "Capitals" check box in the "Edit Areas" tab of the "Text Style Announcements" dialog box.
	
[bookmark: O_16901]	Announce phonetic description when navigating by character check box.
Enables you to append the phonetic description of an alphabetic character to the automatic output. The phonetic description will be announced approximately two seconds after the character is spoken but is relative to your voice speed. You may find this useful when navigating text and require clarification on characters due to their similarity when spoken by your synthesiser, for example, n and m may be difficult to distinguish between with some synthesiser voices.
	
[bookmark: O_15540]	Use Beeps for Capital Announcement check box.
By default, SuperNova will describe capital letters by using words. Using words is a method all synthesisers support. However, it is also possible with some synthesisers to indicate capitals with a sound. If this option is available, you can use beeps to indicate capitals by selecting this check box.
	
[bookmark: O_15539]	Uses sound list.
If you select the "Use Beeps for Capital Announcement" check box then you can choose the sound you would like to use to indicate capitals from this preset list.
	
[bookmark: O_15536]	Repeats button.
You can open the "Repeats" dialog box by selecting this button. The "Repeats" dialog box lets you control how SuperNova reads repeating characters.
	
[bookmark: O_15537]	Clipboard key mapping button.
You can open the "Clipboard key mapping" dialog box by selecting this button. The "Clipboard key mapping" dialog box lets you define what keys Windows uses for cut, copy and paste commands.
	
[bookmark: O_14709][bookmark: _Toc228971468]23.21  Speech Advanced Options dialog box
Menu: Speech > Advanced Options
You can specify settings for a variety of SuperNova features by selecting options in the "Speech Advanced Options" dialog box.
	
[bookmark: O_14714]Cursor tab.
	Use Dolphin Cursor automatically check box.
This setting lets you turn the automatic Dolphin Cursor on or off.
The automatic Dolphin Cursor is a special feature that may be programmed in as part of a Map file. The Map file can set areas to automatically use the Dolphin Cursor when the keyboard focus moves to certain parts of your application. This is useful when no application focus exists in the designated window.
You can turn on and off the automatic Dolphin Cursor behaviour with a hot key. To toggle automatic Dolphin Cursor on and off press LEFT CONTROL + 4.
	Restrict Dolphin Cursor to current area CHECK BOX.
The Dolphin Cursor can be restricted in its movement so that it cannot move outside the current area. This behaviour is set in a Map file. This check box determines whether the Dolphin Cursor should be restricted to the current area or not.
You can use a hot key to turn on and off this restriction. To toggle this option on and off press LEFT CONTROL + 2. Note that this setting will only become active the next time you turn the Dolphin Cursor on.
	Auto Forms Mode check box.
When this check box is selected you will be automatically switched into Forms Mode when you TAB onto an input Field. This enables you to fill in forms more easily using the Dolphin Cursor. A hot key can also be used to toggle this feature. Press CAPS LOCK + ENTER to toggle automatic Forms Mode on and off.
	
[bookmark: O_14718]Verbosity tab.
SuperNova comes with a number of default Verbosity Schemes. A Verbosity Scheme controls what SuperNova tells you about the current control type, like a button or check box. In this property sheet you can modify an existing Verbosity Scheme or even create your own custom schemes.
You can learn more about modifying or creating your own verbosity schemes by visiting the Tutorial pages on the Dolphin web site.
	
[bookmark: O_14723]Monitor Markers tab.
Monitor Markers monitor certain areas of the screen for change. When a change occurs then the Monitor Marker will perform a designated action. The Monitor Marker and action are set in a Map file. Where a monitor marker has been implemented within a map then this should be explained in the accompanying support documentation.
The "Monitor Markers" property sheet can be used to switch individual Monitor Markers on or off.
	Set of markers list box.
Use this pull down list box to choose a set of Monitor Markers to be listed below. You can either list all Monitor Markers for areas that are currently displayed on the screen, or a list of Monitor Markers for all currently running applications or you can choose to list all the Monitor Markers for a specific map file. 
	Marker Action list view.
This list shows all the Monitor Markers in the selected set. Use the check boxes in front of each list item to switch the Monitor Marker on or off.
A hot key can also be used to turn on and off all Monitor Markers. To do this press LEFT CONTROL + 5.
	
[bookmark: O_16876]Audio tab.
	Split Audio check box.
When using a stereo headset or speakers, this setting enables you to have SuperNova's speech output in one ear and the audio of all other applications in your other other ear. While in a Zoom, Teams, or Skype call, this enables you to more easily type notes, read text aloud, adjust meeting settings, and perform other tasks while participating in the meeting. Additionally, this setting may also prove useful while listening to music, podcasts, or audio books, while performing other tasks, such as editing a document. You can can select which ear to hear SuperNova's speech output in using the On Left Channel or On Right Channel radio buttons.
	Duck audio when speaking check box.
This setting temporarily lowers the volume of all other applications while SuperNova is speaking. The Duck volume level to slider allows you to select the volume level to temporarily lower other applications to while SuperNova is speaking. Again, this feature may be useful in a virtual meeting, or when multi-tasking while listening to music, prodcasts, or audio books.
	
[bookmark: O_14778][bookmark: _Toc228971469]23.22  Braille General Preferences dialog box
Menu: Braille > General Preferences
You can change various Braille settings in the "General Preferences" dialog box.
	
[bookmark: O_14779]Translation Tables tab.
	Unicode to Braille Conversion list box.
Choose from this list the Computer Braille table SuperNova uses to translate text to Braille. The language you select is used for both Computer Braille output and Computer Braille input. Computer Braille strictly uses one Braille cell per character, whatever that character is. It is of most use in applications where every character is of importance, you need to distinguish each possible character and space is not at a premium. 
	Unicode to Literary Braille Conversion list box.
Choose from this list the Literary Braille table SuperNova uses to translate text to Braille. The language you select only applies to Literary Braille output. The term Literary Braille covers both grade 1 and grade 2 Braille tables. Literary Braille is of most benefit when reading ordinary text
	Literary Braille Input list box.
Choose from this list the Literary Braille table SuperNova uses to convert Braille input to text. The language you select only applies to Literary Braille input. When you use Literary Braille input, you use 6 dots and use uncontracted or contracted Braille (depending on the chosen input language).  Please note that the Braille characters you type will only appear in your document when you press the Braille Space key, or another key which is not a combination of Braille dots.
	
[bookmark: O_14780]Braille device tab.
	Select Braille display button.
Choose this button to open the "Select Braille display" dialog box. This dialog box lists all Braille devices detected by SuperNova.
If no options are in the list then this means there are no configured devices to choose from. Check that your Braille display is configured correctly and make sure it is detected by Dolphin SAM. This is done by choosing "SAM Setup" in the "General Advanced Options" dialog box.
	Configure button.
The configure button will open the Driver Configuration dialog box for the Braille display currently in use.
	Scroll Margin spin box.
The Scroll Margin determines the amount the Braille display will move when you press the Read Back or Read forward keys. It is also used to scroll the display when a cursor moves beyond the left or right edges of the display.
	
[bookmark: O_14781][bookmark: _Toc228971470]23.23  Braille General Announcements dialog box
Menu: Braille > General Announcements
	Braille Changes group.
Select the SuperNova changes to be output to your Braille display.
The Display table headings inside brackets check box enables you to surround the defined heading with brackets to distinguish it from cell text, for example, this may show on the braille display “R2C2 (January Sales) 120”. Note that the appearance of the heading in the output is controlled by your Verbosity Scheme. Heading detection is supported on webpages, spreadsheets, and Word documents.
	Delimiters group.
These two lists allow you to place various shaped Braille characters around different types of objects in Physical Mode. Choose the type of object from the first list then the characters to use to mark that object from the second.
	
[bookmark: O_5152][bookmark: _Toc228971471]23.24  Braille Input menu and dialog box
Braille menu > Input
The Input menu allows you to change the options for the braille input.
Braille Input controls the action that the braille routing buttons perform. In addition certain braille displays allow "Braille Key Input", i.e. using the keys on the braille display for typing text. 
	
[bookmark: O_5154]	Braille keys item.
This option allows you to type characters by using six or eight buttons on your Braille Display.  The buttons you use to type depend on your display, and not all displays have this capability. Six key input can be useful if you wish to type without removing your hands from the Braille display. Computer code is used for this type of input.
	
[bookmark: O_14170]	Literary Input item.
This option allows you to type characters by using six or eight buttons on your Braille Display.  The buttons you use to type depend on your display, and not all displays have this capability. It is also restricted to supported Braille tables.
	
[bookmark: O_5155][bookmark: _Toc228971472]23.24.1  Routing Buttons
The "Input from Display" dialog box allows you to set what the routing buttons do on your Braille display and select whether the Braille Input Mode is on.
	
[bookmark: O_2661]	Routing Button Action group.
These radio buttons determine what happens when you press a routing button on your Braille display. The choices are to perform a left mouse click, double click, right click or describe the character at that point.
	
[bookmark: O_2662]	Second Routing Button Action group.
These radio buttons determine what happens when you press a secondary routing button on your Braille display. The options are to perform a left mouse click, double click, right click or to describe the character at that point. Not all Braille displays have a second row of routing buttons.
	
[bookmark: O_5156][bookmark: _Toc228971473]23.24.2  Dolphin Cursor Options
The "Input from Display in Dolphin Cursor Mode" dialog box allows you to set what the routing buttons do on your Braille display when using the Dolphin Cursor.
	
[bookmark: O_5141][bookmark: _Toc228971474]23.25  Characters
Braille menu > Characters
The Characters menu allows you to change various Braille settings to do with how characters are shown on the Braille display. This includes the Literary Braille Mode and Enhanced Display Mode.
	
[bookmark: O_2641]	Literary item.
 This setting turns the Literary Braille option on or off.  If you turn this on, your Braille display will show the Braille in literary Braille, otherwise it will use Computer Braille. We use the term "Literary Braille" as it covers both grade 1 and grade 2 Braille.
	
[bookmark: O_5143]	Enhanced item.
Use this setting to turn the Enhanced Braille feature on or off. When on, any characters which have an attribute other than "normal" will be marked, usually by adding a dot 8.
	
[bookmark: O_5144][bookmark: _Toc228971475]23.25.1  Options
Characters dialog box.
The Characters dialog box allows you to change various Braille settings to do with how characters are shown on the Braille display. This includes the Literary Braille Mode and Enhanced Display Mode.
Options:
	
[bookmark: O_2642]	Cursor Word Contracted check box.
When in Literary Mode you can choose to have the word containing the cursor contracted or uncontracted. This check box toggles this setting. If this option is turned off, the word containing the cursor will be written using Computer Braille. Having the cursor word uncontracted may make editing documents easier.
	
[bookmark: O_2643]	Show Capitals check box.
Some versions of Literary Braille denote capital letters by prefixing the letter or contraction with a special sign called a Capital Sign. Other versions of Literary Braille permit the omission of any such notation, thus saving space.
	
[bookmark: O_2644]	8-dot Braille check box.
The ‘8 Dot Braille check box’ toggles between using eight-dot or six-dot Braille. This is mainly useful when using Computer Braille, where, for example, the lower two dots can be used to show capital letters and other special symbols. For example, in several Computer Codes, capital letters are denoted by adding a dot 7 to the regular Braille symbol for the letter. You may prefer to use six-dot Braille if you have difficulty reading the eight-dot version.
	
[bookmark: O_2645]	Tremble Capitals check box.
This option, which is particularly useful when in six-dot Braille, makes capital letters on your Braille display blink. The blink rate of any such characters is governed by the Blink Rate setting in the Cursor Dialog Box.
	
[bookmark: O_2646]	Enhanced group.
The Enhanced Characters options determine what exactly constitutes an "Enhanced" character. Select those attributes you want to be shown.
	Style list.
Style allows you to select how the enhanced characters are shown. By default dot 8 is added to the character. Other options include dot 7 and dot 7 and 8. 
	
[bookmark: O_5148][bookmark: _Toc228971476]23.26  Braille Layout menu and dialog box
Braille menu > Layout
The options in this menu allow you to configure the Layout of the Braille display.
	
[bookmark: O_5149]	Physical Mode item.
This option switches between Physical Mode and Logical Mode. Physical mode provides the opportunity to determine the physical layout of objects on the screen.  Logical mode shows the logical association of any incidental text with the focus. This is similar to the speech output. This mode is particularly useful for working with dialog boxes, as the screen reader will associate the text labels in a dialog box with their corresponding controls.
	
[bookmark: O_2651]	Tracking item.
This check box determines whether the Braille display follows the movement of the focus in Physical Mode as you use your application. Normally, you would have Tracking turned on, but you might want to turn it off, for example, when you want to monitor a certain region on the screen.
	
[bookmark: O_5151][bookmark: _Toc228971477]23.26.1  Options
Layout dialog box.
The options in this dialog allow you to configure the Physical Mode of the Braille display.  They include options such as whether lines of text are wrapped as you navigate forward and back, whether start and end of line markers are shown and whether the physical layout of the screen is displayed.
	
[bookmark: O_2649]	Forward and Back Wrapping check box.
This check box sets whether the Read Forward and Read Back keys will move through the lines on the screen when in Physical Mode. If this option is turned off, these two hot keys are limited to the current line. However, if wrapping is turned on, you will be able to read through the whole window by using just the Read Back and Read Forward keys.
	
[bookmark: O_14454]	Show complete words only check box.
Typically, lines of text on the screen are longer than the length of Braille displays, meaning that a Braille display can only show a portion of a line at a time. To see the next portion, you press the Braille Move Forward key. This can result in words being split over the end and beginning of the Braille display as you move forward.
Selecting "Show Complete Words Only" will prevent words being truncated because they do not fit on the Braille display. This is especially helpful if you use contracted Braille codes such as UK Grade 2 Braille. This option means the scroll margin position is adjusted based on the positions of words.
If you move forward but the next word does not fit on the Braille display then a gap will be shown after the last character in the last word on the display. This makes it easier for you to click beyond the end of the last word shown. It also gives more of a clue that this is the end of the word.
When there are multiple spaces or gaps that span multiple Braille cells, it may be the case that when moving forward or back that the text does not begin in the extreme left hand cell.
Where the word exceeds the total number of Braille cells then the word will appear truncated on the Braille display, that is, it will behave as if "Show Complete Words Only" is unselected. It is also possible that large amounts of the display can appear blank.
	
[bookmark: O_2650]	Start and End Marker check boxes.
These two check boxes determine whether there is a marker symbol placed at the start and end of lines of text when in Physical Mode. This can be useful when Wrapping is on and you wish to know when you move from one line to another.
	
[bookmark: O_2652]	Show Layout check box.
This check box turns the Layout option on and off for Physical Mode. With Layout on, the characters on the line are placed on the Braille display as closely as possible to their screen layout. This may result in some compression or expansion. If Layout is turned off, the Braille display will just show the characters and the gaps (for example between columns), but the layout may not correspond exactly to the screen layout.
	
[bookmark: O_2653]	Expand Gaps check box.
When Show Layout is turned off, this setting determines whether gaps in a line of text are shown on the Braille display.
	
[bookmark: O_2658]	Pixels per Cell in Gaps list.
With Show Layout turned off, this option determines how many Braille cells should be used for gaps in lines of text.
	
[bookmark: O_2654]	Layout methods check boxes.
The Phrases, Words and Characters check boxes determine the way the characters are positioned on your Braille display in Physical Mode when Show Layout is turned on.  Each item (a phrase, word or character) is positioned in the cells that it occupies.
	
[bookmark: O_2655]	Expand into Gaps check box.
This check box allows a set of characters to flow into the gap that follows it, if Show Layout is turned on. This may result in slightly less compression of the characters being necessary, but the gaps between, say, two columns of text, will not be the correct width.
	
[bookmark: O_2656]	Display Dashes check box.
In Physical Mode, with Show Layout turned on, if any expansion is necessary, the extra space the text should occupy will be filled with dashes. This check box determines whether these dashes are shown or not.
	
[bookmark: O_2657]	Layout Length list.
The Layout Length is the number of Braille cells to distribute across the entire width of the screen. The amount of space one Braille cell represents is the total screen resolution divided by this number.
For example, if you had an 800-pixel screen resolution, and a Layout Length of 80, each cell on the Braille display would represent 10 pixels.
	
[bookmark: O_14782][bookmark: _Toc228971478]23.27  Braille Status Cells dialog box
Menu: Braille > Status Cells
The "Status Cells" dialog box sets what is to be shown on your Braille display Status Cells.
Select the items you want displayed. Each option takes one cell.
	
[bookmark: O_2631]	Features on Display check box.
This status cell shows the current setting of various modes of the Braille system, including the Attribute Modes, Literary Braille, Physical Mode and Tracking.
The top four dots show which of the Attribute modes is active: If this is blank, the display is showing characters (normal). Letters A to E represent the five attribute displays available using the Cycle Attributes key. Letter F represents the Describe Character mode.
The lower four dots show other settings, as follows:
- Dot 3: Raised if in Literary Braille, otherwise Computer Braille.
- Dot 6: Raised in Physical Mode, otherwise Logical Mode.
- Dot 7: Raised if the display currently shows the focus.
- Dot 8: Raised if Tracking is on.
	
[bookmark: O_2632]	Cursor Position check box.
This status cell shows the position of the cursor along a line of text when in an edit area. 
The upper four dots represent the tens and the lower four dots show the units. For example dots 245678 show that the cursor is at position 0 (the extreme left).  Please note that the number of characters which will fit on a line depends on the font size and size of the window.
	
[bookmark: O_2633]	Focus Type check box.
This status cell indicates the type and state of the focus control. This is particularly useful in Physical Mode.
	
[bookmark: O_2634]	Attributes check box.
The various Attribute check boxes display the attributes of the character under the cursor in an edit area. The information is exactly the same as for the Attribute Modes function.
	
[bookmark: O_16400][bookmark: _Toc228971479]23.28  Braille Cursor menu and dialog box
Braille menu > Cursor
The Cursor menu allows you to change how the cursor appears on the Braille display. Most of these settings only apply when editing text in an edit area.
Options:
	Visible item.
This setting determines whether the cursor is shown on the Braille display. In an edit area, the Braille cursor is a single cell, which appears superimposed on the character at the insertion point.
When not in an edit area and the Braille display is set to Physical Mode, the "cursor" is taken to be the current focus. All the characters in the focus are underlined with dots 78.
	
[bookmark: O_16401][bookmark: _Toc228971480]23.28.1  Style
The "Cursor Style" dialog determines the appearance of the cursor. The settings include the shape and blink rate to be used to indicate the cursor position and the style to be used when in physical Braille mode.
	 Shape list.
This pull down list box determines the shape of the cursor when in an edit area. Available options include: Dot 8; Dots 7 and 8; All Dots; Blinking Dot 8; Blinking Dots 7 and 8; Blinking All Dots.
The cursor is superimposed on the current character. Thus, the larger the cursor, the easier it is to find, but the harder it is to read the character under it.
	Blink rate list.
The Blink Rate listbox sets the speed of the blinking cursor and any blinking text on your Braille display.  The higher the number, the faster the blink rate.
	Physical Focus Style list.
The "Physical Focus Style" pull down list box allows you to select how SuperNova indicates the position of the focus when you are in physical braille mode. Available options include: Dot 8; Dots 7 and 8; Dot 7; Blinking Dot 8; Blinking Dots 7 and 8; Blinking Dot 7.
	
[bookmark: O_14725][bookmark: _Toc228971481]23.29  Braille Advanced Options dialog box
Menu: Braille > Advanced Options
You can specify settings for a variety of SuperNova features by selecting options in the "Braille Advanced Options" dialog box.
	
[bookmark: O_14726]On screen Braille tab.
You set the size and position of the window for the "Show Braille On Screen" option here.
This small window mirrors the content of the Braille display.
	
[bookmark: O_14728][bookmark: _Toc228971482]23.29.1  Verbosity tab (Braille)
Verbosity tab.
SuperNova comes with a number of default Verbosity Schemes. A Verbosity Scheme controls what SuperNova tells you about the current control type, like a button or check box. In this property sheet you can modify an existing Verbosity Scheme or even create your own custom schemes.
You can learn more about modifying or creating your own Verbosity Schemes by visiting the Tutorial pages on the Dolphin web site.
	
[bookmark: O_14731][bookmark: _Toc228971483]23.29.2  Hooked Areas tab (Braille)
Hooked Areas tab.
Braille Hooked Areas can monitor certain areas of the screen and output this data to the Braille display. A Braille Hooked Area is set in a Map file and is commonly configured for bespoke applications like Telephony programs. Where a Braille Hooked Area has been implemented within a map then this should be explained in the accompanying support documentation.
The "Hooked Areas" property sheet can be used to switch individual Braille Hooked Areas on or off.
	Set of Hooked Areas list box
Use this pull down list box to choose a set of Hooked Areas to be listed below. You can either list all areas currently displayed on the screen or available in the currently running applications.
	Braille Hook Action list view.
This list shows all the Hooked Areas in the selected set. Use the check boxes in front of each list item to turn the Hooked Area on or off.
A hot key can also be used to turn on and off all Braille Hooked Areas. To do this press LEFT CONTROL + LEFT SHIFT + 2.
	
[bookmark: O_16531][bookmark: _Toc228971484]23.30  Media Scan and Read Settings dialog box
Menu: Media > Scan and Read > Scan and Read Settings
The "Scan and Read Settings" dialog box contains options you can use to change how SuperNova saves and converts scanned documents.
Options.
	Scanner list.
The "Scanner" list shows the list of scanners available on the computer. You must ensure the selected scanner matches the scanner you are using with SuperNova.
	Language list.
The "Language" list refers to the language of the text you are scanning. If you are scanning text in a foreign language then, for best results, you must ensure this setting matches the language of the text being scanned.
	Colour list.
The "Colour" list allows you to change the colour setting for the scanner. For best results, ensure the value as closely matches the print colour being scanned, for example, if you are scanning a plain letter then using "Black and white" will bring the most accurate recognition.
	Paper list.
The "Paper" list relates to the size of paper you are scanning. For best results, ensure the paper size matches the size you are scanning.
	Scan and Read Output Folder box.
This edit box states the location where SuperNova saves the converted documents. Use the browse button to change the folder location.
	
[bookmark: O_15165][bookmark: _Toc228971485]23.31  Item Finder dialog box
Menu: General > Item Finder
You can use the Item Finder to list certain objects in an application window. You can then select the objects and perform actions upon them. Examples include clicking a link on a web page or moving to a heading in a document.
You can use the item finder in programs like Microsoft Office and Internet Explorer.
If you are in an application that does not support the Item Finder then the Item Finder is disabled.
To learn more about the Item Finder and the support it offers for your application see the SuperNova Help available for your application.
	
[bookmark: O_17012][bookmark: _Toc228971486]23.32  General Notification Finder
Menu: General > Notification Finder
You can use the Notification Finder to review notifications that appear on your computer from Microsoft Outlook, Microsoft Teams, and Windows, that you might miss when away from your computer.
This feature relies on SuperNova "seeing" the popup notification, so if you have "Do Not Disturb" or "Focus Mode" options enabled in these applications, the notification may not be captured by SuperNova.
[bookmark: H_17015]See Using Notification Finder (page 147) for more details.
	
[bookmark: O_17013][bookmark: _Toc228971487]23.33  General Check for Updates
Menu: General > Check for Updates
This option checks for software, script, and map file updates to your SuperNova software.
	
[bookmark: O_17014][bookmark: _Toc228971488]23.34  General Latest Release Notes
Menu: General > Latest Release Notes
This option opens a web page detailing what's new and what's changed in the latest version of SuperNova.
	
[bookmark: O_14785][bookmark: _Toc228971489]23.35  General Update Settings dialog box
Menu: General > Update Settings
The "Update Settings" dialog box sets when SuperNova automatically checks for updates. SuperNova can check daily, weekly, monthly or never.
You can also keep SuperNova up-to-date by selecting "Check for Updates" from the "Help" menu.
	
[bookmark: O_14788][bookmark: _Toc228971490]23.36  General Web Settings dialog box
Menu: General > Web Page Settings
You can change how SuperNova interacts with a web page by changing web page settings. The settings you choose can apply to a single web page, a web site or to all web pages.
	
[bookmark: O_16155]	General settings.
You can set how SuperNova detects elements on a web page by changing "General" settings. For example, the detection of a table can be disabled by deselecting the "Announce tables ..." check boxes.
	
[bookmark: O_14787][bookmark: _Toc228971491]23.37  General Keyboard dialog box
Menu: General > Keyboard and Hot Keys > Keyboard
You can specify what keyboard layout and hot key set you want to use in the "Keyboard" dialog box.
Options:
	Keyboard list.
The "Keyboard" list box sets the keyboard type. This does not have to be a true reflection of the keyboard you are using.
	Language list.
The "Language" list box should match your Windows keyboard layout. The value relates to Keyboard Announcements and hot key assignments.
	Set list.
The "Set" list box specifies the hot key set to be used. The sets available will be restricted by the selections in the "Keyboard" list and "Language" list.
	Restore default hot keys button.
You can restore any changes you may have made to a hot key set by selecting this button.
	Num Lock On enables Number Pad keys check box.
You can enter numbers using your keyboard's Number Pad by selecting this check box. If you do select this option then turn the Num Lock Off to use SuperNova hot keys that use the Number Pad.
	
[bookmark: O_15549][bookmark: _Toc228971492]23.38  General Hot Keys dialog box
Menu: General > Keyboard and Hot Keys > Hot Keys
You can add, replace or remove any hot key assignments to SuperNova commands by using options in the "Hot Keys" dialog box. Note that the list of commands are global commands. Hot keys defined in Scripts and Maps cannot be changed using this dialog box.
You can also set more than one Dolphin modifier key, for example, you can set both the INSERT and NUMPAD INSERT keys to be the Dolphin modifier key.
You can also set a secondary Dolphin Modifier key. This enables you to assign a different command to the same keypress, for example, the primary Dolphin modifier key of NUMPAD INSERT + DOWN ARROW may begin Read from here while CAPS LOCK + DOWN ARROW may adjust magnification.
Dolphin key double press does the actual key enables you to prevent the accidental toggling of the Dolphin modifier key (e.g. CAPS LOCK) when being used as a modifier. When this option is selected, you must tap the key twice in order to change its status.
[bookmark: H_15293]To learn more about modifying hot keys, see the "Resolve Hot Key Conflicts" topics in this user guide.
	
[bookmark: O_14786][bookmark: _Toc228971493]23.39  General Control Panel dialog box
Menu: General > Control Panel
The "Control Panel" dialog box contains global settings to control the SuperNova user interface.
	
[bookmark: O_1085]	Access System Language list.
This list box lets you change the SuperNova system language. This includes all of the text in the SuperNova control panel, synthesiser output language and help files.
	
[bookmark: O_2696]	Enable helpful warnings check box
This checkbox switches the helpful warnings on or off. An example for a helpful warning is the graphics training: If you press the hot key for graphic training but graphic training is switched off you can get a warning.
	
[bookmark: O_13796]	Enable help messages check box.
Help messages can appear to guide you through specific tasks.  If this option is unselected then these messages will not appear.  It is also possible to disable specific help messages when they appear by unselecting the "Do not show this message again" check box within the message window itself.
	
[bookmark: O_6425]	Use Default Settings in the control panel check box.
By default, you will use the current SuperNova settings when going through the SuperNova control panel. This lets you experience the effects of change to settings as they happen.
In some cases, settings you wish to use in your application may not be suitable for the SuperNova control panel. Selecting this check box means SuperNova will switch to use the Default Application settings and not your custom Application Settings.
	
[bookmark: O_6426]	Hide when minimised check box.
You can prevent the SuperNova control panel being on the Taskbar and part of the "Switch To" dialog box by selecting this check box.
You can continue to access the SuperNova control panel with the "Open control panel" hot key or through the System Tray.
	
[bookmark: O_6427]	Menu bar and Button Bar Style radio buttons.
You can show the SuperNova control panel only as a menu bar or as a menu bar and button bar. The Button Bar Style includes large graphical buttons which offer easy access to the main SuperNova settings.
	
[bookmark: O_6502]	Status bar check box.
You can hide the status bar that is part of the SuperNova control panel by deselecting this check box.
The status bar contains information about the application and the current settings file in use. All changes you make in the control panel apply to this settings file.
	
[bookmark: O_6428]	Always on top check box.
If this setting is enabled then the SuperNova control panel will always be on top of other windows. 
	
[bookmark: O_6429]	Start with panel ... radio buttons.
You can control the appearance of the SuperNova control panel when SuperNova starts. You can set the control panel to be showing, minimised or at the same position when you last closed SuperNova.
	
[bookmark: O_16673][bookmark: _Toc228971494]23.39.1  Control Panel Theme
	Control Panel Theme list.
This list box lets you change the colours displayed in SuperNova’s control panel by allowing you to select one of a number of pre-defined colour schemes. The default setting is "System Colours", which makes SuperNova use the colours of your currently chosen Windows colour scheme.
	
[bookmark: O_14783][bookmark: _Toc228971495]23.40  General Startup Preferences dialog box
Menu: General > Startup Preferences
You can specify settings for a variety of SuperNova features by selecting options in the "Startup Preferences" dialog box. The availability of some options depends on the synthesiser you are using and whether you are running a local, network or USB edition of SuperNova.
Options
	
[bookmark: O_15542]	Launch SuperNova after logon check box.
You can set your computer to automatically run SuperNova after you log into your user account by selecting this check box.
	
[bookmark: O_16959][bookmark: _Toc228971496]23.40.1  Shortcut Key
	Shortcut Key.
Lets you choose the Windows shortcut key to launch SuperNova. The options are: None, CTRL+SHIFT+S, and CTRL+ALT+S. You may need to log out of Windows and then log back in again for Windows to recognise the change to the shortcuts. The default shortcut key setting is CTRL+SHIFT+S.
	
[bookmark: O_15543]	Disable splash screen at startup check box.
You can stop the SuperNova splash screen showing by selecting this check box. A splash screen is an image that appears while a computer program is loading.
	
[bookmark: O_16814][bookmark: _Toc228971497]23.40.2  Disable sounds at startup
	Disable sounds at startup check box.
Enabling this check box stops SuperNova from playing a startup sound every 5 seconds until it finishes loading (so that you know the program is still loading).
	
[bookmark: O_15544]	Magnifier at user logon check box.
You can magnify the Windows Logon Screen by selecting this check box. After selecting this check box, the next time you restart your computer you will have a SuperNova toolbar showing on the Windows Logon Screen. You can use the mouse to click the toolbar buttons to adjust magnification or press F7 to reduce magnification and F8 to increase magnification.
Note: Magnification at the Windows Logon Screen is only possible by having a SuperNova component running as a Windows service. You cannot run a full program at the Windows logon screen because of Windows security restrictions.
	
[bookmark: O_15548]	Show magnification buttons at logon check box.
You can hide the SuperNova toolbar that appears at the Windows Logon Screen by deselecting this item.
	
[bookmark: O_15545]	Announce when loaded check box.
You can announce "SuperNova loaded" when SuperNova finishes loading by selecting this check box.
	
[bookmark: O_15546]	Load all SAM drivers at startup check box.
You can have SAM check for all supporting devices each time it starts by selecting this check box. Note that this can make the launching of SuperNova slower because it waits for SAM to complete its detection process. You should only select this check box if you are regularly changing your output devices.
	
[bookmark: O_16283]	Always save user settings check box.
By default, SuperNova will automatically save changes you make to SuperNova settings. You can prevent this behaviour by deselecting the "Always save user settings" check box. When this check box is unselected then you must manually save the changes you make. You can do this by selecting the "Save Settings" option in the "File" menu.
	

	
[bookmark: O_16284]	Ask user check box.
The "Ask user" check box becomes available when you deselect the "Always save user settings" check box. If you select the "Ask user" check box, then SuperNova will ask you if you want to save the changes you have made when you quit SuperNova.
	
[bookmark: O_16399]Braille at user logon check box.
You can add Braille support to the Windows Logon Screen by selecting this check box. To successfully use a Braille display at the user logon screen requires you to initially configure SuperNova to detect the display.
	
[bookmark: O_15547]	Voice at user logon check box.
You can add speech support to the Windows Logon Screen by selecting this check box. After selecting this check box, at the Windows Logon Screen you can use the following hot keys to control speech:
	Press F1 to announce the available hot keys.
	Press F2 to mute the voice.
	Press F3 to repeat the last speech output.
Note: Speech at the Windows Logon Screen is only possible by having a SuperNova component running as a Windows service. You cannot run a full program at the Windows logon screen because of Windows security restrictions.
	
[bookmark: O_16511][bookmark: _Toc228971498]23.41  General Touchscreen Settings dialog box
Menu: General > Touchscreen Settings
The "Touchscreen Settings" dialog box contains options that you can use to adjust the SuperNova touchscreen experience.
	
[bookmark: O_16528]General tab.
	Double tap timeout slider.
This setting controls the duration between first and second taps for the gesture to be considered a double tap action. You can increase the time allowed between the first and second taps by moving the slider to the right.
	Jitter Margin slider.
The Jitter Margin is The distance an initial touch can wander before SuperNova thinks you are performing a swipe gesture. You can increase the allowable distance by moving the slider to the right.
	
[bookmark: O_16529]Magnification tab.
	Display Touch Bar check box.
The SuperNova Touch Bar is a touchscreen toolbar that appears at the bottom of the screen when you do a 3 finger  single tap. As well as using the gesture, you can also control the appearance of the Touch Bar by adjusting the status of this check box.
	Flick Inertia slider.
Performing a single finger swipe moves the magnified screen with inertia. The faster you perform the swipe the further the SuperNova magnified screen travels. This slider controls the level of resistence SuperNova applies to the motion. You can reduce the level of resistence by moving the slider to the right.
	Auto-Scroll Zone Width slider.
The "Auto-Scroll Zone Width" is the distance your finger needs to be from the edge of the screen before SuperNova starts automatically scrolling the rest of the screen into view. You can increase the size of the margin by moving the slider to the right.
	Auto-Scroll Zone Speed slider.
The "Auto-Scroll Zone Speed" sets how fast SuperNova starts automatically scrolling when your finger enters the auto-scroll zone. You can increase the auto-scrolling speed by moving the slider to the right.
	Pass-Through Timeout slider.
The "Pass-Through Timeout" is the duration before which a press turns into a pass-through gesture.
	Automatically Scroll applications check box.
This setting controls whether a swipe gesture automatically scrolls the content within an application window when the magnified window is at the edge of the screen. For example, if you are reading a web page and the magnified window is at the bottom of the screen, performing a swipe will automatically scroll the web page, bringing more content into view. Applications that support this feature include the Start Screen, Internet Explorer, Adobe Reader and Microsoft Word.
	
[bookmark: O_16530]On Screen Keyboard tab.
	Automatically Open in Desktop Apps check box.
SuperNova automatically shows the onscreen keyboard when you need to type and you do not have a keyboard connected to the device. You can turn off the automatic appearance of the onscreen keyboard when you are using desktop applications by deselecting this setting. With this setting turned off, you can still make the keyboard appear at any time by tapping the Keyboard button in the SuperNova Touch Bar or by tapping the Keyboard button in the Windows Notification area.
	Colour Scheme list.
You can change the appearance of the SuperNova onscreen keyboard by choosing an alternative colour scheme from this list. The colour schemes available offer large print high contrast colour combinations to make it easy to view the keyboard.
	
[bookmark: O_14789][bookmark: _Toc228971499]23.42  General Advanced Options dialog box
Menu: General > Advanced Options
You can specify settings for a variety of SuperNova features by selecting options in the "General Advanced Options" dialog box.
	
[bookmark: O_14878]System Configuration tab
	
[bookmark: O_14937]	Windows Settings button.
SuperNova makes some changes to your system to ensure best accessibility. You can disable any of the changes made by selecting this button to open the "Windows Settings" dialog box and deselecting any listed item.
	
Magnification Engine Settings button
	Magnification Engine Settings button.
The Magnification Engine Settings dialog box allows you to tweak SuperNova’s magnification engine for optimal performance for your operating system and environment should you encounter any magnification performance issues.

The Magnification System group box provides four options: Automatic, Hook Desktop Window Manager, Alternative Magnification System, and Windows Graphics Capture. For nearly all users Automatic is the best setting. Windows Graphics Capture is best for systems running Windows 11 24H2 or Windows Server 2022 build 20348 and above. Hook Display Window Manager is best for Windows 10 systems. Alternative Magnification System is a fallback system if you encounter any issues with either of the other two magnification systems.

The Performance group box options only apply to Windows Graphics Capture and Alternative Magnification System modes. Automatic will automatically select Best Performance if your PC is currently connected to AC power and Power Save if your PC is currently in battery saver mode. Best Performance runs at maximum frame rate. Power Save lowers both the output and capture frame rates to reduce GPU and CPU load. (This is recommended setting for Citrix and remote desktop environments when you have many users on the same server.) Balanced is somewhere in-between.
	
[bookmark: O_14938]	SAM Setup button.
You access the "Configure SAM" dialog box by selecting this button. SAM allows you to turn on or turn off the detection of speech and Braille devices and to configure the SAM driver for each device.
	Close SAM on exit check box.
Dolphin SAM is a separate component of SuperNova. You can quit Dolphin SAM when you quit SuperNova by selecting this check box.
	
[bookmark: O_14879]Detection Settings tab
	
[bookmark: O_14939]
	Actions button.
This button will open the "Action list" dialog box. The Action List dialog box lets you adjust the global actions. You can also edit and delete actions. For more information please refer to the Mapping Guide support documentation.
	Graphic Objects button.
This button will open the "Graphics Database" dialog box. This dialog box lists any graphics that you have manually trained. You can edit and delete graphics from this dialog box.
	
[bookmark: O_14940]	Allow remote mapping check box.
You can enable remote mapping by selecting this check box. This allows computers running the Dolphin remote training utility to connect to your computer.
For security reasons, if you enable this option it will be automatically turned off when you quit SuperNova.
	Read in columns if present check box.
You can organise the screen into columns based on SuperNova's internal detection system by selecting this check box. This influences the reading options in SuperNova in areas with no Document Object Model (DOM).
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